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Preface

How to Use This Guide

Purpose of This
Guide

Audience

Assumptions

Text Conventions

The GeneMapper® ID-X Sofiware Version 1.0 Getting Started Guide
explains how to perform AmpF{STR® kit data analysis using the

GeneMapper® ID-X Software Version 1.0. This guide functions as
both:

* A tutorial, using example experimental data provided with the
GeneMapper ID-X Software.

* A guide for your own experiments.

In addition, this guide introduces you to the features of the
GeneMapper® ID-X Software Version 1.0.

This guide is written for forensic analysts who perform AmpF{STR®
kit data analysis using the GeneMapper /D-X Software.

This guide assumes that you have:

* Installed GeneMapper /D-X Software version 1.0 as described
in the GeneMapper® ID-X Software Version 1.0 Installation
Guide.

+ Used AmpF{STR® amplification kit data for human
identification (HID) applications.

+ Developed a working knowledge of the Microsoft® Windows®
XP operating system.

This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide ix



Preface
How to Use This Guide

User Attention
Words

* A right arrow symbol ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.

Right-click the sample row, then select View Filter »
View All Runs.

Two user attention words appear in Applied Biosystems user
documentation. Each word implies a particular level of observation
or action as described below:

Note: — Provides information that may be of interest or help but is
not critical to the use of the product.

IMPORTANT! — Provides information that is necessary for proper
instrument or software operation, accurate chemistry kit use, or safe
use of a chemical.

Examples of the user attention words appear below:

Note: Each registered user has his or her own set of preferences.
When you set these options, if affects only the user currently logged
in.

IMPORTANT! To verify your client connection to the database, you
need a valid user ID and password.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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How to Obtain More Information

How to Obtain More Information

Related The following related documents are shipped with the system:

Documentation » GeneMapper® ID-X Software Version 1.0 Installation Guide —
Provides procedures for installing version 1.0 of the
GeneMapper® ID-X Software.

s GeneMapper® ID-X Software Version 1.0 Administrator’s
Guide — Provides procedures for creating user accounts, user
groups, and security groups; configuring the audit trail and
E-signature tools; and maintaining version 1.0 of the
GeneMapper® ID-X Software.

s GeneMapper® ID-X Software Version 1.0 Help — Contains
context-sensitive help for all screens, and provides procedures
and background information needed to use the software.

* GeneMapper® ID-X Software Version 1.0 Quick Reference
Guide — Provides abbreviated procedures for analyzing,
viewing, and interpreting data using GeneMapper® ID-X
Software.

s GeneMapper® ID-X Software Version 1.0 Reference Guide —
Describes peak detection, sizing, and genotyping algorithms,
and the GeneMapper® ID-X Software quality value system.

Portable document format (PDF) versions of this guide and the other
documents listed above are also available on the GeneMapper® ID-X
Software Version 1.0 Documentation CD.

Note: To open the user documentation included on the
GeneMapper® ID-X Software Version 1.0 Documentation CD, use
the Adobe® Acrobat® Reader® software available from
www.adobe.com.

Note: For additional documentation, see “How to Obtain Support”
on page Xiii.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide Xi
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Preface

How to Obtain More Information

Xii

Obtaining
Information from
the Help System

Send Us Your
Comments

The GeneMapper® ID-X Software has a Help system that describes
how to use each feature of the user interface. Access the Help system
by doing one of the following:

 Click & in the toolbar of the Project window
» Select Help » Contents and Index
* Press F1

You can use the Help system to find topics of interest by:
» Reviewing the table of contents
» Searching for a specific topic
» Searching an alphabetized index

You can also access PDF versions of all documents in the
GeneMapper® ID-X Software document set from the Help system.
Applied Biosystems welcomes your comments and suggestions for

improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting
comments and suggestions relating to documentation. To order
documents, download PDF files, or for help with a technical
question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xiii).

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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Preface
How to Obtain Support

How to Obtain Support

For HID support, you can send an e-mail to
HIDTechSupport@appliedbiosystems.com or call 888-821-4443
option 1.

For HID support outside North America, contact your local support
office.

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for
Support.

At the Support page, you can:

» Access worldwide telephone and fax numbers to contact
Applied Biosystems Technical Support and Sales facilities

* Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs,
certificates of analysis, and other related documents

* Download PDF documents
* (Obtain information about customer training
» Download software updates and patches

GeneMapper® ID-X Software Version 1.0 Getting Started Guide Xiii
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This chapter covers:

Overview of the GeneMapper® ID-X Software Version 1.0 .. 2

GeneMapper® ID-X Software and Analysis Workflows . . . .. 6
The GeneMapper® ID-X Software Quality Value System . . .. 7
GeneMapper® ID-X Software Security ................. 14
GeneMapper® ID-X Software Terms . . ................. 15
Howto Use ThisGuide. .. .......... ... ... ... ..... 17
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Overview of the GeneMapper® ID-X Software Version 1.0

Overview of the GeneMapper® ID-X Software

Version 1.0

GeneMapper® ID-X Software Version 1.0 is an automated
genotyping software solution for all human identification (HID) data
analysis needs, including forensic casework, databasing, and
paternity testing. The workflow for performing AmpF{STR® kit data
analysis with GeneMapper ID-X Software is shown below.

Process samples with AmpF{STR® kits ‘

Run samples on instrument:

e ABI PrisM® 310 Genetic Analyzer

e ABI Prism® 3100-Avant/3100 Genetic Analyzer E
e Applied Biosystems 3130/3130x/ Genetic Analyzer

e

Analyze samples in GeneMapper® ID-X [, bp 450 bp
Software:

¢ Size based on:
— Size standard run with chemistry
— Size standard specified in software

e Genotype based on:
— Allelic ladders run with chemistry

— Panels and bins specified in
software

Note: GeneMapper® ID-X Software has undergone a verification
process defined by Applied Biosystems. However, human
identification laboratories analyzing forensic, paternity, databasing
and single-source samples that choose to use GeneMapper /D-X
Software for data analysis should perform their own appropriate
validation studies.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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System
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Features of the GeneMapper® ID-X Software

The software provides a quality value system and a set of streamlined
data review tools and features for both expert system and traditional
manual review workflows. Included in the system are the following
features:

The analysis requirement check identifies unmet requirements
before analysis starts. For example, the software checks if there is a
sample with Sample Type = Allelic Ladder listed in the Samples
table. The system can be set up to stop analysis and display an alert if
this sample type is not found.

The allelic ladder quality assessment:

» Evaluates allelic ladders (based on system-defined allelic ladder
quality requirements) before proceeding to sample analysis

 Flags run folders without at least one passing allelic ladder. You
can review allelic ladders before proceeding with analysis.

* Automatically excludes low-quality ladders from analysis and
continues analysis with passing ladders. You can optionally
override the software assessment and use low-quality ladders to
generate bin offsets.

For efficient data evaluation, the analysis summary provides:
* An easy-to-view summary of analysis results
* An overview of allelic ladder, control, and sample quality

» A separation of passing samples from samples that do not meet
one or more quality thresholds

* Interactive links to specific categories of samples
(passing/check/low quality, allelic ladder/control/sample)

Note: For more information on the Quality Value system, see “The
GeneMapper® ID-X Software Quality Value System” on page 7.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide 3
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Features of the GeneMapper® ID-X Software

Manual Review For efficient data review in traditional manual review and expert
Tools systems workflows, the manual review tools provide:

Process quality value (PQV) flags ([, .*, &)
Automatic spike labeling based on intelligent rules
User-defined “artifact” peak labels

Marker-specific quality value details with thresholds and
observed values displayed to show deviations from thresholds
and identify sources of anomalies

Mark Sample for Deletion and Delete All Labels from Sample
functions in the Samples plot to allow easy elimination of
low-quality samples directly from the plot window

Override Genotype Quality (GQ) and Composite Genotype
Quality (CGQ) functions to “manually accept” genotypes at the
marker and sample level

Detailed label edit table display and visual indicators to indicate
edits (gray PQVs) for electronic peer/technical review

Quality Control  The quality control features:

Evaluate sample concordance and allele matching

Support additional custom positive controls and allow
automatic concordance checks of custom controls

Compare samples in a project to one another to determine if
they contain profiles similar to neighboring samples

Compare samples in a project to laboratory reference and
custom control profiles using a user-defined match percent
threshold

Chain-of-Custody The chain-of-custody systems for electronic data can be
Systems for  custom-configured (or turned off) by the GeneMapper ID-X System
Electronic Data administrator as needed. These systems provide:

Security that controls user access to software functions and
data, and allows custom configuration that meets the data-
sharing needs of your laboratory and limits access to data when
needed

Auditing that tracks changes and provides audit history reports

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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Database
Environment

Report Manager

For more information on these features, see the GeneMapper® ID-X
Software Version 1.0 Administrator's Guide.

Chapter 1 Getting Started n

Features of the GeneMapper® ID-X Software

E-signature that requires user-authentication before changes are
saved

The multi-user database environment:

Allows multiple users to share projects in a centralized database

Facilitates efficient data sharing between analysts for second
analysis and review

Limits the need to import and export projects
Allows central management of analysis settings

For customized table-formatted reports, the Report Manager:

Allows you to change column names and column order

Can export a traditional horizontal allele table for a selected
group of samples for use as a genotype summary or import into
LIMS or other downstream applications

GeneMapper® ID-X Software Version 1.0 Getting Started Guide 5
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GeneMapper® ID-X Software and Analysis Workflows

GeneMapper® ID-X Software and Analysis
Workflows

The following flowchart summarizes the steps for performing a
typical data analysis workflow using the GeneMapper® ID-X
Software. To the left are the steps the user performs when analyzing
samples and interpreting results. To the right are the software
operations that occur automatically during analysis.

Set up the software (one time):

1. (Optional) Create table and plot settings.
2. Create an analysis method.

3. Set Project Options.

Create a project:
1. Add samples.

2. Apply analysis settings. During analysis, the software
3. Start analysis. does the following:

Analysis
requirements check

Review analysis workflow summaries:

e (Optional) Analysis Requirements Summary
e (Optional) Allelic Ladder Analysis Summary Peak detection and
® Analysis Summary sizing

Manually review required samples . .
(based on your lab protocol): Allelic ladder quality

. . assessment
1. View sample-level quality flags.

2. Display plots and view marker-level quality
flags and peak data.

3. (Optional) Edit allele labels. Genotyping
4. (Optional) Manually accept genotypes.

(Optional) Use the Profile Comparison tool. Sample quality
assessment

(Optional) Report results:
Analysis summary

1. Generate a custom report. generation

2. Export reports and tables.
3. Print.

6 GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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The GeneMapper® ID-X Software Quality Value System

The GeneMapper® ID-X Software Quality Value
System

Overview The GeneMapper® ID-X Software quality value system:

» Assesses the quality of allelic ladders before analysis and does
not consider low-quality allelic ladders for genotyping.

» Assesses the quality of data at the sample and marker level
using PQVs.

* Can be used in an optimized and validated expert system or
traditional manual review workflow to quickly identify data
quality issues and aid in interpretation of samples that do not
meet all thresholds.

* Can be used in an optimized and validated expert system
workflow to quickly segregate samples that require manual
review from those that do not.

The PQV results of the quality assessment are displayed as
color-coded flags: Pass ([l ), Check, (/% ), Low Quality (). The
color of the flag depends on software-specified thresholds or user-
defined thresholds set in the analysis method.

Optimizing and  Before using any software as an expert system, optimize and validate
Validating an  the thresholds for each AmpF4STR® kit and instrument platform
Expert System combination by processing a variety of samples that challenge each

of the different quality flags.

IMPORTANT! Different kit/instrument combinations may require
different thresholds.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide 7
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The GeneMapper® ID-X Software Quality Value System

Quality Value System Checks and Assessments

The GeneMapper ID-X Software quality value system performs the
following checks and assessments:

Analysis requirements checks — Before analysis starts,
identifies any conditions that may prevent analysis or cause
unexpected results.

Sizing quality assessment — Evaluates the quality of the size
standard profile in each sample.

Allelic ladder quality assessment — Evaluates allelic ladder
quality. Also determines if an allelic ladder is used for creating
bin offsets.

Marker-level quality assessment — Evaluates labeled peaks
within each marker. Contributes to the overall genotype quality
assessment.

Sample-level quality assessment — Evaluates the quality of the
entire sample.

Genotype quality assessment — Evaluates the quality of each
marker in a sample. Contributes to the overall composite
genotype quality assessment.

The following sections contain a brief description of each quality
value system check and assessment along with a list of each
sample-level and marker-level quality value.

Note: For more information on the quality value system, see the
GeneMapper® ID-X Software Version 1.0 Reference Guide.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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The GeneMapper® ID-X Software Quality Value System

Analysis Requirements Checks

The analysis requirements checks are performed and results
displayed either in the Samples table before analysis starts or in the
Analysis Requirements Summary after analysis starts.

Acronym Full Name Description and Flags IE

ARNM Analysis Indicates if all analysis requirements are met. These requirement
Requirement checks are performed when analysis is started:
Not Met

e Sample File Not Found

e Analysis Method Not Selected

* Analysis Method Not Found in the Database
e Panel Not Selected

¢ Panel Not Found in the Database

¢ Binset Not Selected

e Binset in Analysis Method Does Not Match Binset Selected in the
Panel Manager

e Size Standard Not Selected

e Size Standard Not Found in Database

e Size Standard Dye Color is Not Present in the Sample Dye Set
e Matrix Not Selected

e Matrix Not Found or Contains Invalid Data

¢ No Allelic Ladder Selected in Run Folder

¢ GMID v3.x Analysis Method Selected

e Basic or Classic Size Standard Selected

e SNP Panel Selected

GeneMapper® ID-X Software Version 1.0 Getting Started Guide 9
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The GeneMapper® ID-X Software Quality Value System

Sizing Quality Assessment

The quality value system evaluates the quality of the size standard
profile within each sample (SQ) and allows you to flag size
standards with poor peak resolution. Sizing quality assessment is
displayed in the Samples table after analysis completes.

Acronym | Full Name Description and Flags [ &
SQ Sizing Evaluates the similarity between the fragment pattern for the size
Quality standard dye specified in the size standard definition and the actual

distribution of size standard peaks in the sample, calculates an interim
SQ (a value between 0 and 1), then applies the broad peak weighting
specified in the analysis method, as described in the GeneMapper® ID-X
Software Version 1.0 Reference Guide.

Note: The GeneMapper ID-X Software does not genotype samples with

& sa.

Allelic Ladder Quality Assessment

The quality value system performs an allelic ladder quality assessment
to determine if a ladder is used in genotyping (to create bin offsets).
Allelic ladder samples are analyzed before all other samples. An allelic
ladder sample must have a [ SQ and a [ CGQ to be used for
creating bin offsets. For an allelic ladder to have a [j CGQ, all the
markers within the allelic ladder must pass the following rules:

Rule

Description

All ladder alleles specified in the panel used to analyze are detected.

In each marker, the peak height ratio of the first and second peak is greater than 50%.

This rule eliminates allelic ladders if the stutter peak before the first true allele peak is labeled as
an allele.

No spikes are detected above 20% (default) of the highest allele peak in the same dye color within
the extended marker range.

Note: Spike detection for allelic ladders is performed within each extended marker range (no
gaps are present between markers; the end point of each marker is extended past the marker
definition in the panel to the beginning of the next marker).

Note: The Allelic Ladder Spike Cut-off value is user-definable in the Peak Quality tab of the
analysis method.

The peak height ratio between the lowest and highest peak is equal to or greater than 15%.

10
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The GeneMapper® ID-X Software Quality Value System

Marker-Level Quality Assessments

Marker-level quality assessments indicate the quality of each marker
in a sample and are displayed in the Genotypes table after analysis

completes.

Acronym Full Name Description and Flags [

(O] Off-scale Indicates if any fluorescence signal within the marker exceeds the

detection threshold of the instrument.

BIN Out of Bin Indicates if labeled peaks do not fall inside bins. These peaks are

Allele labeled with OL (Off ladder).
PHR Peak Height Indicates if the peak height ratio between the lowest and highest peak
Ratio is less than the Min Peak Height Ratio defined in the analysis method.
MPH Max Peak Indicates if any peak heights (in RFU) within the marker size range
Height exceed the Max Peak Height value (in RFU) set in the analysis method.
LPH Low Peak Indicates if any peak heights (in RFU) within the marker size range are
Height below the following thresholds set in the analysis method:
e Homozygous Min Peak Height
e Heterozygous Min Peak Height
AN Allele Number | Indicates if the software detects no alleles, more than the Max
Expected Alleles set in the analysis method (Peak Quality tab), or no X
allele detected in amelogenin.

BD Broad Peak Indicates if the width of any peak exceeds the Max Peak Width (half

height in base pairs) defined in the analysis method (Peak Quality tab).

CcC Control Indicates if a positive, custom, or negative control produces the

Concordance expected profile.

SPK Marker Spike e Allelic ladders - Indicates if spikes are detected within each extended
marker range (no gaps are present between markers; the end point of
each marker is extended past the marker definition in the panel to the
beginning of the next marker).

e Samples - Indicates if spikes are detected within a marker size range.
The software uses a proprietary algorithm that detects spikes based on the
peak morphology.

OVL Overlapping Indicates if a labeled peak (allele or artifact) falls within the size ranges of

Alleles two neighboring markers.

GeneMapper® /D-X Software Version 1.0 Getting Started Guide 11
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The GeneMapper® ID-X Software Quality Value System

Genotype Quality Assessment

For samples, the quality value system assigns the GQ for each
marker based on the individual marker quality flags. For allelic
ladders, the quality value system assigns a GQ for each marker based
on the allelic ladder quality requirements, as described in “Allelic
Ladder Quality Assessment” on page 10. The GQ is used to
determine the CGQ, and is displayed in the Genotypes table after
analysis completes.

Full i
Acronym Name Description and Flags IE 0
GQ Genotype | Indicates the genotype quality of the marker in the sample. The genotype
(samples) = Quality quality for a sample marker is determined based on the presence of labeled
peaks detected (after filtering) and the GQ weighting specified in the
analysis method.
If no labeled peaks are detected (and the sample is not a negative control),
the GQ is set to 0. If one or more labeled peaks are detected, the GQ is
initially set to 1 with a final value determined by the GQ weighting of
individual marker-level quality values as specified in the analysis method.
GQ Genotype | Indicates the genotype quality of the marker in the allelic ladder. The
(allelic Quality genotype quality for an allelic ladder marker is determined using system-
ladders) defined quality rules (as described in the GeneMapper® ID-X Software

Version 1.0 Reference Guide) to ensure:

e All expected peaks are present.
¢ Peak height ratio of the first and second peak is greater than 50%.

¢ No spikes are present in the extended marker range (within or between
markers).

¢ The peak height ratio between the lowest and highest peak is equal to or
greater than 15%.

IMPORTANT! If the Allelic Ladder GQ Weighting for Spikes is set to 0 (off)
in the analysis method, the GQ may be IE , even if spikes are present in the
allelic ladder.

12 GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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The GeneMapper® ID-X Software Quality Value System

Sample-Level Quality Assessments

Sample-level quality assessments that indicate the quality of the
entire sample are displayed in the Samples table after analysis
completes.

Acronym Full Name Description and Flags IE

SOS Sample Indicates if any fluorescence signal within the analysis range exceeds
Off-scale the detection threshold of the instrument.

MIX Mixed Source | Indicates a potential mixed-source sample.

OMR Qutside Indicates if labeled peaks are detected between two marker size
Marker Range | ranges defined in the panel.

SSPK Sample Spike | ¢ Allelic ladders — Indicates if spikes are detected within the sizing

range.

e Samples - Indicates if spikes are detected within or between two
defined marker size ranges. Does not indicate if spikes are detected
before the first marker or after the last marker.

The software uses a proprietary algorithm that detects spikes based on

the peak morphology.

cacQ Composite Indicates overall sample genotype quality. Considers the individual
(samples) | Genotype marker GQ values.

Quality
caGQ Composite Indicates overall allelic ladder quality. Considers the allelic ladder
(allelic Genotype quality assessment (see page 10).
ladders) Quality

GeneMapper® ID-X Software Version 1.0 Getting Started Guide

Note: Allelic ladder samples with @ CGQ are not used to create bin
offsets.

IMPORTANT! If the Allelic Ladder GQ Weighting for Spikes is set to 0
(off) in the analysis method, the CGQ may be ] even if spikes are
present in the allelic ladder.
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GeneMapper® ID-X Software Security

The GeneMapper® ID-X Software contains a security system that
includes the following features relevant to the procedures outlined in
this guide:

Security System
Component

Description

User accounts

A required component of the security system that allows only authorized users
to access the software.

This guide assumes that you log in using the Practice User account provided
with the software (see the GeneMapper® ID-X Software Version 1.0
Administrator’s Guide for a description of user accounts). Chapter 2 provides
detailed instructions for logging in.

Security groups

A component of the security system that restricts user access to specific data
items (project, panels, analysis methods, and size standards.)

When using the Practice User account, o X
data is assigned to the Practice Security EIEELRIEEL fad
Group automatically (you are not prompted Mame: | Getting Started 4B

to select a security group).

Security Group: | Practice Security Group b

[ OF H Cancel H Help ]

Audit trail

A component of the security system that
keeps track of changes made and can

require users to provide a reason for a v O T T e T S e

change. N[ <6 ST ol AL NG TPOSE 21762

Enter the Reason(s) for Change:

The audit trail is set up by default to require
a reason for change when you edit allele
labels. If additional auditing is set up on
your system, you may be prompted to
specify a reason when you create or edit
data items.

Microveriant oy

E-signature

An optional component of the security S
system that requires users to provide a =
valid user name and password when they
make a change. e

This guide assumes that E-signature is
not set up on your system. =

If E-signature is set up on your system,
you are prompted to provide your user
name and password when you create or
edit data items.

14
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GeneMapper® ID-X Software Terms

For information on:

» Setting up security, audit trail, and E-signature on your system,
see the GeneMapper® ID-X Sofiware Version 1.0
Administrator s Guide.

» Using security groups (and the impact that security groups have
on the data you can access), using the audit trail, and using
E-signature, see the GeneMapper® ID-X Software Helbp.

GeneMapper® ID-X Software Terms

Some common terms used in this guide are:

Term Definition
allele Variant form of a marker (locus).
allelic ladder A sample that contains a set of alleles that are representative of those found in a
particular STR marker. Allelic ladders are generated with the same primers as tested
samples, providing a reference DNA size for each allele included in the ladder.
Unknown samples are compared against them to determine their genotype.
AmpF(STR® Applied Biosystems Human Identification PCR amplification kits for short tandem

Chemistry kit

repeat (STR) analysis.

analysis A collection of user-defined settings that determine the sizing, genotyping and

method quality value algorithms used by the GeneMapper® ID-X Software to analyze sample
files in a project.

bin A fragment size (+ 0.5 bp) that defines an allele within a marker.

bin set A collection of bins (allele definitions), typically specific to a set of panels.

CODIS The FBI Laboratory Combined DNA Index System. For more information, see:
http://www.tbi.gov/hq/lab/codis/index1.htm

custom A positive amplification control other than the control DNA supplied with the

control AmpF(STR® kits.

GeneMapper® /D-X Software Version 1.0 Getting Started Guide 15


http://www.fbi.gov/hq/lab/codis/index1.htm

n Chapter 1 Getting Started

GeneMapper® ID-X Software Terms

Term

expert system

Definition

A computer program that:

¢ |Interprets alleles and DNA profiles

e Uses knowledge acquired from Qualified Analysts

* Is Rule-based

* Acts as an “assistant” to Qualified Analysts

e Automated-minimal human intervention

® [s as good or better than human experts

e Documents reasoning behind decisions

* Does not require manual review of “passing” samples

Source: National DNA Index System (NDIS) DNA Data Acceptable Standards,

Appendix B, "Guidelines for Submitting Requests for Approval of an Expert System
for Review of Offender Samples," 15 July 2004.

genotype

Allele designations for a genetic locus.

genotyping

Labeling of alleles based on allelic ladder bin comparisons and filtering of alleles
based on analysis method settings.

lab reference
profile

A genotyped profile of an analyst or other lab personnel.

marker A genetic locus. A name, fragment size range in base pairs, dye color, repeat length,
and physical allelic ladder alleles are defined for each marker.

negative A sample expected to generate no allele calls. Can be an extraction blank, reagent

control blank or an amplification negative control.

panel A group of markers and properties (size ranges, dye label color, expected positive
control genotypes). Each panel provided with the GeneMapper® ID-X Software
represents a specific AmpF{STR® Chemistry kit.

positive A sample of known genotype. Each AmpF{STR® Chemistry kit includes a positive

control control. You can also run custom positive controls.

PQV (Process | Process quality values (PQVs) assess the quality of data at the sample and marker

Quality Value)

levels.

profile The genotype (allele designations) of a sample.
project In the GeneMapper® ID-X Software, a collection of sizing and genotyping results for
a set of data.
run The electrophoretic injection of a set of samples from a single plate (48- or 96-well)
and the resulting sampile files.
run folder A folder containing a set of sampile files from a capillary-electrophoresis run.
16 GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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Term Definition

sample files Capillary-electrophoresis data files (*.fsa) generated by Data Collection Software.

size standard A list of fragment sizes in base pairs that a size standard sample contains. Only

definition those sizes required for accurate sizing are contained in the size standard definition.
stutter ratio Percent value used to filter stutter peaks (remove labels).
traditional Visual inspection of samples regardless of quality.

manual review

For additional definitions, see the GeneMapper® ID-X Sofiware Help
(select Glossary in the Contents tab).

How to Use This Guide

Before You Start IMPORTANT! Before using the procedures in this guide, make sure
the GeneMapper® ID-X Software has been successfully installed and
registered. See the GeneMapper® ID-X Software Version 1.0
Installation Guide for more information.

When performing the procedures described in this guide, keep in
mind the following:

* The steps in each chapter are designed to flow from start to
finish, and from one chapter to the next

* Complete each chapter as a single unit before stopping your
work, if possible

* Make sure you perform each step as it is described

» Carefully review any previously performed steps if you observe
any differences between what is shown in this guide and what is
displayed on your own system

User Account You must use the Practice User account provided to perform the
Requirements procedures in this guide.

GeneMapper® /D-X Software Version 1.0 Getting Started Guide 17
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How to Use This Guide

Using the Guide Example data (.fsa) generated using the Applied Biosystems
with the Example AmpF{STR® Identifiler® PCR amplification kit, and a reference
Data Provided project (.ser) containing analyzed lab reference samples, custom
controls, and QC samples are installed with the GeneMapper® ID-X
Software.

To perform the exercises described in this guide, use the example
files (.fsa and .ser) located on your computer as shown below.

File Location

Install
Confi ti

onfigtiration Reference project (.ser) Sample files (.fsa)

Client install <drive>:\AppliedBiosystems\ <drive>:\AppliedBiosystems\
GeneMapperID-X\Client\Example Data\ | GeneMapperlD-X\Client\Example Data\
Projects Identifiler Samples

Full install <drive>:\AppliedBiosystems\ <drive>:\AppliedBiosystems\

GeneMapperID-X\Example Data\ GeneMapperID-X\Example Data\
Projects Identifiler Samples

Note: The drive will vary depending on the installation of the
GeneMapper® ID-X Software. The default installation drive is the
Local Disk drive. See the GeneMapper® ID-X Software Version 1.0
Installation Guide for more information on installation options.

Using the Guide This guide is a tutorial designed to help you follow a typical analysis
as a Tutorial workflow. Using the example data provided with the GeneMapper
ID-X Software, follow the procedures in Chapters 2-7:

Chapter Description

Chapter 2, Setting Up the Software . View default panels and bins

. Create an analysis method

. View default table and plot settings
Create new table and plot settings

. View default size standard definitions

. Add custom control and lab reference profiles to database

N o oA N =

. Set project options
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How to Use This Guide

Chapter Description
Chapter 3, Creating a Project, 1. Create a project and add samples
Analyzing, and Reviewing Analysis
Workflow Summaries 2. Analyze the data
3. Review the Analysis Requirement Summary
4. Review the Analysis Summary
Chapter 4, Manually Reviewing and 1. View electropherograms
Interpreting Data 2. Interpret anomalies using quality value flags and details
3. Edit allele labels
4. Manually accept marker genotypes
Chapter 5, Performing Quality 1. Perform Sample Concordance check
Control of Sample Resuits 2. Perform Sample Comparison check
3. Perform Lab Reference Comparison check
4. Perform Control/QC Sample Comparison check
Chapter 6, Performing 1. Use filtered tables to find edited samples
thfgfl'echnlcal Review of Electronic 2. Use Label Edit Viewer to view edited labels
3. Manually accept sample profiles
4. View edit comments in tables

Chapter 7, Reporting, Exporting and
Printing Results

N =

. Generate a custom report
. Export reports and tables

For More This guide contains basic procedures. It does not describe all features
Information and parameters in the GeneMapper® ID-X Software. For detailed
information on topics presented in this guide, see the GeneMapper®
ID-X Software Help.
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Setting Up the Software

X

Creating a Project,
Analyzing, and Reviewing
Analysis Workflow
Summaries

Manually Reviewing and
Interpreting Data

Performing Quality
Control of Sample
Results

Performing
Peer/Technical Review of
Electronic Data

Reporting, Exporting and
Printing Results

Chapter 2

Setting Up the Software

This chapter covers:

OVEIVIEW. . . ottt e e e 22
Step 1: Start the Software and LogIn. .................. 22
Step 2: View Panels, Bins, and Stutter Settings .. ......... 26
Step 3: Create an Analysis Method. .. .................. 29
Step 4: Review Default Table Settings, Plot Settings, and Size

Standards. . ........ . 35

Step 5: Import Lab Reference and Custom Control Profiles . 47
Step 6: Set the Project Options. . ...................... 52
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Overview

Overview

In This Chapter

This chapter demonstrates how to prepare the GeneMapper® ID-X
Software for analysis, using the example data set provided with the
software.

In this chapter you will learn how to:

Start the software and log in
Review the panels, bins, and stutter files provided
Create analysis methods

Review the table settings, plot settings and size standards
provided

Create new table settings and plot settings
Import lab reference and custom control profiles
Set project options

Step 1: Start the Software and Log In

22

Starting the
Software and
Logging In

1.

2.

]
Double-click &~ (GeneMapper® ID-X v1.0) on the desktop to
launch the software.

In the Login to GeneMapper® ID-X dialog box, enter Practice
User for User Name and password for Password, then click
OK.
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Step 1: Start the Software and Log In

gin to GeneMapp

User Mame Fractice User 4 |

Password: | s*#xxssw |

GeneMappaer®

’D-X Database Host: |FOSKOSMANCNDDI 4 |

@ 1999-2007 Applied Biosystemns. All Rights Resenved.

[ Mew Host, ., H Delete Host H Default Host ] [ OF H Exit H Help ]

Note: If you have logged in before, you can select the user
name from the drop-down list.

The Project window opens.

Toolbar

Menu Project name Logged in user Computer name

{ IJntitIed; ) { FOSKOSMANCNDO1, )

»* GeneMapper® ID-X (Practice User)ls Logged In Databas:

File Edit Analysis View Tools Admin  Help
GOoH | W MEEU b @ TableSstting, BE 2Pk De
""" o Project Samples |Analysis Summary || Genotypes |
Status |Sample File Sample Mame Sample 1D Comments  |Sample Type  |Specimen Category Analysis Method
1
2
3
4
5
]
7
[E]
el
10
£ >
Progress Status ... I Stop
Navigation pane that lists run Content pane showing Samples
folders (blank for new projects) table (blank for new projects)
Status bar
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Resizing and 1. Adjust the window to display as many of the table columns as
Exploring the possible:

Project Window a. Click (Maximize) in the upper right corner of the

Project window to expand the window to occupy the full
area of the screen.

b. Resize columns by dragging the separating lines:

* Position the pointer over the line separating two
columns until the pointer changes to sizing arrows.

* Click-drag the sizing arrows. Dragging to the left
narrows the left-hand column. Dragging to the right
widens the left-hand column.

2. Place the pointer over toolbar buttons to display tooltips that
explain the function of the button.

%@ il = =
{

| Add Samples To Project |

Exploring the The GeneMapper® ID-X Software context-sensitive Help system
Context-Sensitive  provides immediate access to detailed information regarding
Help System  software views, functions and troubleshooting guidelines.

To access the Help system from the Project window:

1. Click the Help menu, then select Contents and Index.

) Conkext Sensitive Help
3 products & Services Fz

Contents and Index

About GeneMapper® I0-¥ Software
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Step 1: Start the Software and Log In

Help opens in a separate window.

® ID-X - Untitled - Practice User Is Logged In Database FOSKOSMANCNDO1

File Edit Analysi

is View Tools Admin  Help

5 . m i ﬂ . . Lll . ’ ‘ Table Setting: |31><)<Datannaiysis ‘. ,. 8 a D @.
o gl Profect Samples |mu Genotypes |

|Statu5 |Samp\e File |Sample hame |Sample (s} |Cumment5 |Samp\e Type |SpEEiI‘nEI‘I Category |Analy5i5 Method |Pane| ‘S\ze Standard ‘Custurl

E? GeneMapper® ID-X Software v1.0 Help

Progress Skatus ...

1
2
sl e =2 &
4 | Hide Back Fomward Print
S -~
o | Contents | index | Search | [, Applied —
. = Biosystems ’ Contents | Troubleshooling | Workflows
7] @ Overview of the GeneM apper® & —
8 | | - 2l Features ofVarsion 1.0 the Ge GeneMapper® [D-X Software Workflow
[ 0] — Workflows —————
o] - 2] GeneMapper 1D Software Y 5 =
Set up the soft + :
41 @ Getinp Stated et up the software (one time)
414 Satting Up the Software fane t — 1. (Optional) Create table and plot settings,
[+ @ Setting Up a Project 2. Create an analysis method,
| | = @ tnalyzing a Project 3. Set Project Options, -
[i-@ Reviewing Results |
[ Q Creating and Editing Reports —
[+ Printing and Exporting Create a project:
@ — Using the Software 1. 8dd samples,
[+ Analysis Methad E ditor 2. Apply analysis settings, Dusg;@;g:';;;f;ﬂﬁgfﬂ&w
[+ Q Analysis Summary 3, Start analysis.
1@ Matiices " Analysis
[+ @ Panel Manager | ,: requirements cheds
i+ Plot Settings Editor v l'
1+ @ Profile Comparison Review analysis workflow surnmaries:
[i-% Project ‘window R + [(Optional] Analyziz Requirernents Surmary pe:r‘:ddselgelr‘it“‘”
3 | 5 ar b R I s S e s e e e b
< 3 |||a | =

Note: You can also access the Help system anywhere in the
software by pressing F1, by clicking @ in the toolbar of the

Project window, or by clicking the Help button in a window, tab

or dialog box to access help topics specific to that particular

feature of the user interface. You can then click on the internal
links within the specific help topic to navigate to related topics.

2. Click (Close) to close the Help window and return to the
Project window.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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Step 2: View Panels, Bins, and Stutter Settings

Overview

When to Import

Viewing Panel,
Bin, and Stutter
Settings

26

Before analyzing data, the software must have access to
AmpF{STR® kit details such as marker size ranges and dyes, allele
sizes, and stutter ratios. The files that contain this information are
called Panel, Bin, and Stutter files, respectively.

IMPORTANT! The panel, bin and stutter values shown in this section
are configured specifically for use with AmpF{STR® kit data.
Applied Biosystems recommends you use the provided panels and
bins when analyzing AmpF£STR® data from your laboratory, unless
your laboratory has validated alternative values.

As part of the GeneMapper® ID-X Software installation process, the
panel, bin and stutter files are automatically imported into the
GeneMapper® ID-X Software database.

Note: If you have installed GeneMapper® ID-X Software on the
same workstation as Data Collection software (co-installation), you
must manually import the panel and bin files. See the GeneMapper®
ID-X Software Help for information on this procedure.

Note: You can import new panel, bin and stutter files whenever
updated versions are provided.

1. Ifnot already started, launch the GeneMapper® ID-X Software
(see page 22).

2. In the Project window toolbar, click _ (Panel Manager).
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Step 2: View Panels, Bins, and Stutter Settings

3. In the navigation pane of the Panel Manager, select the
AmpFLSTR_Panels_v1X kit folder, then click ® to expand
its contents.

»* Panel Manager,
File Edit Bins View Help

wo> W W W= Binset: | AmpFLSTR_Bins_v1X

=5 &Panel Manager | Panel Hame Conrirvert
(i rripFLS TR 1 F|ue_v1>< rull
k 2 |COFiIer_v1>< rll

4. Double-click the Identifiler_v1X panel folder. The markers
found in the Identifiler kit are listed in the navigation pane and
the marker details are displayed in the content pane.

Markers Marker details
»* Panel Manager, rz|
File Edit Bins View Help
e el o N N N BinSet:|AmpFLSTR_Bins_v1>< v| HiTES2SE EEBEEE o

Mugker Hame | Dye Color | Min 3ime | Mo Sim | Cortrol Mlleles | BMaker |Comemerts | Ladder Alleles =L

G51179  JElue 118.0 [1835 |13 4 none ,9,10,11,12,13,14,15,16,
D21511 Blue 1845 |247.5 |30 4 none 24,24,2,25,26,27,28,28.2,;
D75520 Blue 2510 (2985 (10,11 4 none 6,7,8,9,10,11,12,13,14,15
CSFIPO Blue 302,12 |348.63 10,12 4 none 6,7,8,9,10,11,12,13,14,15
D351358  |Green  |98.0 148.0 [14,15 4 none 12,13,14,15,16,17,15,19
THO1 Green 1590 |205.0 |8,9.3 4 none 4,5,6,7,8,9,9.3,10,11,13.3
D135317  |Green |205.65 |250.16 |11 4 none ,9,10,11,12,13,14,15
DI65539  |Green  |255.3  |301.61 |11,12 4 none 5,8,9,10,11,12,13,14,15
D251338  |Green 3048 |370.31 [19,23 4 none 15,16,17,18,19,20,21,22,2 | |
D195433  |vellow (1010  [148.0 [14,15 4 none 9,10,11,12,12,2,13,13.2,1¢
VWA Yellow 1510 (2135 [17,16 4 none 11,12,13,14,15,16,17,18,1
TPOX Yellow 216,99 (260,99 |6 4 none 6,7,8,9,10,11,12,13
| | @-Fea 13 |D1Es51 Yellw (264,49 (3500 [15,19 4 none 7,9,10,10,2,11,12,13,13.2,
- [C3 SEfiler_v1% v |14 |aMEL Red 1060  [1140  |x 3 none Y
f' | > 15 |DEsElE Red 1za.0 (1800 |11 4 none 7,8,9,10,11,12,13,14,15, 1t
------ &Reference Samples | 16 |FGA Red 206,25 |360.0 23,24 4 none 17,18,19,20,21,22,23,24,2
[ Ok ] [ Cancel ] [ Apply ] [ Help ]
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Step 2: View Panels, Bins, and Stutter Settings

5. Double-click the D8S1179 marker in the navigation pane. A

plot showing the bins for this marker is displayed in the content
pane.

78 @ 100 11 12 13 14 15 16 17 18] 19 20

1.0

o7

0.5

04

03

0.2

o1

120 130 140 150 160 170 180

DES1179

Markers can include two bin types: physical (represent alleles
present in the allelic ladder sample) and virtual (represent
alleles not present in the allelic ladder sample). The software
displays all physical bins in grey, and all virtual bins (except for
CODIS bins) in pink. In this example, the D8S1179 marker
contains two virtual bins, 7 and 20, displayed in pink in the
content pane.

. In the navigation pane, click = to expand the Yfiler_v1X panel

folder.

. Click ®= to expand the Y_DYS392 marker, then select Stutter

Ratio & Distance.

= [C5fFiler 1%
+- B_DY5456
- B_DY53841
- B_D¥5390
- B_D¥538911
- G_DYS458
- G_DYS19
- G_DYS385
- ¥_DY¥5393
- ¥_D¥5391
- ¥_D¥5439
- ¥_DY¥S635
- ¥_DY¥5392
Stutker Ral
£ R_Y_GATA_H4

TR O O O e e O B
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The marker-specific stutter ratios defined in the stutter file are
displayed in the content pane. In this example, both Minus and
Plus stutter ratios are specified for this marker.

Flease enter the stutter filter(s) for Y_DYS392 marker here If left blank, the global stutter filter will be applied.

Minus Stutter

Ratio

Fram Distance Ta Distance

1622

225

Plus Stutter

Ratio

Fram Distance

Ta Distance

375

L0790

225

375

o] =

o] =

[ mew ][ Edt |[ Delete |

Note: From this window, you can apply up to four minus and
four plus stutter ratios per marker, and edit the default stutter
percentages provided with the GeneMapper® ID-X Software.

8. Click OK to close the Panel Manager window.

Step 3: Create an Analysis Method

Overview

In This Section

GeneMapper® ID-X Software Version 1.0 Getting Started Guide

Analysis methods define the peak detection, sizing, genotyping, and
quality assessment parameters applied during analysis of sample

data.

In this section, you will create a new analysis method, configured
specifically for use with the example data provided with the

GeneMapper® ID-X Software, and with the procedures outlined in
this guide.

IMPORTANT! The values used in this guide may not be suitable for
analyzing data generated in your laboratory. You must optimize and
validate these values during internal verification.
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Creating the 1. In the Project window toolbar, click (GeneMapper ID-X
Analysis Method Manager).

2. Select the Analysis Methods tab, then click New.

3. Complete the tabs of the Analysis Method Editor for this
example analysis method as described in Table 1 on page 30,
and use the GeneMapper® ID-X Software Help to learn more
about the purpose of specific settings and the effects of
changing these settings as needed.

Table 1  Analysis method settings for the example data (Identifiler® samples)
Tab Settings
General Enter the settings as shown below:
Analysis Method Editor %]
General | Allele | Peak Detector || Peak Quality | 5O & G0 Settings
rAnalysis Method Description

Tarme: | Getking Started _your initials |

Security Group: |Practice Security Group v |

Description: For use with the Getting Started Guide only -~

Instrument:

Analysis Type: HID
Note: When following the procedures in this guide, Applied Biosystems recommends
you add your initials to the names of data objects you create so you can distinguish
your data objects from similar objects that may be saved to the same GeneMapper®
ID-X Software database by other laboratory personnel when performing the same steps
in this guide.
Note: This analysis method is assigned to the Practice Security Group automatically
(you are not prompted to select a security group), and is only available if you log in to
the software with the Practice User account. You will verify the Project Options set for
the Practice User account in “Step 6: Set the Project Options” on page 52.
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Table 1  Analysis method settings for the example data (Identifiler® samples) (continued)

Tab Settings

Allele Select the bin set and review the default settings as shown below:

Analysis Method Editor 3

|| Peak Detector | Peak Quality | 50 & GQ Settings

Bin Set: |.C\mpFL5TR_Bins_v1X - |
Use marker-specific stutker ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Walue 0.0 0.0 0.0 0.0
Minusd Ratio 0.0 0.0 0.0 0.0
Minusa Distance From | 0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From | 0.0 325 0.0 0.0
To 0.0 4,75 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Diskance From | 0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0
Amelogenin Cutaff

Note: This analysis method specifies marker-specific stutter ratios. In this case, the
stutter ratios viewed in the Panel Manager will be applied. However, a Global Cut-off
Value and a Global Minus Stutter Ratio may be applied for single-source samples to

minimize background labeling that could cause samples to be flagged as low quality.
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Table 1  Analysis method settings for the example data (Identifiler® samples) (continued)

Tab Settings

Peak Enter the settings as shown below:
Detector

()

Analysis Method Editor

| Peak Quality | 5 & G0 Settings

Peak Detection Algarithm: Advanced

Ranges Peak, Cetection
Analysis Sizing Peak Amplitude Thresholds:
|Part|a| Ra... » |F‘art|a| Sizes hd B: | & | R | & |
Skark PE:) 2740 Skart Size:| 75
Stop PE:| 10000 | Stop Size: | 450 G: |80 | o |8 |
~amoothing and Baselining
Min. Peak Half Width: 2 pts
Smoathing ) Mone
i 2 3
) Light Polynomial Degree
() Heawy Peak Window Size: 15 pts
Baseline Wwindow: pts Slope Threshold
Peak Start: 0.0
r3ize Calling Method Peak End: 0.0
(") 2nd Order Least Squares

() 3rd Order Least Squares
(") Cubic Spline Interpalation
() Lacal Southern Methad
() Global Southern Method
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Table 1  Analysis method settings for the example data (Identifiler® samples) (continued)

Tab Settings

Peak If a marker does not meet a PQV threshold value set in this tab, the GeneMapper® ID-X
Quality Software will set the marker PQV flag to yellow ; * (Check).

Review the default PQV threshold settings shown below. Click Help at the bottom of the
tab and navigate to the Peak Quality help topic to learn more about the parameters
presented in this tab.

Analysis Method Editor X

General || Allele PeakDetectnr|§PEGkQ'-Ia|it‘f'§

| 50 & 5Q Settings

Min/Max Peak Height (LPHIMPH)
Haormozygous min peak height 200.0

Heterozygous min peak height

Max Peak Height (MPH) 5000.0

Peak Height Ratio (PHR)

Min peak height: ratio
Broad Peak (BDY

Max peak width (basepairs)

Allele Mumber (AR

Max expected alleles

I

Allelic Ladder Spike
Cut-off Yalue 0.z
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Table 1  Analysis method settings for the example data (Identifiler® samples) (continued)

Tab Settings
SQ & GQ | The values entered in this tab affect the calculation of SQ and GQ.
Settings

34

Review the default SQ and GQ settings shown below. Click Help at the bottom of the
tab and navigate to the SQ & GQ Settings Tab help topic to learn more about the
parameters presented in this tab.

Analysis Method Editor X

General | Allels | Peak Deteckar PeakQuaIitylé

Quality weights are between 0 and 1.
r3ample and Conkrol G0 weighting

Broad Peak (BD) 0.8 Allele Murnber (AN) 1.0
Out of Bin Allele (BIN) 0.8 Low Peak Height (LPH) 0.3
Cverlap (OWL) 0.5 Max Peak Height (MPH) 0.3
Marker Spike (SPK) 0.3 OFf-scale (0S) 0.8

Peak Height Ratio (PHR) 0.3

Control Concordance (CC) Wieight = 1.0 {Only applicable to contraols)

S0 Weighting

Broad Peak {BDY

rallelic Ladder GO Weighting
Spike (S5PK/SPE)
S50 850 Ranges

Sizing Quality: From | 0.75 to 1.0 From0.0to | 025

Genotype Quality:  From | 0.75 to 1.0 From0.0to | 025

4. After completing all tabs, click Save to save your changes and
close the Analysis Method Editor dialog. The GeneMapper
ID-X Manager remains open.
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Step 4: Review Default Table Settings, Plot
Settings, and Size Standards

Overview

In this section, you will review the default table, plot, and size
standard settings provided with the GeneMapper® ID-X Software.
The default settings are designed to support a logical and efficient
data analysis and review workflow using the example data provided
with the software and for use when analyzing data generated in your
laboratory. Use of the default settings is demonstrated throughout
this guide.

Note: You can modify the default table, plot, and size standard
settings or create new settings to support individual laboratory
workflows.

Review Default Table Settings

Overview

Reviewing Table
Settings

Table settings determine the content (columns) displayed in or
exported from the Samples and Genotypes tables. The default table
settings shown in this section include specific columns required to
perform different workflow tasks.

1. Open the GeneMapper ID-X Manager if not already open (see
page 30).

2. In the GeneMapper ID-X Manager, select the Table Settings
tab.

3. Click a table row to select the table setting to review, then click
Open.

4. Review the default table settings provided using Table 2 on
page 36.

5. After you have finished reviewing the default table settings,
click OK to close the Table Settings Editor. The GeneMapper
ID-X Manager remains open.
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Defaults Provided The following table settings are installed with the GeneMapper®

ID-X Software.

Table 2 Default table settings

Table Setting Column Settings
Name Purpose Samples Table Genotypes Table

310 Data Used to set up table data | Displays analysis setting Displays marker and

Analysis to analyze sample files columns and sample-level | allele columns, and
generated on an quality values. marker-level quality
ABI PrIsM® 310 Genetic values.

Analyzer.

31XX Data Used to set up table data | Same as 310 Data Same as 310 Data

Analysis to analyze sample files Analysis table setting (see | Analysis table setting
generated on ABI PRIsM® | entry above), except the (see entry above).
3100 Series and Matrix column is not
Applied Biosystems 3130 | displayed.

Series Genetic Analyzers.

CODIS Export Used to enter data in the Displays the columns that | Same as 310 Data
appropriate columns of may be used to populate Analysis table setting
the Samples table for CODIS-compatible fields (see entry above).
exporting a CODIS- when the table is Note: No action is
supported CMF file. exported in CMF file o

format. required on the
Genotypes tab when
exporting a CMF file.

Import Used to import lab Displays the Profile ID Same as 310 Data

Reference reference and custom column, which is required | Analysis table setting

Profiles control profils@s into the to name and enter pro(;iles (see entry above).
GeneMapper® ID-X into the GeneMapper Note: No action is
Software database. ID-X Software database. required on the

Genotypes tab when
importing reference
profiles.

View CGQ Used to quickly identify Displays only samples Displays marker and

Overrides samples that have been with CGQ override flag allele columns, edit
manually accepted (this and sample-level quality comments and marker-
includes samples with values. level quality values.
and without allele edits).

View Edited Used to quickly identify Displays only samples Displays only markers

Samples samples that have one or | with allele edits and with edits, edit

more allele edit.

sample-level quality
values.

comments and marker-
level quality values.

36
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Table Setting Column Settings
Name Purpose Samples Table Genotypes Table
Traditional Allele | Used to export data into Displays only the sample Displays only the

Table

an allele table using
Combined Table Export.

information required for
an allele table export
format.

marker and allele
information required for
an allele table export
format.

Note: The allele table export format 1

2| E [ 4 |
resembles that created in ABI PRISM® | 1 [Sample Mame  DES1179 |D21511 075820
Genotyper® Software. The table is %g:mp:g g; mg gggl g
compatible with spreadsheet software Zgam&e 03 1516 312 11,12
such as Microsoft® Excel®. 5 |Sample 04 1304 30 8,10

View Unedited
Samples

Used to quickly identify
samples that have not
been manually
manipulated (edited or
overridden).

Displays only samples
without label edits, or GQ
or CGQ override flags and
sample-level quality
values.

Displays only markers
without allele edits and
marker-level quality
values.

Yfiler Haplotype

Used to export the

Displays only the sample

Displays only the

DB Export appropriate columns information required for sample and marker
using Combined Table export in Yfiler® information required for
Export for upload into the | Haplotype Database export in Yfiler®
Yfiler® Haplotype format. Haplotype Database
Database. format.
VALID_GMIDX_ Used to export the Displays only the sample Displays only the
TableSetting-1.0 | appropriate columns for information and run marker information
importing tabular data information required fora | required for a VALID

Creating a New
Table Setting

into VALID™ Software.

Note: The columns in the Genotypes table displayed at the bottom of

VALID software-
compatible format.

software-compatible
format.

the Samples plot are determined by the table setting selected in the

Project window.

filters to display only specific samples.

1. Open the GeneMapper ID-X Manager if not already open (see

page 30).

GeneMapper® ID-X Software Version 1.0 Getting Started Guide
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2. Inthe GeneMapper ID-X Manager, select the Table Settings
tab, then click New to open the Table Setting Editor.

3. Enter the following information in the General tab:

»* Table Setting Editor

General | Samples | Genotypes

Table Settings @

Mame: | Custom Table Setting_your initials

Security Group: |Practice Security Group w |

Description: |

4. Select the Samples tab, then expand the window (click-drag the
window border) to display the Column, Filtering and Content
columns in the Column Settings list:

able Setting Editor

Genera|| Samples | Genokypes

38

rSamples Table Settings:
~Column Settings: Faonk Settings:
Show | Column Filtering [ats)
Fonk: | Arial v
1 Status Show &ll Records Mif A | |
i ize: |11
2 Sample File Show All Records B | |
3 Sample Mame Show &ll Records
Sork by

4[] |%ampleID Show &ll Records 5
5 Comments (&) Ascending

Shaw All Records Sample File 3 | .
[3 Sample Type Shaw 4l Recards 1], () Descending
LR Specimen Category Show all Records Hf .
g e Then by Click-drag

nalysts Metho Show &ll Records

— ® Ascending border to
9 anel Show All Records Mone resize
e Standard () Descending A

10 iz Standar Show &ll Records window
11 Cuskom Control Show all Records Then by
12| ] |Matrix Shaw Al Records v

| 3| (3) Ascending
R —L ‘ Mone

() Descending
[[show | [ Hide |[ showan ][ Hideal |
[ K ] [ Cancel ] [ Help ]

5. Click Hide All to deselect all of the default table column
selections in the Column Settings list.

6. Select to Show ([¥]) the individual Samples table columns you
wish to display using this custom table setting.
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7. Click the Filtering field for the Sample Type row, then select
Sample from the drop-down list.

Show | Colurn Filtering Content
E Comments Shaw All Records
] Sample Type Show All Rec... v Show All Records
7 Specimen Category |Show All Recards  |Mf&
Analysis Method

8 nalysis HEho Positive Control
9 Panel All.ellc Ladder

- Primer Focus
1o Size Standard Megative Control

Note: When you view the Samples table using this table setting,
the Samples table displays only sample files of sample type
Sample, and not Allelic Ladder or Control sample types. You
can then export this filtered view of the Samples table (as
described in Chapter 7).

8. Select additional filters to apply to the remaining columns in the
Samples table, if desired.

9. In the Sort by drop-down list, select Run Date & Time.

Note: Each sample file records the run date and time for that
individual sample. When you view the Samples table using this
table setting, the sample files sort by order of injection rather
than the default sort option of by Sample File.

10. Select the Genotypes tab, then follow the same procedures
outlined in steps 5 through 8 above to select the columns to
display and filter in the Genotypes table.

Note: The settings you specify in the Genotypes tab determine

the columns displayed in the Genotypes table in the Project
window, and the Genotypes table in the Samples plot.
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11. Verify the default sort options for the Genotypes table.

Sark by
(%) Ascending
Sample File w
() Descending
Then by
(%) Ascending
() w
() Descending
Then by
(%) Ascending
Marker v
() Descending

Note: The GeneMapper® ID-X Software executes the selected
sort options in succession. By default, markers are sorted within
a sample by dye color (B, G, Y, R), then by size.

12. Click OK to apply your changes and close the Table Setting
Editor. The GeneMapper ID-X Manager remains open.

Review Default Plot Settings

Overview Plot settings determine the number of panes, headers, labels and
tables displayed in the Samples and Genotypes plot windows. The
default plot settings shown in this section include a specific set of
display elements required to perform different analysis workflow
tasks. These elements are designed for efficient data review.

Reviewing Plot 1. Open the GeneMapper ID-X Manager if not already open (see
Settings page 30).

2. In the GeneMapper ID-X Manager, select the Plot Settings tab.

3. Click on a table row to select the plot setting you wish to review,
then click Open.

4. Review the default plot settings provided using Table 3 on
page 41.
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5. Click OK to close the Plot Settings Editor after reviewing all
plot settings. The GeneMapper ID-X Manager will remain open.

Defaults Provided The following plot settings are installed with the GeneMapper® ID-X

Software.

Table 3 Default plot settings

Plot Setting
Name Purpose Display Settings

Check LIZ Used to display the GeneScan™ LIZ® | Displays the GeneScan™ LIZ® size

Size Standard size standard in the same format as standard fragments with labels per sample
the Check GS500 Macro in the in separate electropherogram panes.
ABI PrIsM® Genotyper® Software
templates.

Check ROX Used to display the GeneScan™ Displays the GeneScan™ ROX™ size

Size Standard ROX™ size standard in the same standard fragments with labels per sample
format as the Check GS500 Macro in | in separate electropherogram panes.
the ABI PRIsM® Genotyper® Software
templates.

Data Used during manual review of sample | Displays the electropherogram plots for

Interpretation data, to enable quick interpretation of | the selected sample(s), the Genotypes
anomalies and marker-level quality table, and the Quality Value Details (QVD)
values. pane.

Overlay LIZ Used to perform sizing precision Overlays all selected size standard

Dye checks with the GeneScan™ LIZ® fragments in one electropherogram pane,
size standards. and displays the Sizing table.

Overlay ROX Used to perform sizing precision Overlays all selected size standard

Dye checks with the GeneScan™ ROX™ fragments within a project in one
size standards. electropherogram pane, and displays the

Sizing table.

Sizing Data Used to display data in a format Displays all dyes per sample in one
similar to the ABI PRIsM® GeneScan™ | electropherogram pane, and the Sizing
Software plots. table.

Traditional Used to display data in a format Displays each dye for a sample in a

Genotype Plot

similar to the ABI PRIsSM® Genotyper®
Software plots.

separate electropherogram pane.

View Label
Edits

Used to display allele edits for the
selected sample(s) in a table below
the electropherogram for electronic
data review.

Displays the electropherogram plots for
the selected sample(s), and the Label Edit
Viewer table.
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Creating a New  Custom plot settings save frequently used combinations of display
Plot Setting eclements to minimize the time spent adjusting display settings during
manual review.

1.

42

Open the GeneMapper ID-X Manager if not already open (see
page 30).

In the GeneMapper ID-X Manager, select the Plot Settings tab,
then click New.

Enter the following information in the General tab of the Plot
Setting Editor:

Plot Settings Editor

General | sample Header | Genotype Header | Sizing Table | Labels | Display Settings

When opening the Plot findowmw:

Mame: | Custom Plot Setting_your initials

Security Group: | Practice Security Group w

Description:

Select the Sample Header tab, then select the columns to
display in the Samples plot header.

Select the Genotype Header tab, then select the columns to
display in the Genotypes plot header.

Note: The columns in the Genotypes table displayed at the
bottom of the Samples plot are determined by the table settings
selected in the Project window.

Select the Sizing Table tab, then select the columns to display
and the font and font size to use for the Sizing table displayed at
the bottom of the Samples plot.
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7. Select the Labels tab, then select the label information to
display for the detected peaks in the Samples and Genotypes
plots:

Plot Settings Editor

General | Sample Header | Genobype Header | Sizing Table| Labels | Display Settings

rShow Labelz on Samples and types Plot:

Labels

Assigned Allele Custom Allele Allelic Ladder Artifact

Label 1: |l Call v | [anele cal v | [artifact Label
Label 2 |NONE v | [mone v | [mone v | [mone
Label 3 |NONE v | [mone v | [mone v | [mone
Label 4 |NONE v | [mone v | [mone v | [mone

Faont

Size:

Specify multiple
labels per category

rithen opening the Plot Windo:

[] shaw POV trigger peak (LPH,MPH,ED, 05)
[] shaw data type prefixes
Display wirtual allele label in black

[] shaw type of edit

Label Color: | Dye Color-Border »

This tab allows you to choose a different set of labels for
different types of samples and different types of peak labels. For
instance, you may choose to only display the allele call for all
allelic ladder samples, but you want to display both the allele
call and height on all other sample types and have them both be
displayed in the same plot window. Each peak can have up to
four labels.
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8. Select the Display Settings tab, then specify settings:

General | Sample Header | Genobype Header | Sizing Table | Labels

When opening the Plot findowmw:

() Use the display settings last used For this plot

() Use these display settings: ‘

For both Sample and Genotype plats:

Shiow

Select a checkbox or
radial button to enable the
associated toolbar button

Axes
Panes: |4 A4
Plat Header [ dlo Peak Positions Yebods | Scale individually v
Labels b Marker Range ] Y4 Bring Ctrls to Top
() 1 No Labels i Marker Indicators [] § Bring Ladders ko Top| | #-Axis * |Basepairs ~
() Ik Horizontal Labels IL Bins [F ‘.,A;_T,_ Allele Changes
Lt vertical Labels Toolbar OFff-scale
For Sample plot only:
Select Dyes All-Dyve Range (bpj: * Tables Drye Layaut
Blue StartRange | 0.0 (® [ Mo Table O il Combine Dyes
Green iadl Sizing Table b Separate Dyes
e
Yellow Eudbpcely 1000.0 O 22 Genotypes Table O i Overlay &l
Red | abels () £ Label Edit Yiewer
Orange Size Std Labels
All Dyes Custom Colors
For Genotype plot anly:
Marker Margin: | 5 bp

Set the x-axis zoom range

* will be overridden if Retain %-axis Zoom Range is enabled on Plots -=Zoom menu

Click Help at the bottom of the tab and navigate to the Display
Settings Tab help topic to learn more about the parameters
presented in this tab.

9. Click OK to apply your changes and close the Plot Setting
Editor. The GeneMapper ID-X Manager remains open.
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Review Default Size Standards

Overview A size standard definition file provides a list of fragment sizes in
base pairs and the dye color associated with a particular size
standard. During peak detection and size-calling, the
GeneMapper® ID-X Software matches an observed fragment peak
from the size standard run with the sample with a corresponding size
in the definition file.

Reviewing Size 1. Open the GeneMapper ID-X Manager if not already open (see
Standard Settings page 30).

2. In the GeneMapper ID-X Manager, select the Size Standards
tab.

3. Click a table row to select the size standard setting to review,
then click Open.

4. Review the default size standard settings provided using Table 4
on page 46.

5. When you are finished reviewing all size standard settings, click
Done to close the GeneMapper ID-X Manager.

Note: You can also create a new size standard definition using
the GeneMapper ID-X Manager.

Defaults Provided The following default size standard definition files are provided with
the GeneMapper® ID-X Software for analysis of AmpF£STR® kit
data:

Table 4 Default size standards

Size Standard Description When to Use

CE_G5_HID_GS500 Includes fragments present in Use with data generated on ABI PRISM®
the GeneScan™ 500 LIZ® size | 310 and 3100 Series Genetic Analyzers,

standard (75 to 450-bp), and Applied Biosystems 3130 Series
excluding the 250-bp Genetic Analyzers, and run with the
fragment. GS500 LIZ® Size Standard.
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Table 4 Default size standards (continued)

Size Standard

Description

When to Use

CE_F_HID_GS500
(75-400)

Includes fragments present in
the GeneScan™ 500 ROX™
size standard (75 to 400-bp),
excluding the 250-bp
fragment.

Use with data generated on ABI PRISM®
310 and 3100 Series Genetic Analyzers,
and Applied Biosystems 3130 Series
Genetic Analyzers, and run with the
GS500 ROX™ Size Standard and all
AmpF{STR® 4-dye kits (except the SGM
Plus® kit).

CE_F_HID_GS500
(75-450)

GS600_LIZ

Includes fragments present in
the GeneScan™ 500 ROX™
size standard (75 to 450-bp),
excluding the 250-bp
fragment.

Includes fragments present in
the GeneScan™ 600 LIZ® size
standard (80 to 460-bp).

Use with data generated on ABI PRISM®
310 and 3100 Series Genetic Analyzers,
and Applied Biosystems 3130 Series
Genetic Analyzers, and run with the
GS500 ROX™ Size Standard and the
AmpF{STR® SGM Plus® kit.

Use with data generated on ABI PRISM®
310 and 3100 Series Genetic Analyzers,
and Applied Biosystems 3130 Series
Genetic Analyzers, and run with the
GS600 LIZ® Size Standard.

Step 5: Import Lab Reference and Custom Control

Profiles

Overview

46

In this section, you will import a project that contains analyzed lab
reference samples, custom controls, and QC samples that are used to
illustrate the quality control features of the GeneMapper® ID-X
Software (see Chapter 5). This project has been edited to remove any
off-ladder (OL) labels.

IMPORTANT! Before adding your own lab reference and custom
control samples using the procedure described below, review the
samples manually and edit allele labels as needed to ensure that the
profile is accurate. Profiles that include OL labels are not imported
into the Profile Manager. Profiles that include numeric allele labels
on peaks that are not true DNA peaks will affect concordance results.
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Importing the 1. Open the GeneMapper ID-X Manager if not already open (see
Reference Project page 30).

2. Inthe GeneMapper ID-X Manager, select the Projects tab, then
click Import.

o GeneMapper® ID-X Manager b_(‘

Find Mame Containing: | |

Projects | analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards || Report Settings

Rename... Save As... Export... Delete
3. Navigate to and select Reference Profile Project.ser, then click
Import.
o Import Project rzl
Loak in: |@ Projects "| I ,—’llE
Y m| Reference Fi se Analysis Settings
‘—"\3 ‘when having same name:
My Recent
Dacuments (%) Skip
?IT' () Overrite
Desktop
Y
My Documents
My C;mputer

.g File name: | Reference Profile Project. ser | [ Import ]

My Metwork,

Places Files of bype: |Java serialized File {*.ser) R | Cancel

Note: The reference project file path shown above is for Full
install configurations only. For the reference project file path
for Client install configurations, see “Using the Guide with the
Example Data Provided” on page 18.
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Step 5: Import Lab Reference and Custom Control Profiles

4. Make sure the Practice Security Group is selected, then click

5.
Adding Profilesto 1
the Software
Database
3.
4.

48

Choose Security Group

Project <Reference Profile Project =

Security Group:

Click Done to close the GeneMapper ID-X Manager.

. In the Project window, click =% (Open Project).

Select Reference Profile Project, then click OK.

From the Table Setting drop-down list, select Import
Reference Profiles. The Sample table view changes to display
only those columns required to add reference profiles to the
GeneMapper® ID-X Software database.

Note: All genotypes and edits are saved with the imported
project. This project does not require re-analysis.

In the Profile ID column of the Samples tab, click each cell,
then enter the Profile ID names as shown below.

Samnples Analysis Summary | Genotypes
Status | Sample File Sample Mame Sample Type  |Profile ID
1 EE Analyst & fsa Analyst & Sample AMALYST A_YOUR INITIALS
2 E;fj ID_aAlelicLadder fza  |Ladder Allelic: Ladder
3 E;fj ID_CustomContral fsa | Custom Cortrol — |Sample CUSTOM CONTROL_YOUR IMITIALS
4 [ |Gc_Sample_01fsa  |QC Sample 01 |Sample QC SAMPLE 01 _vOUR INTIALS

Note: Profiles are stored in the GeneMapper® ID-X Software
database under Profile ID, not Sample Name.
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Step 5: Import Lab Reference and Custom Control Profiles

5. Select the Analyst A.fsa row, then select Tools » Add
Profile » Lab Reference.

iew Admin - Help
g GeneMapper® ID-¥ Manager  Ckrl4+M ) w Table Setting: Imp
E Panel Manager Chrl+]
E' Report Manager Chr+G

|Sample Type  |Profile I©

CODIS Export Manager..,

Table Setting Editor. .. ChrT
m

Custam Cantral  uyeon

Add Profile

22 Profile Manager

LhAPLE O

Profile Comparison

6. Click Close in the Add Profile Results dialog box to save the
assigned lab reference profile to the GeneMapper® ID-X
Software database.

The following profiles were added successfully,

Profile 1D

ANALYST A_YOUR INITIALS

< | >

7. Shift-click to select the ID_CustomControl.fsa and
QC_Sample_01.fsa rows, then select Tools » Add
Profile » Custom Control.

8. Click Close in the Add Profile Results dialog box to save the
assigned custom control profiles to the GeneMapper® ID-X
Software database.
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Step 5: Import Lab Reference and Custom Control Profiles

Viewing Profiles in 1. In the Project window, select Tools » Profile Manager.

the Profile . , o . _ ,
Manager 2. View the list of profiles in the Profile Manager window. Click

to expand at least one Profile ID to view the genotypes
stored in the GeneMapper® ID-X Software database.

»* Profile Manager @

L =

© Expand &ll Collapse all

= Profile 1D [ Marker Type Alleles

=
... # 0851179 13, 14
... # D21511 258,29
... % DF5820 g, 10
.. % CSFIPO 10, 11
. % [351358 13
% THO1 g, 9
- D135317 12
. # DI65539 12
- D251338 13
- 0195433 14
. ) 15, 16
. TPOY g, 11
... # D15551 13, 14
. ® AMEL %
... # D55818 11, 12
. FGA 20, 24

-] 9C SAMPLE 01 _YOUR INITIALS Custom Cantral

-] AMNALYST A_YOUR INITIALS Lab Reference

’ Delete ] [ Export ] [ Close ] ’ Help ]

3. Click Clese to close the Profile Manager window and return to
the Project window.
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Step 6: Set the Project Options

Step 6: Set the Project Options

Overview Project Options are user-specific project preferences that allow you
to specify default security and analysis options for your user account.

In This Section In this section, you will set the software to:

* Automatically assign a security group (available selections
determined by user account) when you create a project.

* Automatically assign analysis settings when you add samples to
the project.

» Display the Analysis Requirements Summary (ARS) to identify
any conditions that could prevent analysis.

» Automatically disregard low-quality allelic ladders and proceed
with the analysis of run folders containing one or more passing
allelic ladders.

* Display the Analysis Summary, which provides a snapshot of
the analysis status of all samples in the project and the quality
status of allelic ladders, controls, and samples.

Note: These options are suggested for an optimized, efficient data
review workflow. However, you can modify project options as
needed to meet your laboratory workflow requirements.

Setting Project  Project options are associated with the user account currently logged
Options in to the GeneMapper® ID-X Software (in this example, the Practice
User).

Note: Set project options when you obtain your personal or lab-
specific user account. For more information on the GeneMapper®
ID-X Software security system, see the GeneMapper® ID-X Software
Version 1.0 Administrator’s Guide.
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Chapter 2 Setting Up the Software
Step 6: Set the Project Options

1. Select File » Project Options.

2. Complete the Options tabs for the Practice User as described in
Table 5 on page 53, using the GeneMapper® ID-X Sofiware
Help as a guide.

Table 5 Practice User project options settings

Tab Settings

General Verify the settings as shown below:

()

Options

{ General | #dd Samples | Analysis|

Project

(%) Open Blank Project

O Open Previous Project

Plats
|7 [[] Update plots when changing project tab

Security group when creating objects Practice Security Group

|'Data Access Conkrol

52 GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 2 Setting Up the Software n
Step 6: Set the Project Options

Table 5 Practice User project options settings (continued)

Tab Settings

Add Enter the settings as shown below:
Samples

General | Add Samplas | Analysis

When adding new samples, automatically....
Set Analysis Method to:

® |Getting Started_your initials LI for all samples,
(") Read From the Sample.

Set Size Standard ko
(@) |CE_65_HID_GS500 | For all samples.
(") Fead From the Sample.

Set 3L0J377 Matrix to:

| J fFor all samples.

(%) Fead From the Sample,

St Panel to:
@l Tdentifiler w13 | for all samples. To set a panel for all samples:
() Read from Data collection ‘Comment/Panel field' . e Click in the text field to open

- the Select a Panel dialog

e Click to view the available
® fsemple [ | Gereecmes AmpF{STR® panels, then select
(") Read From Data collection 'Infa’ Figld. the Identifiler_v1X pane|

Set Sample Type ko;

»* Select a Panel

# MNone

(=] AmpFLSTR_Panels_v1%
------ # EBlue_vix

------ # Profiler _v1x

------ # Green_I_wviX

------ & Profiler_Plus_wlx
------ & COfiler_wlx

------ # SEfiler_wix

------ & 5GM_Plus_w1x

------ # Profiler _Plus_CODIS_w1x
------ # COfiler_CODIS_wiX

------ & filer_wlx

------ # Identifiler_CODIS_vix
...... # MiniFiler_GS500_w1%

l oK H Cancel ][ Help ]

¢ C(Click OK to close the dialog
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Step 6: Set the Project Options

Table 5 Practice User project options settings (continued)

Tab Settings

Analysis Click Help at the bottom of the tab to learn more about the options presented in the
Analysis Summary area of this tab, then enter the settings as shown below:

Options §|

General | Add Sample

Analysis Surnmary
If one or more analysis requirements are not met

(%) Stop analysis and display Analysis Reguirements Summary
() Continue analysis
If one or more allelic ladders do not meet sizing and)or genotyping requirements
() Stop analysis and display Allelic Ladder Analysis Summary
(%) Continue analysis of run folders with at least one passing allelic ladder
() Continue analysis of all run folders
After Analysis
@ Siew Analysis Summary
() View Sample Table

rAutomatic Analysis

[] Automatically bring low quality samples to the top

rCualicy Metrics Display
(%) Symbols
() Mumbers

rIf only one labelled allele in a genotype, then duplicate the |abel

[] buplicate homaozygous alleles

I QK H Cancel H Help ]

3. Click OK after completing all tabs to close the Options dialog
and return to the Project window.
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m Chapter 3 Creating a Project, Analyzing, and Reviewing Analysis Workflow Summaries
Overview

Overview

During analysis, the GeneMapper® ID-X Software performs the
following tasks, based on the analysis settings and project options set
up in Chapter 3:

* Analysis requirements check

» Data analysis (peak detection and sizing, allele-calling)
* Allelic ladder and sample quality assessment

* Analysis workflow summary generation

This chapter will demonstrate these tasks using the example data set
provided with the software.

In This Chapter In this chapter, you will learn how to:
» Create a project and add samples
* View sample details
* Select analysis settings
* Analyze the data

* Review the analysis workflow summaries (Analysis
Requirements Summary, Analysis Summary)

Step 1: Create a Project and Add Samples

Creating a  Ifa project is already open in the Project window, click =, (New
New Project Project).

Note: If you have a previous project open you may be prompted to
save changes. Click Yes.
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Chapter 3 Creating a Project, Analyzing, and Reviewing Analysis Workflow Summaries
Step 1: Create a Project and Add Samples

Adding Samples 1. Inthe new Project window, click %, (Add Samples to Project).
from Sample Files

2. In the Files tab of the Add Samples to Project dialog box,
navigate to the folder containing the example data, select the
Identifiler Samples folder, then click Add to List.

»* Add Samples to Project

Edit  View
Files | GMID-% Database Samples To Add:
g My Computer Al Ee ) dentifiler Samples

g 3% Floppy (A2

£+ DVYDCD-RW Drive (E:)
=i~ Local Disk (C:)

-3 AppliedBiosystems
[#-[C3) Database Dashboard
=] 2 GeneMapperID-¥
+-[3) app

|25) Applied Biosystems Service
|25 config

|C5) Database

|C5) Database Defaults
|C5) Docs

JJ-[.3) Example Data

R 1 cl=rtifiler Samples

(-3 service
(-3 OracleGMIDY v

Add To List == k
Options. ..

[ Add ][ Add & Analyze ][ Cancel H Help ]

Note: The example data file path shown above is for Full install
configurations only. For the example data file path for Client
install configurations, see “Using the Guide with the Example
Data Provided” on page 18.

3. Click Add. When you add samples from sample (.fsa) files to a
project:
* You specify the location of the .fsa files on the hard drive
or a network drive.

* The sample files remain in their original location on the
drive, and are not stored in the GeneMapper® ID-X
Software project or database.
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Step 1: Create a Project and Add Samples

* The GeneMapper® ID-X Software reads the information it
needs from the .fsa files. No information is written back to
the original sample files.

* The added samples are displayed in the Samples table in
the content pane of the Project window. The run folder
from which you added the samples is displayed in the
navigation pane.

Sampile table lists all files in selected run folder (only Table Setting selected
one run folder in this example). Analysis settings are determines the columns
loaded by default as specified in Project Options. displayed in the Samples table

»* GeneMapper® ID-X - *Untitled - Practice User Is Logged In Database FOSKOSMANC

File Edit Analysis View Tools Admin  Help
[ ] H % @ E' 1 @ - @‘ Table Setting: |Imp0rt Reference Profiles v|[m p S O (7]
B---,;%,Project : Samples |
---@Identifiler Sample: |Status |Sample File: |Sample [Maime |Sample Type |Pr0file I
1 % Ladder Sample
2 @ ID_aAllelicLadder fza Lacider Sample
3 @ ID_CustomContral.fsa |10 CustomContral | Sample
4 @ ID_MegControl fza MegContral Sample
5 @ ID_PosContral fsa PosControl Sample
B @ ID_Sample_01 fsa Sample 01 Sample
7 @ ID_Sample_02 fsa Sample 02 Sample
g @ ID_Sample_03.fsa Sample 03 Sample
9 @ ID_Sample_04 fza Sample 04 Sample
10 @ ID_Sample_05 . fsa Sample 05 Sample
ih! @ ID_Sample_06 fsa Sample 06 Sample
12 @ ID_Sample_07 fza Sample 07 Sample
13 @) ID_Sample_05 . fsa Sample 03 Sample
Progress Stat)is ... 0% Stap
Navigation pane @ indicates samples have
lists run folders for not been analyzed

added samples
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Step 2: View Sample Information and Raw Data

4. In the Project window, select 31XX Data Analysis from the
Table Setting drop-down list. Only the columns needed for
analysis of ABI PrISM® 3100 Series and Applied Biosystems
3130 Series Genetic Analyzer data are displayed in the Samples

table.
@ E] 1 @ - “ Table Setting: |31><>< Data Analysis v | p & (& B e
Samples |Analysis Summary || Genotypes |
[Status [Sample Name  [Sample Type |Analysis Method |custom Contral [aRMM (305 [5G [S3PK M [oMR [Cea

105 Ladder S : Getting Started i deritif G5 _HID_ 0 | Mone
2 % Lacider Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
3 % ID CustomContral | Sample Getting Started_your initials | Identifiler 1% |CE_GS_HID_GS500 |Mone
4 % MegContral Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
5 % PosControl Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
B % Sample 01 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
7 % Sample 02 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
g % Sample 03 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
9 % Sample 04 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
10 % Sample 05 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
ih! % Sample 06 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
12 % Sample 07 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone
13 % Sample 03 Sample Getting Started_your inttials | Identifiler 1% |CE_GS_HID_GS500 |Mone

Step 2: View Sample Information and Raw Data

You have access to the following sample information from the
Project window:

» Sample file, analysis and run parameters
* Raw data
 Electrophoresis, power and temperature (EPT) data
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Step 2: View Sample Information and Raw Data

Viewing Sample

1. Click # to expand the Identifiler Samples folder in the

60

= [ Identifiler Samples

10_AllelicLadder Fsa
10_allelicLadderz Fsa
ID_CustomControl.fsa
ID_MegControl.fsa
ID_PosControl.fsa
ID_Sample_01.fsa
ID_Sample_02.fsa
ID_Sample_03.fsa
ID_Sample_04.fsa
ID_Sample_05.fsa
ID_Sample_06.fsa
ID_Sample_07.fsa
ID_Sample_08.fsa

Sample Information

Sample File : ID_AllelicLadder.fsa

Sanple Name : Ladder
Sample Origin Path
C:vappliedBiosystens), GeneMapperID-X\Exanple Data’Identifiler
JampleshID_AlleliclLadder.faza

Status Message
File Source

: Unanalyzed
: Disk media

Error Message

Message 1 <none-

Last Used Analysis Settings

2]

- |

Information navigation pane, then select the ID_AllelicLadder.fsa sample.
The Info tab for the selected sample is displayed in the content
pane:
= s Project Info | Raw Data || EPT Data

The Sample
Information, Error
Message and Last
Used Analysis
Settings areas are
updated each time
you analyze

2. Click the vertical scroll bar at the right of the Info tab window to
review the following sample-specific information presented in

this tab:
Info Type Info Listed for Selected Sample
Sample e Sample file name and sample name
Information e Sample origin path and file source
e Status message indicating any changes made to
the sample in the Samples table
Error Message e Errors encountered during analysis (if any)
Last Used * Last settings used for analysis
Analysis Settings | Note: This area will be blank if the sample Status is
@ (Unanalyzed). After analysis, the settings last
used to analyze the sample file are displayed in this
tab regardless of the analysis settings selected in
the Samples table.
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Step 2: View Sample Information and Raw Data

Info Type Info Listed for Selected Sample

Run Information ¢ Instrument user name

¢ Instrument name and Data Collection version

e Run date (in yyyy:dd:mm) and time (in hr:min:sec)
e Run duration

e Total data points

Note: All sample files created during one injection
on a multi-capillary instrument (a set of 4 or 16
capillaries) will have the same run date, run time,
and injection time.

Data Collection ¢ Run voltage and injection voltage (in volts)
Settings e |njection duration (in milliseconds)

e Laser power (in mW) and temperature (in °C)
¢ Run module and run protocol name

¢ Dye set name

e Polymer lot number and expiration date

e Results Group name

Note: Results Groups apply to ABI PRism® 3100
Series Data Collection Software v 2.0 and
Applied Biosystems 3130 Series Data Collection
Software v 3.0 only.

Capillary ¢ Length and number of capillaries
Information ¢ Capillary number used for injection

GeneMapper® /D-X Software Version 1.0 Getting Started Guide 61



n Chapter 3 Creating a Project, Analyzing, and Reviewing Analysis Workflow Summaries
Step 2: View Sample Information and Raw Data

Viewing Raw Data You can use the raw data view of a sample to help evaluate any
anomalies, the causes of poor size-calling, and to determine the start
and stop points for analysis.

1. Select the Raw Data tab in the content pane. The raw data plot
for the ID_AllelicLadder.fsa sample is displayed.

Info | RawData | EPT Data
I0_AllelicLadder Fsa

AR JLL\ULL__MMWMM“M_,
E 5]

data point: 4803 rfu: 2240

2. Select the EPT Data tab in the content pane. The EPT plot is
displayed.

Info || Raw Data | EPT Data
10_allelicLadder Fsa

[ F ] 4 (2] S 10 12000 12000 16U

EP Voltage EP Current
Laser Power  n— RurTemp.  p—
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Step 3: Select Analysis Settings and Start Analysis

3. Select the Project node in the navigation pane to return to the
Samples table view.

N Samples |

Identifiler Samples

[ ID_AllelicLadder Fsa

- ID_AllelicLadderz . fsa
- ID_CustomControl Fsa
- ID_MeqgControl.fsa

- ID_PosControl.Fsa
ID_Sample_01.fsa

|Status |Sample [Maime Sample Type

all}

Ladder

@ Lacder Sample
@ 1D CustomCortrol |Sample

= w| e

MegContral Sample

Step 3: Select Analysis Settings and Start Analysis

Analysis settings include the Analysis Method, Size Standard, Panel,
and Sample Type selections needed to perform analysis. Based on
the Project Options you set in Chapter 2, the samples you added to
the Samples table automatically have analysis settings specified.

Selecting Analysis Note: In this section, you will intentionally alter some of the
Settings  analysis settings in the Samples tab to trigger the display of the ARS
when you start the analysis.

1. In the Project window, make sure 31XX Data Analysis is
selected from the Table Setting drop-down list.

2. Enter the Samples tab analysis settings as shown below:

Samples |
Status | Sample Mame Sample Type Analysis Method Panel Size Standard Custom Contraol

1 @ Lacider 2 14 Mone Identifiler_w1¥ |CE_GS_HID_GS500 |Mone
2 @ Lacider Getting Started_your inttials | Identifiler w13 (RIS Mone
3 @ 1D CustomContral |3 Getting Started_your inttials |ldertifiler 13 |CE_GS_HID_GS500

4 @ MegContral (N Getting Started_your initials |Identifiler_w1X (CE_GS_HID_GS500

5 @ PosControl Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
B @ Sample 01 Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
7 @ Sample 02 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
g @ Sample 03 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
9 @ Sample 04 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
10 @ Sample 05 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
ih! @ Sample 06 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
12 @ Sample 07 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
13 @ Sample 03 Sample Getting Started_your inttials | ldentifiler 13 |CE_GS_HID_GS500 |Mone
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Step 4: Review the ARS and Correct the Requirements

Starting Analysis Click # (Analyze).

When analysis is started, the software identifies any conditions that
may prevent analysis or cause unexpected results, sets a . flag for
Analysis Requirements Not Met (ARNM) PQV and displays the
ARS if chosen in the Project Options. In this example, we have
chosen to display the ARS.

The Analysis Requirements Summary dialog box opens because at
least one sample in the project does not meet one or more analysis
requirements.

»* Analysis Requirements Summary

2 samples do not meet one or more analysis requirements,

# Samples That Do Mot
X | Meet Requirement
Analysis Method Mot Selected 1

Size Standard Mot Selected 1

Analysis Requirement Mok Met

‘what would you like to do next?
() View sample(s) that do not meet ane or maore analysis requirements

() Continue analysis

[ OF H Cancel H Help ]

Step 4: Review the ARS and Correct the
Requirements

64

Reviewing the From the ARS, you may view the samples that do not meet the
ARS analysis requirements or you can continue with analysis. In this
section, you will view the flagged samples in the example project.

1. Keep the default selection in the What would you like to do
next? area of the ARS, then click OK.

The Samples table opens. If one or more analysis requirements
are not met, the ARNM PQV is set to ;* . Based on the analysis
settings changes you made in step 2 on page 63, note that only

the allelic ladder samples in the example project are listed with
a /. ARNM flag in the Samples table.
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Step 4: Review the ARS and Correct the Requirements

Samples tab label bold italics indicates

indicates table is filtered table is filtered

= = BE W = @  Table Setting: | |31% Data Analysis =

Samples (Fil‘tered)

Status |Sample Name | Sample Type | Analysis Method Panel Size Standard Custom Contral | ARNM

1 @ Lacider Allelic Ladder  |Mone Identifiler_w1¥ |CE_GS_HID_GS500  |Mone

2 @ Lacider Allelic Ladder | Getting Started_your initials |Idertifiler_w1X |Mone Mone
Check
ARNM PQV

When you view the Samples table from the ARS, the Samples
table is filtered. The current table setting is applied to determine
which columns are displayed, but only the samples in the
category selected are listed. In this example, samples that do not
meet the analysis requirements are listed. The filtered condition
of the table is indicated by the status of the Samples tab label
(filtered) and the Table Setting label (bold italics).

2. Place the pointer overa ;. ARNM flag to display a tooltip with
analysis requirement information for each sample in the filtered

Samples table.
Samples (filkered)
Status |Sample Name | Sample Type | Analysis Method Panel Size Standard Custom Contral  |ARNM |S0S |56 SEPK
1 @ Lacider Allelic Ladder  |Mone Identifiler_w1¥ |CE_GS_HID_GS500  |Mone _|_ s
2 @ Lacider Allelic Ladder | Getting Started_your inftials |ldentifiler_v1X |Mone Mone Enalysis Method Mot Selected|

Note that the analysis Status for the samples is still T
(Unanalyzed).
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Step 5: Analyze the Data

Correcting the  To correct the unmet requirements listed in the ARS, change the
Analysis analysis settings in the Samples table back to their original values:

Requirements , i
1. Change the Analysis Method for the first Ladder sample to

Getting Started.

2. Change the Size Standard for the second Ladder sample to
CE_G5_HID_GS500.

The updated Samples table analysis settings should be:

Samples (filkered)

Status |Sample Name | Sample Type | Analysis Method Panel Size Standard Custom Contraol
1 @ Lacider Allelic Ladder  ReElER=EG T ATE M Idertifiler _w1X (CE_GS_HID_GS500  |Mone
2 @ Lacider Allelic: Ladder | Getting Started_your initials | Identifiler w1 e 0o

=5 HID SIS Fone

Step 5: Analyze the Data

Analyzing the In this section, you will analyze with all analysis requirements
Data satisfied and display the Analysis Summary.

1. Click I (Analyze).

2. Complete the fields in the Save Project dialog box:

a. For Name, type Getting Started <your initials>. For
example, Getting Started AB.

b. Verify that the Practice Security Group is selected from the
drop-down list.

Save Project

Mame: | Getting Started AR |

Security Group: |Practice Security Group b |

[ OF H Cancel H Help ]

c. Click OK to save the project to the GeneMapper® ID-X
Software database and start analysis.
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Step 5: Analyze the Data

Viewing Analysis After saving the project to the database:

Progress » The project name (entered in step 2a on page 66) appears in the

title bar of the Project window. For example:

»* GeneMapper® ID-X - *Getting Started|AB - Practice User Is Logged In Database

* The software then begins analysis.

Note the following after analysis begins:

* Allelic ladder sample types are analyzed before all other sample
types in the project. The sample currently being analyzed is
highlighted in green in the Samples table:

Samples | analysis Summary | Genotypes |

Status Sample F |Sample M| Sample IC|Comment | Sample T | Specimer | Analysis |Panel Size Star [Custom C | hatrix Fun Marmi | Instrumer | Instrume
1 IC_aAllelicl | Ladder Mone Allelic: La'n‘ Mo Expor; Getting Sb Identifiler’ CE_GS_I; Mone Mone Ideritifiler |ABIZ100 (3100

ID_Allelicl |Ladder | ca9539ck |Mone Allelic La’n‘ Mo Expor; Getting SP Identifilerp CE_GS_I; Mone Mone Identifiler |ABl31350 |1405-04

ID_Custon | ID Custon | e163912E |None Posi‘ti\reg

Mo Expor | Getting S | Idertifiler |CE_GS_F
L L L L

CUSTOM. Mone lelertifiler |ABI313530 |1405-04

pContr 11de 2 Mone

ID_PosCe |PosCaontr | ebddid 7 Mone Posi‘tiveg

Mo Expor; Getting S‘ Identifiler’ CE_GS_I; Idertifiler |ABI3130 |3130-16

ID_Sarmpl |Sample O | ek 90 Mone Sample Mo Expor; GeﬂingS“Idemifiler‘ CE_GS_I; More More ledertifiler |ABI3130 |3130-16

= m| S | e

0| 1|

ID_Sampl |Sample O | ebddbd 92 Mone Sample Mo Expor; GeﬂinngIderdifiler’ CE_GS_I; More Mone Idertifiler | ABI3130 |3130-16

* Analysis progress is displayed at the bottom of the Project
window:

Analyzing Samples ... ! 3% [ Step ]‘
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Step 6: Review the Analysis Summary

About the Based on the Project Options you set in Chapter 2, the Analysis
Analysis  Summary tab is displayed when analysis is complete.
Summary Tab

Samples | Anakysis Summary | Genokypes

Analysis Summary Summary Generation Date:

Select run Folder ko display: | |

Sample Status [ Total # of Samples ]
[@ Unanalyzed o
Analyzed 13
L)j Analysis Setting Changed o

Click a link below to display a filtered Samples Table containing only the samples selected.

Allelic Ladder Quality per run folder {based on S0 and CGQ only)

Run Folder [ Total # of Analyzed Ladders [
Identifiler Samples 2

.

Control Quality per project (hased on sample POVs: S05, S5PK, MIX, OMR, 5Q, CGQ)

[ Control Type [ Total # of Samples [ All threshaolds met [ 6 One or more thresholds not met
Positive Control ]

Customn Contraol
Megative Control
Total

o= = | 1=
| ==
===

Sample Quality per project (based on sample PQVs: S0S, SSPK, MIX, OMR, 50, CGQ)

[ [ Total # of Samples [ Al thresholds met [ 6 One or more thresholds not met ]
Samples g 4 4 |

For efficient data evaluation, the Analysis Summary tab:

* Provides a summary of the analysis status for all or a subset of
samples in the project

* Displays an overview of allelic ladder, control, and sample
quality

* Visually separates passing samples from samples that do not
meet one or more quality thresholds
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» Provides interactive links to specific categories of samples
(passing/check/low quality, allelic ladder/control/sample)

IMPORTANT! Refer to your own laboratory protocol to determine
the samples (allelic ladder, positive control, negative control, custom
control, and unknown) that require manual review when analyzing
data generated in your laboratory.

Briefly review the features and areas of the Analysis Summary tab as
described below, then continue to Chapter 4, where you will review
the functions of this tab in more detail.

Features of the Note the following features of the Analysis Summary tab:

Analysis * You can display an Analysis Summary for the entire project or
Summary Tab for an individual run folder in the project by selecting a run
folder from the drop-down list at the top of the tab

Note: If the project contains only one run folder, this selection
is dimmed.

In this example, Identifiler Samples is the only run folder in the
Getting Started project:

Select run fFolder ko display:

* Blue links take you to a Samples table displaying only the
samples of interest

[ Takal # of Snalyzed Ladders ][ | ][ ][ ) ]

| 2 S R
Click to display a Click to display a Samples
Samples table table with only allelic
displaying only the ladders that did not meet
allelic ladder samples one or more requirements

* Tooltips explain symbols

Place the pointer over symbols to display tooltips

|
@:}E &)

—'| Pass 5@ and CGQ, or override CGQ | C‘heck S0, Pass CGQ | —‘| Lo Quallty SQor 0G|
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70

Areas of the
Analysis
Summary Tab

Analysis Status

The Analysis status area at the top of the Analysis Summary tab
indicates that all samples in the Getting Started project are analyzed.

[ Sample Status ][ Total # of Samples ]
[@ Unanalyzed 0

Analyzed 13
'-:5 Analysis Setting Changed 0

Allelic Ladder Quality

The Allelic Ladder Quality area indicates that of the two allelic
ladder samples analyzed in the Getting Started project, one met all of
the allelic ladder quality requirements ([l ) and one did not ( @ ).

[ Run Folder ][Total#of Analyzed Ladders ][ ) ] 6

Idertifiler Samples | 2 | 1 | 0 | 1 |

You can use the allelic ladder quality results to determine the
samples that require manual review. For example, if each run folder
contains at least one passing allelic ladder and the positive and
custom controls meet all quality value thresholds, visual inspection
of the allelic ladders may not be required. Depending on validation,
you can proceed directly to evaluation of the controls or samples in
the project.

Control Quality

The Control Quality area of the Analysis Summary indicates that of
the three controls analyzed in the Getting Started project, the positive
and custom controls met all quality thresholds ( [Ji] ) and generated
the expected profile, but the negative control did not.

Control Type ][Tu:utal # of Samples ][ all thresholds met ]@ one or more thresholds not met ]

Positive Conkrol

1]

Zustom Conkrol

Megative Control

Total

o = = {1
IS Ll o
= (==

When validated, this area of the Analysis Summary may eliminate
the need for you to visually inspect the control samples if they fall
under the green All Thresholds Met column. Controls in this column
have met all sample-level and marker-level quality values, including
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Control Concordance (CC). This means that the sample genotypes
for positive and custom controls match the expected known profile
without any anomalies. For negative controls, this means that there
were no peaks detected above the peak amplitude threshold.

You can also use the control quality results to verify allelic ladder
quality. For example, allelic ladders may meet all requirements, but if
their migration rate differs from the sample migration rate, samples
and controls may contain OL calls. However, controls that met all
thresholds (and therefore do not contain OL calls), may indicate
consistent migration rates for allelic ladders and samples.

Sample Quality

The Sample Quality area of the Analysis Summary indicates that of
the eight samples analyzed, four met all quality thresholds ([ ) and

four did not (@).
][Tu:utal # of Samples ][ (8 Al thresholds met ]@ One of more thresholds not met ]
Samples | g | 4 | 4 |

In Chapter 4, you will use the blue links to visually inspect certain
categories of samples.
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Overview

The Analysis Summary discussed in Chapter 3 guides you directly to
different types of samples while following a logical data
interpretation workflow, regardless of whether the software is being
used as an expert system or not. In a traditional manual review
workflow, you would most likely visually inspect all unknown
sample electropherograms. In a validated expert system workflow,
you would only view those samples that did not meet one or more
quality value thresholds.

Note: Refer to your own laboratory protocol to determine the
controls and samples that require manual review.

In This Chapter In this chapter, you will review the example data analyzed in
Chapter 3 and learn how to:

* Use the Analysis Summary tab and filtered Samples table to
examine allelic ladder, control and sample quality

» Investigate sample-level PQVs, and marker-level PQVs using
the QVD pane

» Review sample plots and edit peak labels

* Adjust plot displays to determine the source of artifacts

Note: Some steps performed in this chapter are included only to
demonstrate the use of certain features in the GeneMapper® ID-X
Software and may not be a part of your routine analysis workflow.

Step 1: Examine Allelic Ladder Quality

Overview The order of information displayed in the Analysis Summary is
designed to direct you to evaluate the allelic ladder quality first. The
designation is based on a set of allelic ladder requirements. If there is
at least one passing allelic ladder per run folder and the positive and
custom controls meet all quality value thresholds as displayed in the
Analysis Summary, you may not require visual inspection of the
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allelic ladders and may proceed directly to evaluation of the controls
or samples in the project (depending on validation). However, for the
purposes of this guide, you will walk through the process for
manually reviewing allelic ladder samples.

Viewing Allelic  In Chapter 3, the Allelic Ladder Quality area of the Analysis
Ladder Quality Summary tab indicates that of the two allelic ladder samples
Status analyzed, one has met all allelic ladder requirements ([ ) and one

has not ( @).

Allelic Ladder Quality per run folder (based on SQ and CGQ onhy)

[ Run Folder ][Total#of.ﬂ\nalyzed Ladders ]@:]I]
| ¢ [ o | 1 |

Idertifiler Samples | z

Note: Low-quality (#) allelic ladders are not used to create bin
offsets.

Examining the 1. If the Getting Started project is not already open, click =
@ Low-Quality (Open Project) in the Project window.
Allelic Ladder

Note: Ifyou have a previous project open you may be prompted
to save changes. Click Yes.

2. In the Open Project window, select the Getting Started <your
initials> project, then click OK. The Getting Started project
opens in the Project window.

3. In the Samples table, verify that 31XX Data Analysis is
selected from the Table Setting drop-down list.

4. Verify that the Analysis Summary tab is selected in the content
pane.
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5. Inthe Allelic Ladder Quality area of the Analysis Summary tab,
click the link for the @ allelic ladder sample.

Allelic Ladder Quality per run folder (hased on SQ and CGQ only)

Run Falder ][Total # of analyzed Ladders [ i @

Identifiler Samples | z 1 | 0 I |
]

The filtered Samples table displays the selected sample. Note
that this low-quality allelic ladder sample has a @ CGQ PQV.

Samnples (fikered) | Analysis Summary | Genotypes

Status |Sample Mame | Sample Type | Analysis Method Panel Size Standard Custom Contral | ARMM |SOS |SQ |SSPK M |OMR |GG
|1 Lacider Allelic Ladder |Getting Started_your inttisls (ldentifiler_w1X |CE_GS_HID_GS500 |Mone | 0
Low Quality
CcGQ PQV

6. Select the Ladder sample in the filtered Samples table, then
click (Display Plots). The plot for the selected allelic ladder
sample opens in the Samples plot.

7. Click (Maximize) in the top-right corner of the Samples
plot to maximize the display.

BE

8. Seclect Data Interpretation from the Plot Setting drop-down
list.

File Edit “ew Plots Tools Alleles Help

% Ep. Plat Setting:|Data Interpretation v[:%@
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Based on the display options of this default plot setting (see
Chapter 2), the Samples plot displays:

* Two electropherogram (dye) panes in a single view
» Each pane zoomed to the 75 - 450 base pair range

» Each of four dyes (blue, green, yellow, red) in a separate
pane

» The Genotypes table and QVD pane displayed under the
electropherograms

w* Gotting Started AB : Samples Plot

File Edt Wew Pocs Tooks Aielss  Heb

& [3 PbiSeing: Daka Interpretaton #|F  paezlz | (W (W | BT WL EEEE A | @
A | ho i[Re] | (D 4§ S | 8 RE

e e [os sq s wx ow ceg

_AldirLaddes? fr2. [Ladder O] &

Electropherogram
(dye) panes

_AldirLadder? fr2. [Ladter ] &

U W

3
H
H

B

Sampletare  |Merker  |alklq Aleez |05 |BH |PHR |LPH WPH 5K &N |BD [CC |G buality Value Details
Lsaser eSS ‘ ‘ 1 L [Te e inciviciual quality value details, select & single row.
Lorkier GEEQ] IC] CHE 3
Ladkier o7saz IF] ICHE &
Ladker CEFIPD & [
Ladder D351358 IC] CHE &
Lorkier THIY IC] CHE @
Ladkier GIEETR IF] ICHE &
Ladker Di6ssia & [
Ladder 0251338 IC] CHE &
Lacker 0195433 IC] CHE @
Ladkier e, IF] IF] &
Ladker TROX, 5 T 2 ’7’7’7’77
Ladder o18ss1 IC] | CHEN (]
Ladder EEL X v IC] ICRCRCRC IC]
Ladkier = 3 IF] ’_’_’_’_’__ ]
Ladker = (i 13
Genotypes table QVD pane
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Note the appearance of the marker headers and bins:

Marker header colors
correspond to GQ flag color

Sample File Sample Name s0s [sQ  [ssPK MIX [oMR [ccQ
ID_AlldicLadder? f5a Ladder | | |o
persm ]

Virtual (pink) bin Physical (gray) bin

The marker headers are color-coded (green, yellow, red) to
reflect the GQ flag color. Bins are displayed according to bin
type (see Chapter 2), with virtual bins in pink and physical bins
in gray.

Note: For more information on virtual and physical bins, see
the GeneMapper® ID-X Software Version 1.0 Reference Guide.
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9. To investigate the reason why a particular marker failed the
allelic ladder quality assessment, click the red D8S1179 marker
header in the blue dye pane to display quality assessment
information in the QVD pane for this marker.

—  ——
1111 1™

<

.11

Sample Mame | Mark

|ilele 1 |Alele 2 [0S BN |[PHR |LPH MPH |SPK [an B0 |cC [ca Quality Value Details

Lacldler L 74 J& |ha [NA {NA [NA | (MA [MA [MNA i
—||©Q=100
Ladder L2151 [0]
Lacder 075320 & One or more allelic ladder requirements have not heen met. See helow:
Ladder CSFIPO ® - One or more peaks were not detected
Laelder D3z1358 0 Cue to the above reason(s), this l1adder has not been used to generate hin offsets
Laccler THO i)

Note: The columns displayed in the Genotypes table are
determined by the table setting selected in the Project window.
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The QVD pane displays the allelic ladder quality requirement
that was not met for the selected marker. In this example, one or
more of the expected allelic peaks fell below the peak amplitude
threshold set for the D8S1179 marker.

Quality Value Details
GQ=0.0

Cine or mare allelic ladder requirements have not been met. See below:
- One or more peaks were not detected

Diwe to the above reasaonis), this ladder has not heen used to generate bin offsets.

10. Click the vertical scroll bar at the right of Samples plot until you
can see the D5S818 marker in the red dye pane.

10_#llelicLadder? fsa Ladder “E “E ||i ‘ | |o [7] Mark Sample For Deletion | #

L T L —— L

75 115 155 195 235 395 435

R |

aaa I
o]

10_allelicLadder? fsa Ladder “E “E ||i ‘ | |0 [ Mark Sample For Deletion
= 055818 | [FGa |
75 15 155 195 235 275 318 355 395 455
]
i @JL I

Z0 2| [33.2 442|472

ul

E‘E‘L@‘ LL‘L L gH 23] 153 s3] 12 %
[10] [12] [14] 1] #33] [s62] [0

i

Click the scroll bar——
to display the next
electropherogram
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11. Click the green D5S818 marker header to display the quality
assessment details for this marker.

ID_ANdicLadde? f5a

118

= ® @ @ [ [ (@

155

[FEa

195 235 278 318 355
" A\MMJ\NMMJJ‘\M‘ AJUUU\M\M

ot RS
B [ IEIL sl

(171 | 19| B[ oelar] | facfar] | Eelmaa]eaca
Esloafisl Gufialfad

|

<
Sample Mame |Marker  |Allele 1 |Alele? |OS BN |PHR |LPH |MPH |SPK &N |BD |CC
Lacider D831179 ry
Lacider D21511 &
Lacider D73820 &
Lacider CSFIPO &
Lacider D3%1358 &
Lacier THOH &
Lackder D13537 &
Lackder D165539 &
Lacider D251336 &
Lackdler D195433 &
Lacder A F
Laider TPOX |6 7 &
Lacider D18s51 &
Lacider AMEL ¥ Y & @ [ |
Lacider 7 8 N N

18

1‘0100000000000%

Quality Value Details
Ga=1.0

All allelic ladder requirements met for this marker.

The QVD pane indicates that all allelic ladder quality
requirements are met for the selected marker. Based on the
calculated GQ values shown in the QVD pane, this marker is
flagged as Passing quality ([J] ). However, since one or more
markers within this allelic ladder sample do not meet all quality
requirements, the allelic ladder is classified as Low Quality
(@) and it will not be used to create bin offsets.
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12. Click |2 (No Table) in the Samples plot toolbar to hide the
Genotypes table and QVD pane, and view only the dye panes.

Note: This toolbar selection does not alter the selected plot
settings.

w»* Getting Started AB : Samples Plot

File Edt wiew Plots Tools Alleles Help

&R rosmwolomnmmn W@ | el ¥ EECEEE | B UEHI GEESE A 0
() | A dh(8] | (W) B S5 | & AR
[ sample Ee Sample Name S05 [SQ  [SSPK MIX |OMR |cGQ
TD_ATdicL addec? 53 Ladder ‘ | \0 [ Mark Sample for Deletion
L2k — T S— pressr ]
75 15 155 195 =5 275 315 385 305 a3
20

L 1 —

BB R i
TD_ATdicLadde? fsa Ladder ’7,7’07 ] Mark Sample For Delet

ion
Dssgig [FeA
s 116 165 196

355 305 a5

-

1]

Ay ¥
El“

(L £l

[x 384,11 ¥ 130]
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13. Select 4 from the Panes drop-down list to display all dyes in the
Samples plot.

While this particular ladder would not be usable (since several
expected peaks are missing), if another ladder had broad peaks
or a spike but was still genotyped accurately, you may override
CGQ for the ladder, which will then automatically apply the bin
offsets from that ladder. This procedure is recommended only if
you do not have another passing ladder.

14. Select File » Close Plot Window to return to the Project
window.

Step 2: Examine Control Quality

Overview

Viewing Control
Quality Status

In this section, you will use the features of the Analysis Summary tab
and the Samples plot to manually verify the quality of the control
samples analyzed in the Getting Started project in Chapter 3.

Select the Analysis Summary tab in the Project window.

In Chapter 3, the Control Quality area of the Analysis Summary tab
indicates that of the three control samples analyzed, two were of
Passing quality ([[l] ) and one was of Low Quality ().

If a control has met all thresholds, the expected profile was obtained
with no other anomalies detected. Therefore, you may not be
required to visually inspect the control samples. However, the next
two sections demonstrate how to manually review the control
samples.

GeneMapper® /D-X Software Version 1.0 Getting Started Guide 83



n Chapter 4 Manually Reviewing and Interpreting Data
Step 2: Examine Control Quality

Examining a

Passing
Control

1. In the Control Quality area of the Analysis Summary tab, click
the link for the Custom Control sample.

Control Quality per project (hased on sample POVs: S05, S5PK, MIX, OMR, 5Q, CGQ)

[ Control Type [Total # of Samples [ All threshaolds met [ 6 One or more thresholds not met
Positive Control 1 1 o
Custom Control 1 1 o
Megative Control 1 4’"] 1
Total 3 = 1

The filtered Samples table displays the selected sample. Note
that all sample-level PQVs for this custom control sample

are [ .

Samples (filered) | analysis Surnmary | Genokypes

|Status|Samp\e Maime |Sample Type |Analysis Method ‘Panel |Size Stancard |Cus‘tom Cortrol

[4RMM [0S [S0 [S5PI MK [OMR[CG0
|3 | |ID CustomCortrol |Pos'rtive Cortral |Geﬂing Started_your intials ‘Iderﬂif\ler_vﬂ( CE_G5_HID_G3500 |CUSTOM CONTROL_YOUR INTIALS | l_l_ l_l_l_

2. Select the ID CustomControl sample in the filtered Samples
table, then click (Display Plots). The plot for the selected
custom control sample opens in the Samples plot.

o Getting Started AB : Samples Plot

File Edit Wiew Plots Tools aleles  Help
S [ Potsotig [petsmeerreton W] peres ] (MW (mME [ET WL HdEE A @
(hh] | bk (] | (U 4 R @ fR
Sample File Sample Hame 505 5@ SSPK MIX OMR |CGQ
10_CustomControl fs= 10 Custarm Control DMark Sample For Deletion d:
[DBST179 |[FESE] | 75820 | lc_snpo
75 115 156 195 375 315 365 395 435
1200
B0
amo.
- " ik ii i
i
f2s]
10_CustomCortrol fsa 1D CustornCortrol [ Mark Sample for Deletion -
D351358 L] | 135317 |D165538 | 0251338
e 1158 158 195 255 276 s B 395 435
3000
2000
1000
o l & A A A l l Ty 2 s ' ey a A
(]

v
< >
;a:p; rxlacrmla-'l : :::;I:z:r?g f;elaﬂ ﬂela2 s |BIN |PHR Qua"ty Value Deta"s

UEIomontrol . . P . . .
o wiew individual quality value details, select a single row.
I CustomControl [D21511 |26 29
I CustomControl [D7S820 |3 10
D CustomControl [CSFIPO (10 11 ]
< |
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3. To investigate the quality of this control sample, click the
vertical scroll bar at the right of the Samples plot to scroll
through all panes. Note that all of the marker headers are
colored green, which indicates that this custom control sample
has met all marker-level PQV thresholds.

Sample File Sample Name s0s [sQ  [SSPK MIX |OMR |CEQ

ID_Custom Conirel f52 D Custom Canrol \E \li \li \li \li \i [[] Mark Sample for Deletion | #
[D351358 ] [THT ] [DI3S3IT | DI65EE ] [DESIEHE
e s 158 195 = 275 a8 0 ams s
200
om0,
2000
200,
1600
1200
.
e L]
A,
BB
ID_Custom Candrol fsa ID Custers Cantral FECECECECEC [ Mark Sample For Deletion
[DI®5433 ] A ] [POX | [DI8SEL %
115 3 135 e 275, 516 565 ass a0
00,
2
o
h A

]

Note: For traditional manual review, if you are required to
visually inspect the control samples (not rely solely on PQVs),
the color-coded marker headers may help reduce the amount of
time spent on this task. If all markers are green, you know that
this control produced the expected profile and no other
anomalies were detected. If a marker header is yellow or red,
you know those are the markers where anomalies were detected.
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4. Click the green D8S1179 marker header in the blue dye pane to
display the quality assessment details for this marker. Based on
the calculated GQ value shown in the QVD pane, this marker is
flagged as Passing quality ([ ).

Passing CC PQV

ID CustomContral (D21:511

|#lie 1 |2lele 2 |05 |BMPHR |LPH |MPH |SPK (&M [BD [CC| [G@

Quality Value Details
r RN ~

Ga=1.0

ID CustomCortral | D7PSE20 (& 10 . l_l_l_l_l_l_l_l_l_ All quality value thresholds have been met for this marker.

Note the CC PQYV, indicating that this marker contains the
expected genotype for that marker.

Note: The profile for each sample in the project designated as a
custom control is compared against the custom positive control
profile stored in the Profile Manager. You added the CUSTOM
CONTROL profile ID to the Profile Manager in Chapter 2.

5. Select File » Close Plot Window to return to the Project
window.

Examininga 1. Select the Analysis Summary tab in the Project window.

@ Low-Quality

Control 2. In the Control Quality area of the Analysis Summary tab, click
the link for the @ Negative Control sample.

Control Quality per project (hased on sample POVs: S05, S5PK, MIX, OMR, 5Q, CGQ)

[ Control Type [Total # of Samples [ All threshaolds met [ 6 One or more thresholds not met
1]

Positive Control
Customn Contraol
Megative Control
Total

]
L

1)

o= = | 1=
| ==

The filtered Samples table displays the selected sample. Note
that this negative control sample shows a @ CGQ PQV.

Sarnples (filkered) | Analysis Summary | Genotypes

Status | Sample Mame | Sample Type Analysis Method Panel Size Standsrd Custom Cortrol |ARMM |SOS |56 | SSPK (M |OMR|CGG
|4 MegCortrol  |Negstive Control |Getting Started _your inftisls |Identifiler w1 | CE_GS_HID_G=500 |Mane o
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3. To investigate the anomalies detected in this sample, select the
NegControl sample in the filtered Samples table, then click
(Display Plots). The plot for the selected negative control
sample opens in the Samples plot. Note that several of the
marker headers are colored red and there are peaks detected in

the sample.
Sample File Sample Namne sos [sQ SSPK |MIX |OME |CGQ
TD_Neg Condrel fsa Heg Comiral ,o—
Lo v - £V S| [isE301 R

78 118 155 195 =5 275 318 355

B
ID_Fieg Comdrol £5a Heg Comdrol ,o_
T pEsEr L |

75 115 155 195 255 275 35 355
240
200
160
120

B0

- I M

L]

IEIL

4. Click the red D8S1179 marker header in the blue dye pane to
display the quality assessment details for this marker. Based on
the calculated GQ value shown in the QVD pane, this marker is
flagged as Low Quality (@).
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Step 3: Examine Sample Quality

Sample Mame Marker | Allele 1 [Allele 2 |05 BN PHR [LPH [MPH |SPK |an [BD [CC |30 Quality Value Details

MegControl  |D831179 |15 MA(mA (NA [HA (A (MA [Ma [MA [ Y Q=00

MegControl — D21511 |30 332 L | @

MeaCortral D7sE20 & ) o The following quality value thresholds have not heen met:

MegCortrol CSFIPO 8 12 o _Pay | Size | Observed Yalue | Threshold | G0 Weighting |
= CC|mMfA [ Mon Concordant [ MjA |05

MegContral 0351358 |

Check CC PQV

Note the £ CC PQV for this marker, indicating that this
marker does not contain the expected result. Since peaks are
detected in several markers of this negative control, this
negative control is flagged as low quality.

Note: You will use the Profile Comparison tool in Chapter 5 of
this guide to help determine the possible contributor to this
negative control profile.

5. Select File » Close Plot Window to return to the Project
window.

Step 3: Examine Sample Quality

88

Overview

Viewing Sample
Quality Status

In this section, you will use the features of the Analysis Summary tab
and the Samples plot to manually verify the quality of the unknown
samples analyzed with the Getting Started project in Chapter 3.

Select the Analysis Summary tab in the Project window.

In Chapter 3, the Sample Quality area of the Analysis Summary tab
indicates that of the eight samples analyzed, four met all quality
thresholds ( [l ) and four did not ( @ ).

For the purposes of this guide, you will examine only those samples
that did not meet one or more thresholds. Examination of passing
samples would follow the same workflow.
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Examining the
@ Low-Quality
Samples

Chapter 4 Manually Reviewing and Interpreting Data
Step 3: Examine Sample Quality

1. In the Sample Quality area of the Analysis Summary tab, click
the link for the @ Samples.

Sample Quality per project (based on sample PQVs: S0S, SSPK, MIX, OMR, 50, CGQ)

[ [Total # of Samples

[ Al thresholds met

[ 6 One or more thresholds not met ]

Samples

a

4

i |

W

2. The filtered Samples table displays the selected samples. Note
the /% and @ sample-level PQVs for these low-quality

samples.

Samples (filkered) | Analysis Summary | Genotypes

Status | Sample Mame |Sample Type |Analysis Method Panel Size Standard Custom Cortrol [ARKMM |SOS |SQ | SSPH MK |OMR (CGG
10 Sample 05 Sample Getting Started_your inttialz |ldertifiler _v1% |CE_G5_HID_GS500 Mone F'y &
11 Sample 06 Sample Getting Started_your inttialz |ldertifiler _v1% |CE_G5_HID_GS500 Mone \ 0
12 Sample 07 Sample Getting Started_your inttialz |ldertifiler _v1% |CE_G5_HID_GS500 Mone F Y 0
13 Sample 05 Satmple Getting Started_your inftialz |ldertifiler w1 % | CE_GS_HID_Z5500 |Mone 0

From the sample-level PQVs shown, you can conclude that:
» Sample 05 contains a spike (/% SSPK) within a marker

size range or another minor anomaly within the marker
size range was detected in addition to spike between two

markers (% CGQ)

* Sample 06 is a potential mixture (. MIX)

* Sample 07 has a ;/* SQ, which indicates there is a
resolution issue or a problem with the size standard peak
detection

» Sample 08 contains an unexpected peak in between two
markers (/% OMR) and other anomalies within one or
more marker size ranges (@ CGQ)

Follow the procedures outlined in “Step 4: Review the Low-
Quality Sample Results” on page 90 to individually review the
quality of these unknown samples.
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Step 4: Review the Low-Quality Sample Results

Step 4: Review the Low-Quality Sample Results

Examining the A . SQ PQV indicates that the sizing quality is below the passing
. SQ Sample range specified in the analysis method. This example illustrates:

Results * How to view SQ using the Size Match Editor
* The SQ PQV flag

To examine a /. SQ PQV:

1. Select Sample 07 in the Samples table, then click |E| (Size
Match Editor) to view the peak assignments for the size
standard peaks in this sample.

Peak(s) exceed Broad Calculated SQ value
Peaks (BD) threshold in Check range
Size Matches || Size Calling Curve ‘
Broad Peakl’z) Detected Sizing Quality = 04167
800 175
0 100
00 1330
160
S
200
A
S
200 450
3
200 A0 g
1m
o
2740 37an 4740 5740 E7a0 Tran 8740
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Step 4: Review the Low-Quality Sample Results

Note the following in the Size Match Editor:

» All size standard peaks are present and labeled correctly, as
compared to the fragment sizes stored in the
CE_G5_HID_GS500 size standard definition file set for
this sample

* The calculated SQ value, 0.4167 for this sample, is within
the Check (/" ) range set in the analysis method (default
value = 0.74 — 0.26)

* A “Broad Peak(s) Detected” message indicates there are
peaks present in this sample that exceed the Broad Peak
(BD) Max Peak Width threshold set in the analysis method

In this example, the SQ is due to the broad peaks.

Note: For more information on the calculation of SQ, see the
GeneMapper® ID-X Software Version 1.0 Reference Guide.

2. Click OK to close the Size Match Editor.

Displaying the 1. Shift-click to select all samples in the filtered Samples table,
@ Low-Quality then click [Ill] (Display Plots).
Sample Plots

2. Verify that Data Interpretation is selected from the Plot
Setting drop-down list.

File Edit “ew Plots Tools Alleles Help

& [&  Plot Setting: | Data Inkerpretation %@
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3. The plots for all of the selected samples are shown in the

Samples plot.
Sample File Sample Name $05 [§Q  [SSPK |MIX |OMR |cco
ID_Sample_05 fsa Sample 05 | \ | | \
[Des1IT® |[D2ISIT ] [D7sez0 ] [CSFIPO
TE 18 168 196 5 275 35 355
300
200
100 NA
A A A
iz é
ID_Sample_05 fsa Sample 05 \ \
DI51358 ] WL | 135317 | DI6sE3® | s
TE 18 168 196 5 275 35 355
S0
A0
300
20
1m0 h h
\ . | |
<
Sample Mame | Marker Alele 1 |Alllz2 (05 |BIN PHR LPH |MPH SPK AN |BD  CC (GQ Qua"ty Value Deta“s
Sample 05 |DGS1179 |15 |16 S ) )
i o view individual quality value details, select a single row
Samplz 05 |D21511 |312
Sample 05 |D7S820 |11 [12
Sample 05 |CSFIPO |12
Sample 05 |D3S1358 |16

The first two panes display the blue dye and green dye for the
first sample selected in the Samples table (in this example,
Sample 05).

Note: The selection order in the Samples table determines the
display order in the Samples plot.

Examining the A . SSPK (Sample Spike) PQV indicates that one or more spike
. SSPK Sample peaks have been detected within a marker range or between two
Results markers. This example illustrates:

* Automatic labeling of spikes

* The Marker Spike (SPK) and Peak Height Ratio (PHR) PQV
flags

* How to confirm a spike in raw data

92 GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 4 Manually Reviewing and Interpreting Data n
Step 4: Review the Low-Quality Sample Results

* How to override GQ
* How to override CGQ

To investigate a marker with a yellow or red marker header bar:

1. Click the yellow D2S1338 marker header in the green dye pane
of Sample 05 to display the quality assessment details for this

marker.
ID_Sample 05 Tsa Sample 05 |_ | |
[Das13zE | [TEDY | [DI3531T | 165539 ] D2s1338
78 18 186 195 235 275 35 % 355
S00
a0
S0
- I
100
;AP 1111 1) U S
]
|

3
Sample Mame |Marker  |Slele ! Alele2 |05 BN PHR (LPH |[MPH |SPK AN |BD |CC
Sample 05| THOM 83 (@ (@
Sample 05 |D13S317 |8 12 7]

Sample 05

JQuality Value Details

—| [G@=048

DEm 3

ﬂﬂ|ﬂ
e
oe

The following quality value thresholds have not been met:

: POV Size ::Observed Value Threshald G0 Weighting
PHR 323.82... | 0.5747 <=0.7 0.3
SPK 349.54 Spike {1 0.3

Sample 05

0135433

||SampIeDS WAL, |1s ‘18 | ,.— ‘

Check PHR and SPK PQVs

Note the following:

» There is a peak labeled as “Spike” present in this marker
and the marker-level ;* SPK PQV is triggered, indicating
that one or more spikes are detected within the marker size
range (in this case, one spike was detected)

Note: This peak is automatically labeled as a Spike artifact
and displayed with a pink label border by the
GeneMapper® ID-X Software. Peaks labeled as artifacts
are not considered true alleles by the software and are not
listed in the Genotypes table.

GeneMapper® /D-X Software Version 1.0 Getting Started Guide 93



n Chapter 4 Manually Reviewing and Interpreting Data
Step 4: Review the Low-Quality Sample Results

* The marker-level PHR PQV is also triggered for this
marker, indicating that the peak height ratio calculated
between the lowest and highest allele peaks within the
marker is less than the Min Peak Height Ratio threshold
defined in the analysis method (in this example, 0.7)

2. Click-drag the Size column margin in the QVD pane to the right
to expand its contents and view the peak sizes contributing to
the PHR and SPK PQVs for this marker.

Click-drag column
margin to resize

Quality Value Details

Go=10.449
The following guality ralue thresholds have not been met:
©Opow Size Q%ﬂbserved Yalue Threshold a0 Weighting
PHR. 323.82,... | 0.5747 <=0.7 0.3
SPE 349.54 Spike 1) 0.3
Calculated Calculated PHR GQ Weighting
peak PHR threshold  defined in
positions (bp) threshold defined in  Analysis
Analysis Method
Method

Note: The SPK and PHR PQV status are used to determine the
GQ PQV. Based on the calculated GQ value shown in the QVD
pane, this marker is flagged as Check (% ).
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Step 4: Review the Low-Quality Sample Results

3. In the green dye pane, left-click the Spike artifact label to select
the peak, then right-click the label to open a drop-down menu
containing peak edit actions.

D251338
315 355 305

- —AJ‘\ M}LL Celete Labelis)

Epl Add Allele Label

Rename Arifact Labal #
_ ISR
IMPORTANT! You must left-click the label before you
right-click the label.

4. To confirm the spike peak, select Peak Raw Data from the
drop-down menu to open the raw data plot for this peak in the
Project window.

5. To view the raw data plot, click the GeneMapper® ID-X -
Getting Started <your initials> taskbar button.

GeneMapper® ID-¥ - Getting Started AE - Practice User Is Logged In Database
Fo5S

wt Renﬁ:l"-ﬂapp:rli] D%-.. | pb Getting Started A8 ... "(_'_J 4119 PM
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Info | Raw Data | EPT Data

6. Review the raw data and peak morphology to confirm that the

selected peak is a spike.

ID_Sample_05.fsa
Note: Once you have validated the spike detection PQVs using
your own data, you may not be required to view the raw data to
confirm a spike peak.
7. To return to the Samples plot, click the Getting Started <your
initials> : Samples Plot taskbar button.
Getting Started AE @ Samples Plot
[ b GensMapper® ID-¥ - |k Getting Started AB 1 ... '(_l
8. Right-click the /% GQ PQV in the D2S1338 marker row
highlighted in the Genotypes table.
Right-click PQV
Sample Mame Marker Allele 1 |Allele2 |05 |BIM PHR |LPH |MPH [SPK (AN |BD |CC |GG Quality Value Deta“s
sample 03 Disssss |12 @ o view individual quality value
Sample 05 02513358 |19 25 & & _‘__i_
Sample 05 [195433 |14

96
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Step 4: Review the Low-Quality Sample Results

9. Click Yes in the dialog box to override the genotype quality for
this marker.

Override D251338 Genotype Quality Pz|

\_‘.:/ Override the Genotype Quality of this marker?

Note that after overriding:
* The GQ PQV changes to

* All other PQVs for the marker turn gray and maintain their
original shape (II) to indicate that the marker has
been overridden

* The marker header turns green

Note: Overriding GQ allows you to manually accept the
genotype for a particular marker and also provides evidence that
the marker was visually inspected by the analyst.

10. To accept the entire sample profile for Sample 05, you can
override its ;% CGQ PQV. To do so, first right-click the ;*
CGQ PQV for Sample 05 in the genotypes header of the

Samples plot.
Sample File s05 (S0 SSPK MIX |OMR |CGOQ
ID_Ssmaple_05 £53 | | | , | | | 4+

Right-click PQV

The next dialog box displays a message indicating that there are
still ;% or @ marker-level GQ PQVs present in this sample.
Unless you have viewed the rest of the markers and confirmed
the genotypes, you should not continue with the CGQ override.

Owerride ID_Sample_05.fsa Composite Genotype Quality. Pz|

€p | Oneor more Genotype Quality flags in this sample are still yvellow or red.
\‘-‘4/ Do you wank to continue overriding CEQ7

Click No to return to the Samples plot and confirm the
genotypes for the remaining markers.
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11. Click the vertical scroll bar at the right of the Samples plot to

12.

scroll through the two remaining dye panes (yellow and red) for
Sample 05. Note that there is a yellow D5S818 marker header in
the red dye pane. It was this marker that triggered the Override
CGQ warning message seen in step 10 on page 97.

Click the yellow D5S818 marker header to display the quality
assessment details for this marker.

ID_Sample_05 52 Sample 05 |_‘_ | |_‘_
D5SE18 [Fea
75 118 % 156 195 255 756 315 355
0
1m0
" e e, Futyria, ]
£
<5
Satnple Mame | Marker Allglz1 (Alele2 0S5 |EHN PHR |LPH |MPH SPK (AN |BD [sloR ] Quallty Value Details
Sample 05 |D231330 |19 25 @ (& @ (& ] EoEH
Sample 05 |D193433 |14 ] ]
Sample 05 WA, 16 18 | The fUHUywng qualitwalu.e. thresholds ha\fg not heen r.n.et.
Sample 05 TPOX 5 | | § I':"-|QP\:I I — 5?2751 — _I_;)l;servad Yalue } lhzreusl;old _I_UGS ‘Weighting I
Sample 03 D18551 14 15 | .
Sample 05 | AMEL X W | |
Sample 05 11 3 B | B K
Sample 05 Fi3A, 22

98

Note the marker-level ;/* PHR PQV in the Genotypes table for
this marker. Based on the calculated PHR value shown in the
QVD pane, this marker is flagged as Check (/" ).

13. Right-click the /% GQ PQV in the highlighted row of the

Genotypes table, then click Yes in the dialog box to override the
genotype quality for this marker.
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Step 4: Review the Low-Quality Sample Results

14. Now that all GQ PQVs are for Sample 05, click Yes in the
next dialog box to override the CGQ for this sample.

Owerride ID_Sample_05.fsa Composite Genotype Quality E|

b ] The Genokype Quality Flag is green for all markers in sample ID_Sample_05.Fsa.
“-‘./ Do you wank to override the Composite Genotype Quality For this sample?

Note that after overriding, the CGQ PQV changes to €
(Manually Overridden).

Note: Overriding CGQ allows you to manually accept the
entire profile for a particular sample and also provides evidence
that the sample was visually inspected by the analyst.

You have now completed reviewing Sample 05. Another use for
CGQ override will be demonstrated in Chapter 6 for review
purposes.

Examining the A . Mixed Source (MIX) PQV indicates a potential mixed-source
.4 MIX Sample sample. This example illustrates:

Results * How to select peaks and view their calculated peak height ratios
* The marker-level PQVs triggered in mixed samples
* The PHR and Allele Number (AN) PQV flags
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To investigate the cause of the yellow MIX PQV flag:

1. Click the vertical scroll bar at the right of the Samples plot until
you can see the first two dye panes (blue and green) for

Sample 06.
Sagie e Sorgieeme sos s (s wx Jomm [cen
ID_sample_o6 f5a sample 06 [ & ) [ Mark Sample for Deletion |
L0, — 1 s . L W |
s ™ s = e - s as
-
o
P
o -
a0, Jl L
= A ) Lk A il B Al ks
é@ Bl bz 5]
ID_Sample 06 fra Sangle 06 A ) [ Mark Sample far Deletion
e e Y | s .0 — 0 1 S—
35 s s e e a5 sus as
1o
P
-
e Ul M At o)
[ B B
@

2. Click the yellow D8S1179 marker header in the blue dye pane
to display the quality assessment details for this marker.

Sample Name |Marker  (Allels 1 [Allsle? |05 |BIN[PHR |LRH |MPH \SPK |AN Br |oc Ga Quality Value Details

Sample 05 |AMEL x v N ‘ ] ~llea=n7

Sample 05 |DSsE1E |11 13 | & ‘ ]

Sample 05 FGA 22 | ‘ The fulluwiﬂg quality value threshaolds ha\fe not heen r.r!el. i
Sample 06 13 A 5 _ pov | Size | Observed Yalue | Threshold ‘ G0 Weighting |
—— - - PHR | 139,43, 143,98 | 0.1811 =07 |03 |

Note the marker-level ;% PHR PQV in the Genotypes table for
this marker. Based on the calculated PHR value shown in the
QVD pane, this marker is flagged as Check ().
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3. Ctrl-click the 17 and 20 allele peaks in the green dye pane for
marker D2S1338 to select them both. The software
automatically calculates a peak height ratio (PHR) value for the
selected peaks and displays the results in the status bar at the
bottom of the Samples plot.

Ctrl-click
two peaks
I0_Sample 06f5a |Sample 06 | & o
DSBS T pesar (pREsEe _ |
‘.-.75 15 155 185 235 275 355
10D ‘
S0
L
L
2
At " " i ik i, i
Bl EIiLIE [zd]
5
<
Sample Mame  |Marker Allelz 1 |Allele 2 O_S EEJ P_HH LEH r\fH S_PK ;ilN EE CCoGa | Quallty Value Detalls
Sample 05 |D351358 |15 16 Yy & & |®||ce=on
Sample 06 | THO! 7 Fl & \ &
- _—r The following quality value thresholds have not been met:
Sampls 06 |D135317 |11 '
ki PQY Size ::Observed Yalue Threshold G Weighting \
Sampls 06 |D16S538 |3 10 [ i J (] PHR. | 339.82, 315.36 | 0.2543 =07 |03 ]
E0 20 K K | A | { AN | A 4 >z 1.0 |
Sample 06 |D195433  [13 14 & |4 & [2]
Sample 06 |WA 14 16 & & [2]
Sample 06 | TPOX 8 E] & A
Sampls 06 |D18SS1 |12 15 & & &
Sample 06 | AMEL i3 Y & |-
Sampls 06 |DSS81E |11 13 & Y
Sample 06 |FGA 232 |24 & & &
Sample 07 |DES1179 |13 Y &
Sample 07 |D21511 |30 22 Yy &
Sample 07 D7Sa20 & .
Sample 07 |CSFIPD |10 oL A Y &
Sampls 07 |D3Z1358 |15 18 B & & |+
[x 328.18 Y -231](:Peak Height Ratio 0.35673
\—Calculated PHR for selected PHR and AN PQV details
peak pair is shown here are shown here
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Note the following:

* The calculated PHR is less than the minimum PHR
threshold of 0.7 specified in the analysis method

* The AN PQV in the Genotypes table for this marker,
indicating the number of alleles detected is greater than the
Max Expected Alleles defined in the analysis method

Note: The AN and PHR PQV status is used to determine the
GQ PQV. Based on the observed AN and PHR values shown in
the QVD pane, this marker is flagged as Low Quality ( @ ).

Repeat step 3 on page 101 for any of the other peak pairs in this
sample.

You have now completed reviewing Sample 06. This sample
was expected to be from a single source. You will use the
Profile Comparison tool in Chapter 5 to help determine the
potential contributor(s) to this mixture.

Note: For more information on the conditions that must be met
for a sample to be considered a potential mixture, see the
GeneMapper® ID-X Software Version 1.0 Reference Guide.

Examining the This example illustrates:

SQ Sample .
Results

How to view PQV trigger labels

* The Broad Peak (BD) PQV flag

102

How to delete allele labels for a sample
How to add a reason for change to the audit trail

How to mark a sample for deletion from the project
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Step 4: Review the Low-Quality Sample Results

To investigate this low-quality sample:

1. Click the vertical scroll bar at the right of the Samples plot until
you can see the first two dye panes (blue and green) for

Sample 07.
Sample File Sample Name 505 |58  |55PK |[MIX  |OMR |CG@
\D_Sample_07fsa Sample 07 |_‘ | |o
pestd ——— pedsWm ] L
75 115 155 195 5 s s 355
0
160
1200
Eoul
" A
. J i L J .
ID_Sample_07 fsa Sample 07 i &

75 15 155 195 =5 275 318 355

Note: This is the same sample you viewed using the Size Match
Editor earlier in this chapter (see “Examining the SQ Sample
Results” on page 90).
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2. In the Samples plot toolbar, click | S | (PQV Trigger Peak) to
add PQV suffixes to peak labels for peaks that cause any of the
following ;* PQVs: LPH, MPH, BD, OS.

Note: Displaying the PQV trigger peak labels can help you
quickly find the exact peaks that triggered specific PQV flags.

Sample File Sample Name 505 =0 SEPK MIX OMR | CGQ

ID_Sample_07 fsa Sample 07 | | ‘o
pssTivs — meds® | prsen [ [CSAP0 ]
75 11§ 166 196 235 278 318 355
2000
1600
1200
00
amo
, . J A l. v A
|0_Sample_07fsa Sample 07 i o
pIstsse ] [ (p@sstT
75 11§ 166 196 235 278 318 355
&0
4
i {\
pldA e "y ey ik Ak o Py {\
b E)

In this example, (BD) is appended to the label of each peak that
exceeds the Max Peak Width threshold.

3. Click |E| (PQV Trigger Peak) again to turn off the PQV trigger
labels.
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4. Click the red D3S1358 marker header to display the quality
assessment details for this marker. Note the marker-level ;. BD
PQYV in the Genotypes table, and the Max Peak Width threshold
and observed values related to this PQV in the QVD pane.

ID_Sample 07 fra Sample 07 A o
ESISEN— [T Db by ) Dm0 )
75 115 165 195 25 275 3s 356
L]
4o
- /\
dos L ML
Bl
< |
Sample Name | Marker Allele 1 |Alele2 (OS5 |BIM O |PHR |LPH |MPH |SPK (AW |BD |CC G@& Quality Value Details
Sample 07 [D21511 |30 322 3 @ 7 ls0z 0z
Sl 07 075820 Yy o
CSF1IPO 10 QL T o The following quality value thresholds have not been met
5 8 N N A | ‘ POy Size | Observed ¥alue Threshald GO Weighting
L ED 123.43 l.e248 *=1.5bp | 0.8
THn — - ED 135,68 1.8518 >=1.5bp |08
| [semple o7 Ip13sa7 i | |@ | ] f &
Check BD PQV for Observed Max Peak Width
selected marker values and accepted

thresholds are shown here

The genotype profile for this sample is not reliable and should
not be reported. Therefore, from the Samples plot, you can
choose to:

* Delete all labels for a sample
or

» Mark the sample for deletion from the project

The following steps 5 through 8 demonstrate these two options.
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106

Sample File

5. To delete all labels for Sample 07, right-click in any pane for
this sample, then select Delete All Labels for Sample.

Sarple Haxne f0%8 5Q SIPK | MIX OMR | CGOQ

ID_Sample_07 fsa

75

Srih |& | o
Desimy 0 peism ] [issee ] [CSFIPFO ]
115 155 185 235 75 36

Delete All Labels for Sample

6. Click Yes in the Delete All Labels dialog box.

7. Enter Bad injection in the Reason(s) for Change dialog box
(recorded in the audit trail), then click OK.

»* Reason(s) for Change f5__(|
rReason(s) for Change

Attribute | RN, Identifiler Samples, SAMPLE.ID_Sample_07.fsa. ALLELE.13.deleted |

Oldvalue |13 [KitT.AmpFLSTR_Panels_w1% PANEL Identifiler_v1¥MARKER D851179. |

Tew Yalue |

Enter the Reasonis) for Change:

Ead injection

Note: By default, a reason for change audit trail entry is
required for all label edits.
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Note that after deleting all allele labels for Sample 07:

All sample-level and marker-level PQVs for the sample
turn gray and maintain their original shapes (IT) to
indicate that the sample has been edited

Affected marker header colors change to gray

The sample will still be listed in the Samples and
Genotypes table, but no allele values are reported

Sample File |Smp1emm |sos ‘so |ssm{ |M]x ‘um |l:|:;Q
ID_Sample 07 f5a |Smp1en'r | ‘7\ | |°
peistr ] [cspG ]
TE 18 188 195 5 275 3§ 355
N0
1600
1700
B0
A0
J AN
ID_Sample 07 f5a |Smp1en'r | ‘7\ | ’0_
[or— |pomssiT PSS [pesms
TE 18 188 195 5 275 3§ 355
B0
A0
" f
Loa . | " ) UL A

=

Sample Name | Marker Alele 1 | Allele 2 (E BI_N F‘_HR L_PH hﬂH S_PK A_N EE co EE Qua“ty Value Details

Sample 07 |DES1179 'y (3] *| [To view individual quality value details, select a single row.
Sample 07 |D21S11 & @

Sample 07 | 073820 ) @

Sample 07 | CSFIFG Y & @

Sample 07 | 351348 & @
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Samuple File

Step 4: Review the Low-Quality Sample Results

8. To delete Sample 07 from the Getting Started project, select
Mark Sample for Deletion at the top right of any dye pane for
this sample.

Sample Name sos [sq [sspk M [oMm [ceq

108

D_Sample 07 52

%Mark Sample for Deletion

=iy L @ @ @ @
Lot i —
-

255 275 365 395 5

[DESIITe
18

185

EERER !
#

A

Note: The remaining panes associated with this sample are
automatically marked for deletion by the software.

The sample will be deleted from the project when the Samples
plot is closed. For now, keep the Samples plot open to continue
reviewing the last low-quality sample results in this project.

You have now completed reviewing Sample 07.

Examining the A ;. Outside Marker Range (OMR) PQV indicates that one or more

OMR Sample peaks were detected between two marker size ranges specified in the

Results panel for the marker. This example illustrates:
* Automatic labeling of OMR peaks

e The Out of Bin Allele (BIN), Low Peak Height (LPH), and Max
Peak Height (MPH) PQV flags

* How to change an artifact label to an allele label and assign it to
a selected marker

* How to save a custom artifact label for future use

* How to change an allele label to an artifact label
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Step 4: Review the Low-Quality Sample Results

To investigate the source of the OMR peak and other potential
anomalies:

Click the vertical scroll bar at the right of the Samples plot until you
can see the last two dye panes (yellow and red) for Sample 08.

Sample File Samgle Hame sos [sQ  [ssPR [ [onk [ceQ

ID_Sangle U852 Surgle 08 @ [ @ (@ | [ [ Mark Sample For Delstion | %
[D195433 ] WA ] TPOX ] DrEsEl
18 155 EY 275

135

355 305 ass

111

.
ID_Sample 0% 52 Sample 05 CECERCECEEEC] [ Mark Sample for Deletion
P ———————

135 =5 275 515 355 305 ass

AR

B
]
—
a‘

El

[EH
[Ep=
Blp—

B
B

Note the following:

* There is a peak labeled OMR present between the vWA and
TPOX markers

* The marker header for TPOX is yellow

* The marker headers for D5S818 and FGA are red

» There is a peak labeled OL present in the D5S818 marker
o There are three labeled peaks present in the FGA marker

Follow the procedures in the following sections (on pages 110 to
128) to individually review the quality of these markers.

You will first investigate the OMR peak between vWA and TPOX
and the quality of the TPOX marker.
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Step 4: Review the Low-Quality Sample Results
To examine TPOX marker and OMR peak:

1. In the Samples plot toolbar, click |I| (PQV Trigger Peak) to
add PQV suffixes to peak labels for peaks that cause any of the
following ;* PQVs: LPH, MPH, BD, OS.

MPH suffix
I0_Sample_D&fsa Sample 08 ‘ : |°
0195433 ] (WA | [TPOX | D855
I0_Sample_D&fsa Sample 08 ’—’0_
psseis ]
CI . ’ ]
LPH suffix
In this example, (MPH) in TPOX and (LPH) in D5S818 are
appended to the label of each peak that does not meet the
thresholds related to these PQVs set in the analysis method.

2. Click | R | (PQV Trigger Peak) again to turn off the PQV trigger
labels.
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Step 4: Review the Low-Quality Sample Results

3. Click the yellow TPOX marker header to display the quality
assessment details for this marker. Note the marker-level ;"
MPH PQYV in the Genotypes table for this marker, and the Max
Peak Height threshold (in RFU) and observed values related to

this PQV in the QVD pane.
Sample File |s:mp|sz ‘sns |sq |ssn( ‘MIX |m\.m |l:|:q
ID_Sample_08 £5a |Sxmpleﬂ8 | |_\ |.
L — - —

i
!
——
|

ded s H "

] [
ID_Sawple 08 f5a |smw | ’_‘—lo_

76 1186

166
L
S0
o
1000
0 ek A .

1% 255 276 36 56

b

Jud 4

i 202
<
Sample Mame  |Marker Allele 1 |Alele 2 lE Bﬂ PHR Iﬂ-i hﬁH S_PK A_N EE cC G-Q | :Quallty Value Details
Sample 08 |DES117S [12 13 *l lea=07
Sample 08 |D21511 |28 El — T —— — -
T T T e following gquality value thresholds have not been met
Sample 08 |D7S820 |7 12 CHRCERCERCRCRCRCRC = - —= T ; —
——— =it T = ] ._-_._-_._._ [ | - PQY | Size _|_Observed Walue | Threshold | G0 Weighting l)
ol MPH | 229.84 | 5548.0 | »=5000.0RFU [0.3 f
Sampls 08 |D351358 |15 16
Samplz 08 | THOT 7 9.3
Sampls 08 |D135317 |11
Sample 08 |D165539 |9 10
Sampls 08 |D251338 |20 23
Sample 08 |D195433 |14 15
Sample 08 WA 14 16 0
K |& B NA &
Semple 08 |D18S51 |12 15 ﬁ|i
Check MPH PQV Observed Max Peak Height
for selected marker values and accepted

thresholds are shown here
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Step 4: Review the Low-Quality Sample Results

4. With the TPOX marker header still selected, left-click the OMR

label.
Sample File Sample Name S05 (50 [SSPK MIX |OMR |CcQ
ID_Sample 0% fsa Sample 08 | & |°
[D195433 | A | TPOX DIBSET
75 18 155 195 235 278 316 355
SO0
4000
SO0
U0
" | il
5
ID_Sunple_ 0% fsa Sample 08 Y o
L0 —
75 118 155 185 235 75 315 355
4000
SO0
U0
1
i
< |
Satnple Mame  |Marker Allelz 1 Allele2 (05 |BIM PHR [LPH |MPH SPK (AN BD |CC |GQ Qua"ty Value Deta"s
Sample 03 |D7SE20 |7 12 [#]
—— | [Toview individual quality value details, select a single row.
Sample 03 CEF1PO |11 12 4 [V ! d
Sample 013 |DIE13EE |15 16
Sample 03| THO 7 EE] 7]
Sample 03 |D13EH7 (11
Sample 03 |DIBS533 |3 10
Sample 03 |DIE133E |20 23
Sample 03 |D195433 |14 15 7]
Sample 03 A, 14 16
Sample 03 TROXK 3 & i
Sample 03 |D18381 12 15

Note: This peak is automatically labeled as an OMR artifact by
the GeneMapper® ID-X Software. Peaks labeled as artifacts are
not listed in the Genotypes table. In some rare cases, an OMR
artifact peak may be a true allele; you may need to verify the
classification of an OMR peak if you encounter one in your own
data.
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Step 4: Review the Low-Quality Sample Results

For this example, you will assume that this OMR artifact peak is
indeed a true allele solely to learn how to add an allele label to
an artifact peak and assign it to a selected marker (although you
are aware this is not a true DNA peak).

5. Right-click the OMR label, then select Add Allele Label.
O ox 185

Delete Label(s)
OLIE

_ﬁ Rename Arifact Labal P

Feak Raw D ata

6. Inthe Add Custom Allele Label dialog box, enter < 6, then click
OK. Note that the TPOX marker is selected for this allele since
this was the marker selected before adding the allele.

Add Custom Allele Label x|

Customn Allele Label: ‘ =g ‘

Marker Mame: TPOE

[ ok ” Cancel H Help ]

Note: This custom allele will be added to the TPOX marker and
entered as an allele in the Genotypes table.
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Step 4: Review the Low-Quality Sample Results

7. In the Reason(s) For Change dialog box, enter Microvariant
OMR, then click OK.

#* Reason(s) for Change E]

rReasonis) for Change

Attribute | RUN.Identifiler Samples,SAMPLE. ID_Sample_08.fsa. ALLELE . OMR. modified |

Old Value | OMR [KitT.AmpFLSTR_Panels_v1x.PAMEL. Identifiler_v1x MARKER, TPOX.BASEPAIR. 212,76, |

MNew Yalue | <6 [KitT.AmpFLSTR_Panels_v1x.PANEL. Identifiler_v 1 MARKER, TPOR. BASERPAIR, 212,765 |

Enter the Reasonis) for Change:

Hicrovariant OHRI

Note that after editing:

* All sample-level PQVs (except SQ) for the sample turn
gray (@ |4 ) to indicate that the sample has been edited

* All marker-level PQVs for the marker turn gray and
maintain their shape (lf), to indicate that the marker
has been edited

» The allele is listed in the Genotypes table
» The allele label changes text and color from pink to black

* The marker header color changes from yellow to gray
(pink if selected)
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Step 4: Review the Low-Quality Sample Results

Sample PQVs (except SQ) turn
gray, but keep original shape

Sample File Sample Hame 508 =50 SUPH MK OmMR  |CGO
| —
ID_Sample_08 is= Sample 03 “ IO
0195433 ] WA | TROXI 018551
TE 18 168 196 5 275 35 355
S0
AR
SR
20
" s ke ik i i
iz
|D_Sample_08 fsa Sample 03 & ®
L
76 1186 166 195 5 275 315 565
SO0
SR
20
" " i i
@ 20 2]
L7
Sample Mame Marker Allele 1 |Allele2 [0S (BN SPHO AW BD |CC |GG | Qua"ty Value Details
Sample 03 DastTe 12 13 ~ S ) :
Ample = [To view individual quality value details, s
Sample 02 D211 |28 Bl
Sample 02 oTs80 |7 12
Sample 03 CSFIPC 11 12
Sample 02 0351358 [15 16
Sample 08 THI 7 93
Sample 03 037 |1
Sample 02 D1ES538 |8 10
Sample 02 0251338 |20 23
Sample 02 D195433 14 15
Sample 08 VA, 14 15
Sample 08 TPOX <5 3 &
Sample 03 masst 1 15

< 6 allele entered Marker PQVs turn gray,
in Genotypes table  but keep original shape

8. Select the TPOX marker row in the Genotypes table, then right-
click its & GQ PQV.

9. Click Yes in the dialog box to override the genotype quality and
manually accept the current genotype (<6, 8) for the TPOX
marker. The GQ PQV changes to and the marker header
turns green.

You have completed reviewing the TPOX marker. You will now
investigate the OL peak present in the D5S818 marker.
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116

To examine the cause of an extra peak:

1. In the red dye pane for Sample 08, place the pointer next to the
X-axis below the red D5S818 marker header until the pointer
changes to a 4.

ID_Sample_08 52 Sample 0% ’Tlo_
75 115 O\ 155 195 235 275 35 3565
® - N - s
2. Click-drag the pointer to the right to create a box that includes
the area to the left of the D5S818 marker, then release to zoom
in on this marker, as shown below.
ID_Sample 06 52 Sample 08 ’Tlo_
L
75 e [ e O 1w 235 276 316 355
L
] ]
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Step 4: Review the Low-Quality Sample Results

3. Click the red D5S818 marker header to display the quality
assessment details for this marker. Note the marker-level ;"
BIN PQYV in the Genotypes table for this marker.

ID_Sample_0% fra |Smnh [ | Fy IO_
130 140 150 160 170
A
SN
20
100
P

£ |
Sample Name | Marker Allete 1 |Allele 2
Sample 08 Da=1179 |12 13
Sample 03 D215 28 kil
Sample 03 D7SE20 7 12
Sathple 03 CSFIPO |11 12
Sample 05 D331356 |15 16
Sample 05 THO1 7 9.3
Sample 05 D133y |1
Sample 03 D16=539 |3 10
Sample 03 D251336 |20 23
Sample 03 0195433 |14 15
Sample 08 A, 14 16
Sample 03 TPOX =6 =
Sample 05 D18351 12 15
Sample 09 AMEL LS hd

@z
=
=
I
Eil
=
-
T
E
el
T
5]
T
=
=
=

Quality Value Details
Ga=0.008

[

The fallowing quality value thresholds have not been met:

Copgy | Size Observed ¥alue Threshold 1" GQ weighting |
BIN 139.41 OFF ladder e 0.8
PHR. 139.41, 151,28 | 0.0201 <=0.7 0.3
LPH 139.41 93.0 <= 100.0 RFU Hetrozygote ... | 0.3

oo oo Do meE s
o oEnEeDEE S

ﬂ|ﬂ‘ﬂ ﬂ‘ﬁ|ﬁ|ﬂ|ﬂ ﬂ|ﬂ‘ﬁ‘ﬁ‘ﬁ|ﬂ|
] 0 ] ] ] o o

> AR S SIS S

n
3 »

Sample 05 FGA 202 24

Note: A ;* BIN PQV indicates that one or more labeled peaks
are detected outside an offset bin. These peaks are automatically
labeled as OL peaks by the software. For information on bin
offsetting, see the GeneMapper® ID-X Software Version 1.0
Reference Guide.

4. Click the OL peak label to select the OL peak.

5. Click !lil (Combine Dyes) in the Samples plot toolbar to
display all dye colors for the sample in one pane.
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Step 4: Review the Low-Quality Sample Results

6. Place the pointer next to the Y-axis until the pointer changes to a
€4, then right-click and select Zoom to.

0 Sample 08 £5n Sample U8 PP | @ A @

125 135 125

som

-

o Full Yiews

mm

om0
0

7. Enter 1000 in the Y-Axis Zooming dialog box, then click OK to
zoom in on the OL peak. Note that the red OL peak is located
under a larger blue dye peak.

ID_Sample 08 fsa Sample 08 | | | | |1 |0

¥
7

145 156

- EES§§Ed888

JAN
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Step 4: Review the Low-Quality Sample Results

8. Ctrl-click the overlaying blue dye peak to select it (the red OL
peak should still be highlighted).

ID_Sample 0% £5a |Smp1e08 | | | | |‘ |.

130 140 150

'SREREEERER

JREAL

< |

[Sample Mame |Marker — [Allele 1 |Allele 2 |05 BN [PHR LPH [MPH |SPK |&M  |BD IQuaIity Value Details
o r K To view individual quality ve
Sample08  |D21511

Sample08  |D7s820 |7 12 M,

Sample 08 |CSFIPO |11 12 MA

Sample03  |D3S1358 |15 16 A

Sample 08 | THOT 7 93 M,

Sample 08 |D13337 |11 A M,

Sample0s  |D165539 |9 10 A

Sample 08 |D251338 |20 73 A

Sample 08 |D195433 |14 15 MA

Sample 05 A, 14 16 A

Sampe0s  |TPOX  |<6  |a M, Y M,

Sample 0 |D16351 |12 15 MA

Sample 05 |AMEL X k3 A

Sample 05 e ™ U
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9. Click & (Sizing Table) in the Samples plot toolbar to display
the Sizing table, which contains the following peak sizing
information for all detected peaks in the sample: size (in base
pairs), peak height, peak area, and data point.

ID_Sample 08 fsa Sample 08 | | | | |1 |o
125 135 145 185
100
o
am
L
L= ]
S
2
0
Hm
1
; AN
< |

| |Dye!’SampIe Peak |Sample File Mame |Marker |.ﬂ.llele |Size Height Area Data Point

IC_Sample_0& =5

DES11/3 |12

Das117a (13 14396 2510 29645 3579

. B3 ID_Sample_05 fsa

[ ] B4 ID_Sample_0S.fsa 196.37 95 1032 45635
[ ] BA ID_Sample_08 fsa  |D21511 28 200.22 2035 19813 4615
[ ] B ID_Sample_0S.fsa 205816 147 1492 4721

120

Note: The columns displayed in the Sizing table are determined
by the plot setting selected in the Samples plot.
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Step 4: Review the Low-Quality Sample Results

10. With the blue dye and red OL peaks still selected, press Ctrl+G
to display only the selected peaks in the Sizing table.

ID_Sample 0 fsa

¥

Sample 08

136

CHRCHCECECSCE

145

. F¥§§5838488§

JAN

|

B2

|Dye!8ample Peak |Sample File Mame | rker

The sizing data indicates that the red OL peak could be caused
by spectral pull-up.

You will change the software-generated OL peak label to a
custom artifact label in the next steps.

To change the OL peak label to a custom artifact label:

1. Select the [l D5S818 row in the Sizing table to deselect the
overlaying blue dye peak (the red OL peak should still be
highlighted).

ID_Sample 0 fsa

¥

Sample 08

CHRCHCECECSCE

145

. F¥§§5838488§

JAN

|

DyeiSample Peak

Sample File Mame

Marker

Allele

Size

Height

Area

Data Poirit

. B2
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Chapter 4 Manually Reviewing and Interpreting Data
Step 4: Review the Low-Quality Sample Results

2. Click |E | (Separate Dyes) in the Samples plot toolbar to display
each dye color for the sample in separate panes.

3. Click |%| (Genotypes Table) in the Samples plot toolbar to
replace the Sizing table with the Genotypes table and QVD
pane.

4. Left-click the OL peak label in the red dye pane, then right-
click the label and select Rename Allele Label » Custom
Artifact Label.

ID_Sample_08 f53 |Sample 08 | A &
125 135 145 155
Bl
S
HEE
1m0
o Delete Labeliz)
= IR PR R N S ustam Allele Label
Cuskom Arkifact |abel
i | Feak Raw [ata k
Sample Mame | hWarker Alele 1 |Alele 2 (05 |BIM |PHR [LPH [MPH |SPK (AN |BD |CC y Value Dl
Sample 05 [D21511 28 3 T
Sample 08 Dysaz20 7 12
Sample 03 CSFIPD |11 12 '-_ring qualihf\fall{l
Sample 08 |D351358 |15 16 p "BLI‘*r\‘]‘ b= 4?23
Sample 05 | THO 7 8.3 PHR | 139.41, 151,26
Sample 08 D135317 |11 LPH 139.41

GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 4 Manually Reviewing and Interpreting Data "
Step 4: Review the Low-Quality Sample Results

5. Complete the Custom Artifact Label dialog box:
a. Enter SPU <your initials> (for example, SPU AB).
b. Select Add to predefined list.

Custom Artifact Label

Custam Artifact Label: ‘ SPU AE| ‘

Add tor predefined list:

[ sl hl ’ Cancel ] [ Help

c. Click OK.

Note: This option allows you to select this custom artifact label
from a list of labels in the future.

6. In the Reason(s) For Change dialog box, enter Pull-up, then
click OK.

»* Reason(s) for Change

Reason(s) far Change

Attribute | RUM.Identifiler Samples.SAMPLE.ID_Sample_08.Fsa.ALLELE.OL.modified |

Old Yalue | OL [KitT.AmpFLSTR_Panels_w1x.PAMNEL. Identifiler_v1x.MARKER.D55518,BASEF |

Mew Yalue | SPUAE [KitT.AmpFLSTR_Panels_v1x.PAMEL Identifiler_w1x.MARKER.DSS818.B |

Enter the Reasonis) for Change:

Pull-up
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Note that after editing:
* The SPU artifact label is displayed with a pink border

» The SPU artifact peak is not added to the Genotypes table
since an artifact is not considered a true allele

* All marker-level and sample-level PQVs (except SQ) turn
gray and maintain their original shape (E) to indicate
that the marker has been edited

» The marker header color changes to gray (pink if selected)

TD_Sample 08 fsa |Swt1ﬂeﬂs | Fy ’0_

190 120 150 160 170

§

g
&
El

£ |

Sample Mame  |Marker Allele 1 Allele 2
Sample 08 L2131 26 31
Sample 08 D72820 7 12
Sample 05 CSFIPO 11 12
Sample 05 031358 |15 16

o
=
o
I
Ed
=
b
I
=
3
I
@
o
=

siss

—JQuality Value Details
*) |ea =008

The following quality value threshalds have not heen met:

POV Size  Observed Valus Threshold | &Q weighting |
BIN | 139.41 Off ladder [ 0.8

PHR 139.41, 151.23 | 0.0201 <=0.7 0.3

LPH 139.41 93.0 <= 100.0 RFU Hetrozygote... | 0.3

Sample 05 THO1 7 9.3

Sample 05 013=37 M

Sample 08 0165539 |9 10
Sample 08 0231336 |20 23
Sample 05 0195433 |14 15
Sample 05 A, 14 16

Sample 08 TPOX =6 8

Sample 05 018251 12 15

oo EE® 2
ﬁ‘ﬁ|b ﬁ|ﬁ‘ﬂ‘ﬁ‘ﬁ|ﬁ|ﬁ|ﬁ|ﬂ‘ﬁ‘
] ) ]
i‘i|i|ﬁ|ﬂ‘ﬂ‘i‘i|i|ﬁ|ﬁ|ﬁ‘ﬁ‘ z
oo em s

-ﬂ‘ﬂ| ﬁ|ﬁ‘ﬂ‘ﬂ‘ ﬂ|ﬁ|ﬁ|ﬁ‘ﬂ‘
| o o o

S e 08 AMEL LS A

< BEEEEEEIEE S

5

]
[
;

[
]
[
r

-]
@
<

7. Verify the D5S818 marker row is selected in the Genotypes
table, then right-click its @ GQ PQV.

8. Click Yes in the dialog box to override the genotype quality and
manually accept the current genotype (11) for the D5S818
marker. The GQ PQV changes to and the marker header
turns green.

You have completed reviewing the D5S818 marker. You will now
investigate the extra allele present in the FGA marker.

1. Press Ctrl+Minus Sign (-) four times to incrementally zoom
out on all panes of the Samples plot.
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Step 4: Review the Low-Quality Sample Results

2. Click the red FGA marker header in the red dye pane of
Sample 08 to display the quality assessment details for this

marker.
ID_Sanple U8 552 |Smn1e [ | A ©®
1 140 180 ) 260 300 30 360 420

A0

3000

2000

i A i " A
M SPU AR
<
Samcle Name_[varker [alleie | [lee2 [05 [BN [PHR [LPH [WPH [Sic [an B0 Jcc (56 dgality Value Details
Sampls 08 021511 |28 Kl “| lza=o0
Sample 08 |D7SE20 7 12
Sample 03 CSFIPO |11 42 The fallowing quality walue thresholds have not heen met:
— 1 — = — Cpgr | Size | Observed Value | Threshold | GG Weighting |

Sample 05 |DIS1358 (15 8 FHR | 228.61, 242.58 | 0.0885 =07 03
Samplz 08 |THOT 7 93 BN NjA 3 52 L0
Sampls 08 |D13S317 |11
Sampls 05 0165539 |9 10
Sampls 08 D2s1338 |20 23
Sampls 08 195433 |14 15
Sample 08 |viis 14 16
Sample 08 |TPOX <6 B Y
Sample 08 oiasst (12 15
Sample 03 |AMEL X Y
Sample 08 |D53818 |11 & & &
3 08 B K A | = ! -

Note the following:

» The software has detected three alleles in the marker range:
20.2, 24 and 26

» The marker-level . AN PQV is triggered

Note: A . AN PQV indicates that the software detects
either no alleles or more alleles than the Max Expected
Alleles threshold set in the analysis method (in this
example, set to two).

» The marker-level ;. PHR PQV is triggered

In this example you will assume the extra allele is caused by
pull-up as well.
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3. Left-click the 20.2 peak label, then right-click the label and
select Rename Allele Label » SPU <your initials>.

ID_Sample_ 06 £5a Sample 08 ,T’T

L |
130 170 210 250 200 330 37
A
30
2

.

[} E T A A, 3 Delete Labelis) y

seuas] ] 202 P T PRI Custam Allele Label
= Custom Artifact Label

Feak Raw Data

Ep——

SPL AR
Sample Mame | Marker Allele 1 |Allele2 |(O= BIN PHR LPH |MPH |SPK (AW |BD |CC GO :Qua k tails
Sample 05 021511 28 k1 A o=
Sample 03 D7ss20 |7 12
Sample 08 CSFIPO 11 12 The fo thresholds hgve not beerj
FECECEEEEEEE PQY SiZE Observed value | Threshold
Sample 05 0331356 13 16 - s A ]
_ _ _ _ _ _ PHR | 228.61, 242,55 | 00335 <=07
Sample 03 THO1 7 93 A 3 P
Sample 05 D13sx7 M

Note: Note that the SPU custom artifact label you created in
step 5 on page 123 is now displayed in the list of available
labels.

4. In the Reason(s) For Change dialog box, leave the Pull-up text
as shown (recorded in the audit trail), then click OK.

#* Reason(s) for Change @

rReasonis) for Change

Attribute | RUMN.Identifiler Samples. SAMPLE.ID_Sample_03.fsa ALLELE. 20,2 maodified |

Old Value | 20,2 [KitT.AmpFLSTR_Panels_w1x.PAMEL. Identifiler_v1x.MARKER . FGA.BASEPAIR. 228,61 |

MNew Yalue | SPUAE  [KitT.AmpFLSTR_Panels_w1X.PAMEL. Identifiler_v1x.MARKER FGA BASEPAIR. 225 |

Enter the Reasonis) for Change:

Full-up
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Note that after editing:
* The SPU artifact label is displayed with a pink border

» The SPU artifact peak is not added to the Genotypes table
since an artifact is not considered a true allele

* All PQVs (except SQ) for the FGA marker turn gray and
maintain their shape (lf) to indicate that the marker
has been edited

» The marker header color changes to gray (pink if selected)

ID_Sample 08 f52 |Stmp1¢ " | A ®
By e
1m0 140 180 260 300 a0

a0m

3000

200

" M Ll

o i A A, & 4 'y &
E 3PU AE 3P AE
<
Sample Mame  |Marker Allele 1 |Allele2 |(O=  |BIM |PHR |LPH |MPH |ZPK |AN |BD  |CC GO | Quality Value Details
Sample 05 D231 28 3 -~ Ga=0.0
Sample 03 |D7S820 |7 12 Bl | 9
Sample 03 CSFIPD 11 12 The following quality value thresholds hay
rEEECECrEEEEE Pov | Siem | Observed value |
=t le 05 0331358 |15 16 ' ds _
A PHR. | 228.61, 242,58 | 0.08585

Sample 03 THM 7 93 anl A 3
Sample 05 D13s37 N1 i
Sample 03 0165539 |9 10
Sample 03 0251338 |20 23
Sample 05 0193433 |14 13
Sample 03 WL, 14 16
Sample 05 TROX, =6 8 ‘
Sample 05 18351 12 13
Sample 03 AMEL X ki
Sample 05 D5s518 11 ‘ ‘ ‘ i
Sample 03 N N f | f s

5. Verify the row for the FGA marker is selected in the Genotypes
table, then right-click its @ GQ PQV.

6. Click Yes in the dialog box to override the genotype quality and
manually accept the current genotype (24, 26) for the FGA
marker.

The next dialog box displays a message indicating that all
marker-level GQ PQVs for sample Sample 08 are now green.
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7. Click No in this Override CGQ dialog box to keep the current
CGQ status for this sample.

Override ID_Sample_08.fsa Composite Genotype Quality

€ | The Genotype Quality flag is green For all markers in sample ID_Sample_03.fsa.
\:/ Da you wank o override the Composite Genotype Quality For this sample?

You will review this sample further in Chapter 6.

Note that after overriding GQ:
+ The GQ PQV changes to
* The marker header turns green

ID_Sample 0% fsa | Sample 08 | A O
A pESEE
100 140 180 260 300 340

4000

SO0

2000

1o A Jl !l Il

o . A 'y A 'S A
@ SPUTAE SPTTAE
<
Sample Mame | Marker Allele 1 |alele 2 |05 BD |CC |GG& | :Quality Value Details
Sample 03 02511 |28 3 T *llca=o00
Sample 05 DFsE20 |7 12 RS
Sample 08 CSFIPO |11 12 T The following quality value thresholds haw
Cpow | Size " Observed Walus
Sample 03 0351358 |15 16 T
PHR | 228.61, 242.55 | 0.0335

Sample 08 |THOY 7 9.3 A AN | A 3
Sample 05 o3ass7 |1 RS
Sample 05 165539 |9 10 RS
Sample 05 D251336 |20 23 RS
Sample 03 0185433 |14 15 T
Sample 03 WIS, 14 16 T
Sample 03 TPOX 6 3 T
Sample 05 oasst |12 15 RS
Sample 03 AMEL ¥ v T

Sample 05 DSs815 11

Sample 03 Fa, 24

=
=
3
<

You have now completed reviewing Sample 08.
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Step 5: View Additional Plot Settings

Additional plot settings are supplied with the GeneMapper® ID-X
Software to assist with performing other functions within the plot
window. Follow the procedures on pages 129 through 132 to review
the elements of these other plot settings.

Select each of the following from the Plot Setting drop-down list:

» Sizing Data — Displays peak detection and sizing information
in a format similar to the ABI PRISM® GeneScan™ software
plots

& [& Plot Setting: |Sizing Data

v|E Panes |2

BT | ()2 40 | EEEEEEY A @

[hi] | e bufgs] (ML) 4B WL o AR
Sagle Name
Sanple 05 [ Mark Sample for Deletion >
s ns 188 195 = s sis. e 385 s
1o
1500
1900,
120
1000l
oo
00
)
,,JL« ._L_lllll_.l{n I ..MJ\L o d i\ _.M . l'lﬂ I 1 J'LJ‘\, AJ‘I i 1 Ll
Sample 06 [] Mark Sample For Deletion
s ns 158 195 2 278 sis 88 385 s
20w
150
1200
00
TR P ¥ 1.9 1 Y b AR LAk thJ'l b ..ﬂ Mow. ! I
~
¢ J >
[DrveiSample Peak [Sample Fis Name | Marker Alele [ize Height Area Data Paint
] |B,1 ID_Sample_05 tsa 95 66 142 1347 3046 -~
| mpE2 ID_Sample_05.fsa | DBS1179 15 15252 267 2474 3601
i ID_Sample_DS.fsa |DBS1179 18 156.8 240 2153 3854
B .lB,A ID_Sample_05fsa |D21511 32 21387 329 2898 4532
| mps D_Sample_05.fsa | D7S620 1 275.06 236 2375 5350
| T mPEs ID_Sample_0S.fsa | D7S820 12 27913 188 1983 5399
| mpET ID_Sample_05.1sa | CIF1PQ 12 32961 516 373 5962
[ .|e‘1 I0_Sample_05 fsa 777 288 2733 2796
B .le‘z ID_Sample_05tsa |D3S1358 16 127.55 489 4787 32868
I .|G‘3 ID_Sample_05.fsa |THO! 33 185.87 |5Ts 5053 4228
| mee ID_Sample_DS.fsa |D133317 B 21633 iE 1738 4624
| Tmle® ID_Sample_05.tsa 0135317 12 23231 220 2264 4625
[ .lG‘E |0_Sample_05 fsa | D165530 12 26013 |§|4 ’Em 5411
[ .lGJ ID_Sample_05 fsa | D251336 19 238 |127 ‘1347 ’Ens
I .lG‘E ID_Sample_D5.fsa | D251338 25 4737 |21 2440 BES] ]
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* Check LIZ Size Standard — Displays plots in the same format
as the Check GS500 Macro in the ABI PRISM® Genotyper®
Software templates

& [B Plot Satting: | Check L1Z Size Standard v | Panesi[4 v EEEEFEm i feal | UMW | EEEE | A @
ac
L | bkl (e 4T RS @ AR
Sanple Hame sQ
Sample 05 ] [ Mark Sample for Delstion
0 £l 150 1 =0 250 2 330 3 410 50 = a0
1600
120
o
.
F30 1000 oo | 1600 000 aws37 3000 5400 000 1500
1500 3500
Sanple 06 ] [ Mark sample For Deletion
) n 150 1 20 250 0 330 s a1 a0 = s
om0
1600
1200
o
am.
v
73.0 100.0° 130.0 160.0 2000 246,70 3000 340.0. 4000 430.0.
150.0 350.0.
Sample 07 Mark Sample for Deletion
o x 150 1 210 250 20 350 a0 a1 a5 = s
o
am.
20
[
F30 1000 50 | (1600 2000 a4741 3000 5400 s00.0 4500
1500 3500
Sample 0% ] [ Mark Sample for Deletion
0 n 130 m 210 250 20 320 a0 a0 as0 a0 a0
160
1200
o
am.
o
F30 1000 oo | 1600 000 At a1 3000 5400 000 1500
1500 3500
~
< >
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Step 5: View Additional Plot Settings

* Overlay LIZ Dye- Overlays all selected size standard
fragments in one electropherogram pane

& [ Plot Setting: [Overlay LIZ Dye v | Panes:| ] EREEEm

A~ B
m i i ac
[ | e bif] (b =y
Sample Name sQ
Mark: Sample: for Deletion (&
] L) 1 ™ 210 250 = 30 3 40 ) ] )
000,
1600
12
£l
B
v
10_sample_05.ts 1B_Sample_07 fsa
1D_Sample_06.tza 1D_Sampla_08 fsa &
< >
DyeSample Peak [Sample File Name | Marker Alele [Size Height rea Dsta Poirt
o1 - ID_Sample_05.15 750 1232 11057 2756 ~
o0z * ID_Sample_05 fsa 1000 1413 12361 3106
03 * ID_Sample_05 fsa 1360 1531 13534 3636
04 * ID_Sample_05.fsa 150.0 1604 14170 3770
05 * ID_Sample_1E fsa 160.0 1650 14523 3864 |
o5 ID_Satple_0S.fza 200.0 1734 15811 4414
CH ID_Sample_05.fsa 24637 1731 16524 5000
CERC I0_Sample_0E fsa 3000 1862 15339 |gEaT
03 - ID_Sample_05.15 3400 1846 15109 [6104
R ID_Sample_0E fsa 3500 1881 15745 6233
GCEENE ID_Sample_05 fsa 4000 1558 2657 6625
o1z * ID_Sample_05.fsa 450.0 1367 23170 7364
0,13 ID_Sample_1E fsa 45652 1554 24543 7827
014 ID_Satple_0S.fza 498.57 1968 24592 s
GRS ID_Sample_D.fsa 750 1335 12442 2632 g
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* Traditional Genotype Plot — Displays plots in a format similar
to the ABI PRISM® Genotyper® Software

& [8  Plot Setting: | Traditional Genotype Plot v |EB  Panesi[4 ~ | (R m G | EEEE A e
(L) | eebf) | ()d 4 5S4 | @ &
Sanple Hame sos [sQ  [sseR M [oMR |ceq
Sangle 05 \li \li \ |i |B |® ] Mark Sample for Deletion |
[EEaviE) | [DETSIT ] DTS ] [CSEIPO
s 118 165 195 =5 275 318 56 a8 s
s
2w
= LA
[ Ll )
Sample 05 CHC @ @ (& ] Mark Sample For Deletion
[DFS1358 | [TE0T ] DI3S3T ] [D16S53F ] [D25I3E
s 116 185 [ ES 275 516 565 ass a0
s
!
0.
- fl
100,
1 ] | ! A fh
B3l £ [tz
Sample 05 \Ii \Ii \ |i |E |® [ Mark Sample For Deletion
P53 | EWE ] POX ] [DISSET
e s 158 195 B 275 a8 08 ams s
o
a0,
. « L i
Sunple 65 CHC] @ @ [® [ Mark Sample Far Deletion
[DEsEIE ] [Fea
s 115 15 195 B 75 a15 505 ams. as
20,
il )
i &l
~
< >

After you have finished reviewing each plot setting, you are now
ready to close the Samples plot.
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Step 6: Delete Samples from the Project

1. Click || (Bring Marked Samples To Top) in the Samples plot
toolbar. The sample (Sample 07) you marked for deletion in
step 8 on page 108 is displayed in the top pane of the Samples
plot.

Sangle e Samgle Hame sos [sq  [ssK [ [omm |c6Q
I_Sanple 07 55 Sample 07 | [-] [¥] Mark Sample for Deletion |
L .23 1} S — L - — e —
E s 185 195 e s 316 358 ams a5
20
1o
A
v
ID_Sample_05 fsa Sample 65 |4 ) ] Mark Sample For Deletion #
[D3S11Te ‘ [D21ST1 | [D78820 | [CSFIPO
s 118 185 195 S a7s a8 a5 398 s
N Il ! h ‘
b4 BE i 5]
ID_Sample_05 £sa samgle o5 [5] [] Mark Sampls For Deletion
[DEST358 1 [TET | [DIIS3IT | [DI6883E ] [D2SIEEE
7 s 185 125 B 78 as 58 ams -
- ﬁ J\ ‘
2w
L« ii 1 h A hl i
(] [ [£] ]
“

You can use this feature to verify which samples are marked for
deletion before closing the plot window, since closing the plot
window automatically deletes these samples from the project.

2. Select File » Close Plot Window. A dialog box displays a

message indicating that one sample is marked for deletion.

GeneMapper® ID-X

€,  Thereis 1 sample marked For deletion, Do you want to delete this sample?
\‘-‘q/ This action cannaot be undone.

Yes [: Mo Cancel

3. Click Yes in the dialog box to close the Samples plot and return

to the Project window. The software automatically deletes
Sample 07 from the Getting Started project.

Note: From step 4 on page 95, the raw data for Sample 05 is
still displayed in the Project window.
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4. Select the Project node in the navigation pane to display the
remaining samples of the Getting Started project in the Samples
table.

»* GeneMapper® ID-X - *Getting Started AB - Practice User Is Logged In Database FOSKOSMANCNDO1
File Edt Analysis View Tools Admin Help

LoOoHE ©LF = | E = @  TableSstting: | 31XX Data Analysis v FPéEaL Ee
W Samples | Analysis Summary | Genatypes|
|y Identifiler Samplas
Status | Sample Name: Sample Type Analysis Method Panel Size Stanciard Custom Control ARNM |SOS |SG SSPH MR |OMR CGE

- ID_plelicLadder fsa

. T_plelicLadderz fsa Ladder Alllic Ladder | Getting Started_your intials |idertifiler_v1} |CE_G5_HID_GS500 |None

{ - ID_CustomControl.fsa
- ID_NeqControl.Fsa
. ID_PosControl.fsa

1

2

3

- ID_Sample_01.fsa 4
- ID_Sample_0z2.fsa 5 PosControl Positive Control | Getting Started_your intials | Idertifiler_w13( |CE_G5_HID_GS500  None

&

7

i

Ladder Allelic Ladder | Getting Started _your intisls |ldertifiler_v1X |CE_GS_HD_GSS00 |Mone
ID CustomContral |[Postive Cortrol | Getting Started_your intials |dertifiler_v1X | CE_G5_HID_GS500 |CUSTOM CONTROL_YOUR INITIALS

HegCortrol Negative Control | Getting Started_your intisls |ldertifiler_v1X |CE_GS_HD_GSS00 |Mone

- ID_Sample_03.fsa
L ID_Sample_D4.fsa
L ID_Sample_05.fsa
| ID_Sample_06.fsa
© . ID_Sample_08.fsa

Sample 01 Sample Getting Started_your intials |Idertifiler_v1X |CE_G5_HID_GSS00 |Mone

Sample 02 Sample Getting Started_your intials |Idertifiler_v1X |CE_G5_HID_GSS00 |Mone

Sample 03 Sample Getting Started_your intials |Idertifiler_v1X |CE_G5_HID_GSS00 |Mone

Sample 04 Sample Getting Started_your intials |Idertifiler_v1X |CE_G5_HID_GSS00 |Mone

Progress Status . | Stop

Note that Sample 07 is removed from this view. You are now
ready to save your edits to the Getting Started project.

Step 7: Save the Project

Now that you have finished editing the Getting Started project, click
IH (Save Project) to save all project edits (label edits and
comments) to the GeneMapper® ID-X Software database so they can
be viewed the next time the project is opened.

In Chapter 6, you will review your edits to the Getting Started
project.

First, in Chapter 5 you will use the Profile Comparison tool to help
determine the potential contributors to the negative control with
detected peaks and the mixture sample you just reviewed.
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Overview

Overview

About Quality
Control of Sample
Results

In This Chapter

136

Use the Profile Comparison tool to perform quality control of
sample results in a project. Only samples and controls with [ or

SQ are included in comparisons (allelic ladder samples are not
included).

The Profile Comparison tool does the following for all samples in a
project:
* Groups samples with 100% concordant profiles
* Compares samples in the project against all other samples in the
project
» Compares samples in the project against lab reference, custom
control, and QC sample profiles stored in the Profile Manager

IMPORTANT! Before you use the Profile Comparison tool to
evaluate the samples in your project, edit allele labels as needed and
ensure that no OL allele labels are present. Samples containing OL-
labeled peaks are not considered in comparisons.

In this chapter, you will use the Getting Started project, saved in
Chapter 4, to determine the potential contributors to the Negative
Control and mixture samples observed in Chapter 4 by comparing
the unknown sample profiles in the project against each other and
against the profiles imported into the GeneMapper® ID-X Software
database in Chapter 2.
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Understanding the Profile Comparison Tool

Terms You Need * Reference Profile — The reference profile is the profile against
to Know which another profile is compared to determine the % Match.
The software performs pairwise comparisons to determine the
direction of comparison that yields the higher % Match, then
reports only the direction of comparison with the higher
% Match.

A mixed-source sample is used as a reference profile only when
it is compared to another mixed-source sample.

* Comparison Profile — The comparison profile is compared to
the reference profile to determine the % Match result.

* %-Match — Calculated using the following formula:

<# reference profile alleles found in comparison profile > X 100

Total # reference profile alleles

Each sample or group (determined in Sample Concordance tab)
is compared to every other individual sample or single-source or
mixed-source group in the project. For a pair of samples or
groups, two comparisons are performed. Each sample/group is
used as a reference, to which the other sample (comparison
sample) is compared. The comparison direction that produces
the highest % Match is reported.

For example:

— Sample 1 is a single-source sample
— Sample 2 is a mixed-source sample

— Sample 1 contains 10 alleles (all of which are found in
Sample 2)

— Sample 2 contains 20 alleles

— When Sample 1 is used as the reference, the
% Match = 100%.

— When Sample 2 is used as the reference, the % Match = 50%.
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Sample
Concordance

— In this example, the comparison in which Sample 1 is used as
the reference is reported.

Note: Results are reported only when the % Match is greater
than or equal to the user-defined Percent Match Threshold
(range is 50 — 100).

* Single-source groups — Samples with no more than three
alleles in more than one marker in the Genotypes table, and are
100% concordant (all markers and all alleles match).

* Mixed-source groups — Samples with two or more markers
with three or more alleles in the Genotypes table, and are
100% concordant.

* Individual samples — Samples that contain unique profiles.

* Lab Reference and Custom Control Profile — Profiles
imported and stored in the Profile Manager.

The software performs a sample concordance check to group
samples with identical profiles and minimize the number of
comparisons performed on the other tabs of the Profile Comparison
tool.

To perform sample concordance, the software:

+ Considers all analyzed samples in the open project with a [
(Pass) or (Check) SQ value, except:

— Allelic Ladder sample types
— Samples that contain OL labels

* Compares each sample against every other sample to determine
100% concordance (all markers and all alleles match).

* Groups 100% concordant profiles in one or more single-source
or mixed-source groups.

Note: The Sample Concordance tab only displays grouped
samples that are 100% concordant. It does not list individual
samples. However, individual samples that meet or exceed the
user-defined Percent Match Threshold are considered in the
Sample Comparison, Lab Reference Comparison, and
Control/QC Comparison tabs.
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Sample, Lab  To perform comparisons, the software:

Reference, .
Custom Control,
and QC
Comparison

For sample comparisons: Performs a pairwise comparison of all
individual sample, single-source group, and mixed-source
group profiles.

For lab reference and custom control/QC comparisons:
Compares all individual sample, single-source group profiles,
and mixed-source group profiles to the lab reference or custom
control profiles stored in the Profile Manager (QC comparisons
use custom control profiles).

Calculates the % Match for each comparison.

Determines the reference-to-comparison % Match to report.

Note: Only the comparison that yields the highest % Match is
reported. The comparison that yields the lower % Match is not
used or listed in results.

Displays the % Match results that are greater than or equal to
the user-defined Percent Match Threshold.
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Step 1: Examine Sample Concordance

Overview In this section, you will use the Profile Comparison tool to check for
concordance among all samples in the Getting Started project.

Examining 1. Inthe Project window, open the Getting Started project (see
Sample step 1 on page 75).
Concordance

2. Seclect Tools » Profile Comparison. The Profile Comparison
tool opens to the Sample Concordance tab.

#* Profile Comparison
Ie Concard El Sample Compatison | Lab Reference Comparison | Contral/QC Comparison

Single Source 100% Concordance

Single Source-Groupl

op Samples
[ pssurs | [ pzisu | [ orsseo | [ csFipo | [ opssiass | [ thor | [ misssiz | [ oiessas 13— Markers
14, 16 23,31 B 1z 14,17 6,9 B, 11 3,1z

Single Source-Group2

op Samples
[ psstizs | [ peisit | [ oessen | [ csrpo | [ bastsss | [ thot | [ missstiz | [ ptessa |
15, 16 Nz 11, 12 1z 16 33 512 1z ——Alleles

IMiXed Source 100% Concordance

Two single-source groups (Group 1 and Group 2) are listed on
this tab for the Getting Started project.
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3. Click = to expand the Samples view for both single-source
groups.

»* Profile Comparison

Single Source 100% Concordance

Single Source-Groupl

= Samples
02 | ID_Sample_01.fsa | Sample0l | Z2006-08-08 14:54:11.0
D02 | ID_Sample_0Zfsa | Sample02 | Z2006-08-03 14:54:11.0

pssi179 | [ paistt | [ ovssan | [ csripo | [ pasisss | [ tHor | [ pi1sssiz | [ Diessam
14, 16 23, 51 5 1z 14,17 B 5 11 5,12

Single Source-Groups

Samples
G0l | ID_Sample_03.fsa | Sample03 | Z2006-08-08 14:13:03.0
BOZ2 | ID_Sample_0S.fsa | Sample0S | Z2006-08-08 14:54:11.0

[ psstizg | [ petsit | [ prsseo | [ csftro | [ pastsss | [ tHor | [ pi3ssiz | [ piessss
15, 16 3Lz 11, 12 1z 16 5.3 5 12 1z

Mi)(ed Source 100% Concordance

|

In the Getting Started project, ID_Sample_01 and
ID_Sample_02 (Single Source-Group 1) are 100% concordant,
and ID_Sample_03 and ID_Sample_05 (Single Source-

Group 2) are 100% concordant. All other samples in the project
have unique profiles and are not shown on this tab.

Step 2: Perform Sample Comparison and
View Results

Overview In this section, you will use the Profile Comparison tool to determine
whether any of the sample profiles in the Getting Started project are
potential contributors to another sample profile in the project.
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Comparison

Step 2: Perform Sample Comparison and View Results

Performing 1. Select the Sample Comparison tab.

Sample .
2. Keep the Percent Match Threshold at 80, then click Compare

Profiles.

Note: The default Percent Match Threshold value is set to 80,
with an accepted range of 50—100 percent.

Viewing the Review the sample comparison results.
Results
Note: The matching alleles in the reference sample profile
(indicated in bold) and the comparison sample profile are displayed
in blue.

»* Profile Comparison @

Sample Concordance | Sample Comparison | |ab Reference Camparison | Control/QC Comparison |
Percent Match Threshold {Percent of reference profile alleles detected in the comparison profile)
30 Compare Profiles
Sample Comparison
Single - Mixed
pss1179 | [ peisit | [ ovssen | [ csFiro | [ bs
B0Z | ID_Sample_08.Fsa | Sample 08 (Reference) 9% Match 12, 13 28, 31 7, 12 11, 12 1!
D02 | ID_Sample_06.fsa | Sample 06 96, 7% 12, 13 28, 30,31, 322 7,9, 10,12 10, 11, 12 15,
< | ¥

From Chapter 4, you know that ID_Sample_06 in the Getting Started
project is flagged as a potential mixture sample. The sample
comparison results indicate that ID_Sample_08 may be contributing
to the mixed profile of ID_Sample_06 because ID_Sample_08 (the
reference sample) contains 96.7% of the same alleles found in
ID_Sample_06 (the comparison sample).

GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 5 Performing Quality Control of Sample Results
Step 3: Perform Lab Reference Comparison and View Results

Step 3: Perform Lab Reference Comparison and

View Results

Overview

Performing Lab
Reference
Comparison

Viewing the
Results

#* Profile Comparison E]
Sample Concordance | Sample Comparisoni Lab Reference Compatison | ConkrolfQC Comparison

In this section, you will use the Profile Comparison tool to determine
whether any of the lab reference sample profiles stored in the Profile
Manager are potential contributors to sample profiles in the project.

1. Select the Lab Reference Comparison tab.

2. Keep the Percent Match Threshold at 80, then click Compare
Profiles.
Review the lab reference comparison results.

From Chapter 4, we know that the ID_Negative Control sample in
the Getting Started project contains detected, labeled alleles.

Percent Match Threshold (Percent of reference profile alleles detected in the comparison profile)
| 30 | Compare Profiles
Lab Reference Comparison
Project sample/source-group used as reference to calculate percent match
pesitze | [ pewsit | [ prsseo | [ sk | [ f
G11 | ID_NegControl.fsa | NegControl {Reference) < Match 15 30, 33.2 8 9,12
AMALYST A_YOUR INITIALS 100.0%: 15 30, 35.2 g, 11 9, 12
< ¥

The lab reference comparison results indicate that the Analyst A
profile (entered as a lab reference profile in Chapter 2) may be a
contributor to the Negative Control sample, because all of the alleles
detected in the Negative Control sample profile are found in the
Analyst A lab reference profile.
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Step 4: Perform Control/QC Comparison and

View Results

Overview

Performing
Control/QC
Comparison

Viewing the
Results

In this section, you will use the Profile Comparison tool to help
perform a blind QC check by comparing the observed profiles for the
custom control and QC samples present in the Getting Started
project to the custom control profiles stored in the Profile Manager
(QC samples use the Custom Control profile type).

1. Select the Control/QC Comparison tab.

2. Keep the Percent Match Threshold at 80, then click Compare
Profiles.

Review the control/QC comparison results.

In the Getting Started project, ID_Sample_04 is run as a QC sample
with profile results expected to match at least one of the custom
control profiles stored in the Profile Manager.

#* Profile Comparison @

Sample Cancordance | Sample Comparison | Lab Reference Compatison ControlfQC Comparison

Percent Match Threshold {Percent of reference profile alleles detected in the comparison profile)

éo
Control/QC Comparison

Custom Contral profile used as reference to calculate percent match

CUSTOM CONTROL_YOUR INITIALS (Reference) % Match 13, 14 28, 29 8, 10 10, 11 1

<03 | ID_CustomCantral.Fsa | ID CustomContral 100.0% 13, 14 28, 29 g 10 10, 11 1
[ pssuzs | [ pesit | [ orssen | [ csFipo | [ Dasiass

QC SAMPLE 01_¥OUR INITIALS (Reference) % Match 13, 14 30 8, 10 10 14, 15 |
EO1 | ID Sample_04.Fsa | Sample 04 100.0% 13, 14 30 8,10 10 14,15

k7]

[ pssuze | [ obeisit | [ orsszo | [ csFiro | [ pas

144

The control/QC comparison results indicate that the QC Sample 01
profile (entered as a custom control profile in the Profile Manager in
Chapter 2) matches a stored custom control profile as expected (all
alleles in ID_Sample_04 are also found in the QC Sample 01 profile).
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m Chapter 6 Performing Peer/Technical Review of Electronic Data
Overview

Overview

About Electronic  The GeneMapper® ID-X Software provides several data review tools
Peer/Technical and features designed to improve the efficiency of electronic
Review peer/technical review of projects. These features may minimize the
time spent during manual review and eliminate the need to print
electropherograms.

In This Chapter In this chapter, you will use the Getting Started project results edited
in Chapter 4 to learn how to:

» Use table settings to display only those samples containing
manual edits or overrides

* Visually confirm manual edits using the Label Edit Viewer
» Export the contents of the Label Edit Viewer
» Use table and plot settings to review manual edits

Step 1: View Samples with Manual Edits and
Overrides

Overview In this section, you will apply several of the default table settings
provided with the software (see Chapter 2) to the Samples table to
display only those samples in the Getting Started project that contain
manual edits or overrides.

Viewing CGQ 1. Open the Getting Started project, if not already open (see step 1
Overrides on page 75).

2. In the Project window, select View CGQ Overrides from the
Table Setting drop-down list.
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Step 2: View Edits in the Label Edit Viewer o

Only those samples in the Getting Started project whose CGQs
were manually overridden in Chapter 4 are shown in the
Samples table:

=] w P @ | Table Setting:

Samnples | Analysis Summary | Genotypes

[Stetus [Sample Name  [Sample Type  [SE [S05 [s@  [SSPK M [omR [coa

Sample 05 Sample

If a sample is displayed in this list, it means during the previous
interpretation, the analyst manually accepted the sample profile
with or without edits.

Viewing Edited In the Project window, select View Edited Samples from the Table
Samples Setting drop-down list.

Only those samples in the Getting Started project that had at least
one allele or artifact label edited in Chapter 4 are shown in the

Samples table:
E' i @ - w Table Setting: |View Edited Samples v|@
Samples | Analysis Summary | Genotypes
[Status [Sample Name [Sample Type [Run Date & Time [sE  [s0s [sa@  [ssek [mi [omr [coa

Sample 05 Sample 2007-05-0310:21:110 | o | | | |

Note that there is a «” in the Sample Edit (SE) column, and the
sample-level PQVs are gray, indicating that peaks within and/or
outside of marker ranges have been edited. This table setting allows
reviewers to focus on only those samples that have been edited. In an
expert system workflow, these may be the only samples that require
second review.

Step 2: View Edits in the Label Edit Viewer

Overview The Label Edit Viewer contains a list of edits made to the allele and
artifact labels displayed in the sample electropherogram plots of the
Samples plot. In this section, you will use the Label Edit Viewer to
assist in the visual confirmation of manual edits you made to the
Getting Started project in Chapter 4.

You can view the Label Edit Viewer from the Project window or the
Samples plot.
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Step 2: View Edits in the Label Edit Viewer

Viewing Edits 1. In the Project window, make sure View Edited Samples is
from the Samples selected from the Table Setting drop-down list.
Plot . ) i .
2. Select the edited sample in the filtered Samples table, then click
(Display Plots).
3. In the Samples plot, select the View Label Edits setting from
the Plot Setting drop-down list. The Samples plot view changes.
&b [&  Plot Setting: | view Label Edits v |l | Panes:[z v |§|§|:|§\ﬂ m ‘-M‘E‘W @@§|\ Al @
(k) anoiifl] (M4 45 4 | ow AR
Sample Name 505 |5Q SSPK |MIX |oMR [ceQ
S CIRL a4 |®
[D8sIITa [D2181L | DTSz | [CSFIFG
m75 118 155 195 255 278 3s 355
1200
. JL
el 0 [CIRL A |®
[ EES | [THOL | [DI3531T | 0165539 ] D533
78 118 155 195 255 278 35 355
- U I b
A e e dk A i n i .
[
<
Label Edit Viewer - Mew edits will not be displayed in the table until the project is saved
[ Sample File Mame Sample Name [ Panel [ Marker Base Pair [ <ld Value Mew Yalue
ID_Sample_0&.fsa Sample 05 Identifiler_v1% TR 212,76 OMR <6
ID_Sample_0&.fsa Sample 05 Identifiler_w1% DSS818 139,41 oL SPU AR
ID_Sample_0&.fsa Sample 05 Identifiler_w1% FGa 228.61 20,2 SPU AR

148

This plot setting displays the sample electropherogram plots
above the list of edits shown in the Label Edit Viewer table. In
Chapter 4, you made three label edits to Sample 08 in the
Getting Started project. The Label Edit Viewer displays detailed
information about each of these edits.

Note: The Label Edit Viewer is blank if you have not saved the
project.
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Step 2: View Edits in the Label Edit Viewer

4. To visually confirm the displayed peak labels for Sample 08
against the label edit entries in the Label Edit Viewer, select the
first row in the table. The corresponding edited peak is
highlighted in the electropherogram plot.

Samples plot shows
selected edit

Sample Name s05  5Q SSPK |MIX |OMR  CEQ
sl A |®
[[DEEERE ] FWA || MFOX ] DIESEL
75 115 156 195 25 275 315 356
SO0
4000
3000
200
- L

Sngle 06 e @ @ (4 @
Fex
75 116 155 195 55 275 315 355
30
o]
- M
" A " " "

< |
Label Edit Wiewer - Mew edits will not be displayed in the table until the project is saved

Sample File Mame Sample Name Panel Marker Base Pair <ld Value Mew Yalue
Sample i v1X okd 76 0 <&

|ID_Sample_08 fsa |5ample 03 |Faa [228.61 |0z ETEE] |

Select row in table

Note: Selecting an edited peak in the electropherogram plot
will also highlight the corresponding edit in the Label Edit
Viewer.

5. Repeat step 4 above for each entry in the Label Edit Viewer.
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150

Step 2: View Edits in the Label Edit Viewer

6. After you confirm all label edits, manually accept the sample
profile by overriding the CGQ PQV:

a. Right-click the @ CGQ in the Samples plot header.

Note: A @ CGQ indicates that one or more peaks within
a marker have been edited.

Sample Name 505 [sQ SSPFK MIX |OMR |CEQ
Sample 0 A [

DI85 | FWA | MPOX | [DIEEEL

75 115 1645 195 5 275

\_‘.:/ Override the Composite Genotype Quality of this Sample?

fes
v , M e L. il ,, J .Jt

b. Click Yes in the message dialog to override the sample
CGQ. The CGQ PQV changes to &) (Manually
Overridden).

Note: Overriding CGQ allows the reviewer to manually

accept the entire profile for a particular sample and also

provides evidence that the sample was visually inspected
by the reviewer.

Sample Hame 505 |5Q SSPK MIX |OMR |CGQ
Sanple 08 A [©®
[D125433 | WA | MPOX

75 115 155 195 5

SN0

QU

SO0

M

1000 U
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Step 2: View Edits in the Label Edit Viewer

7. Select File » Close Plot Window to return to the Project
window.

8. Click . (Save Project) to save your changes to the Getting

Started project.
Viewing Edits 1. In the Project window, make sure View Edited Samples is
from the Project selected from the Table Setting drop-down list.

Window _
Select the edited sample in the filtered Samples table, then click

|| (Label Edit Viewer). The Label Edit Viewer opens in a
separate window.

»¥ Label Edit Viewer X

Label Edit Yiewer - Mew edits will not be displayed in the table until the project is saved

[Sample File Mame  |[Sample Name  |[ Panel [Marker  |(Base Pair | Old value Hew Yalue | Action Reason [ User [ Date

ID_Sample_0&.fza  |Sample 03 Identifiler_wix | TPOX 212,76 OMR, <6 modified Microvariant OMR |Practice User | 2007j08/15 12128116

ID_Sample_0&.fsa | Sample 03 Identifiler_wix |DSS&18 (139,41 =8 SPU A modified Full-up Practice User 200708115 12:28:16

ID_Sample_08.Fsa | Sample 08 Identifiler_v1¥  |FGA 228.61 20.2 SPL AR madified Pull-up Practice User |2007/08/15 12:28:16
[ Expart ] [ Close ] [ Help ]

3. Proceed to the next section if you wish to export the contents of
the Label Edit Viewer. Otherwise, click Close in the Label Edit
Viewer to return to the filtered Samples table.

Exporting the Note: You can also export the contents of the Label Edit Viewer
Label Edit Viewer from the Samples plot. See “Exporting from the Samples Plot” on
from the Project page 168.
Window

1. Display the Label Edit Viewer from the Project window (see
step 2 above).

2. In the Label Edit Viewer, click Export.
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Step 2: View Edits in the Label Edit Viewer

3. In the Export Table dialog, specify a location, name and format
(.txt or .csv) for the exported file, then click Export.

File location File format
Laok in: |@ GeneMapperID-% v | 53 ’_’l|| =
Y 25 app Export File As
C\é () Applied Biosystems Service | Tab-dlefmited text {.txt) |
My Recent I3 config
Documents [) Database
= |C5) Database Defaults
H |_f i |C5) Docs
Desktop |C5) Example Data
) RE
2\ I3 Panels
_"_/ 15 service
My Documents r;] GeneMapper _Contexk, bk
E] GeneMapper_Log.kxt
Ej}g r;] PanellmportLog. bxt
My Computer
.5 File name: aetting Started AE_alleleEditTable D [ Export [\]
Iy Metwork
Flaces Files of type: | Tab-delimited Text {* k) v | Cancel

File name

Note: The Files of type selection filters the list of file names
displayed in the navigation pane, it does not determine the
format of the exported file.

4. Click Close in the Label Edit Viewer to return to the filtered
Samples table.

5. Open the exported file with a spreadsheet software that supports
tab-delimited or comma-separated text, such as Microsoft®
Excel®.

6. Print the exported file as needed.

152 GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 6 Performing Peer/Technical Review of Electronic Data “
Step 3: View Allele Edits and Comments in the Genotypes Table and Genotypes Plot

Step 3: View Allele Edits and Comments in the
Genotypes Table and Genotypes Plot

Overview In this section, you will use the Genotypes table and Genotypes plot
to view the allele edits and comments for the Getting Started project.

Viewing Allele 1. In the Project window, select the Project node in the navigation
Calls in the pane, then select the Genotypes tab.

Genotypes Table . o
. Verify that the View Edited Samples setting is selected from

the Table Setting drop-down list. Only the markers that were
edited in the selected sample (in this example, Sample 08) are
displayed in the Genotypes table.

El il E [ ﬁ Table Setting: ‘View Edited Samples v| )O =N 0 e

Samples | Analysis Summaryl Genotypes |

[ME Jos [BMN [PHR [LPH [MPH [SPKC [aN

Pull-Lig

Pull-up; |~

3. Review the entries in the following table columns:

* Allele Edit (AE) Reason For Change: Displays the last
reason for change entered for an edit that yields an allele
label

* Marker Edit Comment (MEC): Displays the reason for
change entered for an edit that yields an artifact label or
when alleles are deleted

* Marker Edit (ME) flag: Displays «" (true) if allele or
artifact labels are edited within a marker size range

Note: You can export the contents of the Genotypes table from
the Project window. This procedure is outlined in “Step 4:
Export Table Data” on page 165.

Viewing Allele 1. Inthe Project window, Shift-click to select all rows in the
Calls in the Genotypes table (if not already selected), then click
Genotypes Plot (Display Plots). The Genotypes plot window opens.
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2. In the Genotypes plot, select the Traditional Genotype Plot
setting from the Plot Setting drop-down list. The Genotypes plot
view changes.

» Getting Started AB : Genotypes Plot
File Edit Wiew Plots Tools  Allelss  Help
& [& PIntSetting:|Traditinna\GenmtypEP\nt ‘4@ Panas: |§|§|z|i|!" ||E|A:A| (7]
(i) | ik lls] |l R L M AR A
Samnple Name Marker 05 |BIN PHR LPH [MPH SPK (AN |BD CC |6Q
smglect . [mox | | [© [ (A [® @ @ [ @ 2
[TPOX
09 211 213 216 2IF 29 D91 295 25 97 299 B BI3 356 257 239 21 B3 205 247 249 361 353 256 257 269 261
5000
2000
Soo0
2000
1000
0 i i
smpeie psus @ A A A (BB @ @
D5S818
130 140 150 160 170 130
2000
000
2000
1000
o i
e @ [ (A (8 (@ [8 (4 [@ [0 [®
[FGR
290 240 260 280 00 390 240 360
1000
s00
[
200
om0
de A A Pl Moa s
v

This plot setting displays one marker per pane for each of the
markers selected in the Genotypes table. For the Getting Started
project, only the markers for Sample 08 are displayed in the
Genotypes plot.

3. Seclect File » Close Plot Window to return to the Project
window.
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Overview

Overview

In this chapter, you will learn how to generate custom reports, and
export reports and data tables. You will practice these tasks using the
Getting Started project you created using the procedures in Chapter 3
of this guide.

Note: For information on exporting data in a format suitable for
CODIS, see the GeneMapper® ID-X Software Help.

Step 1: Create a Custom Report Setting

Overview

Creating a
Custom Report
Setting

156

GeneMapper® ID-X Software can generate table-formatted reports
from any combination of the columns in the Samples and Genotypes
tables. You can configure the report with custom columns, save the
report to the project, print it, or export it as tab-delimited or comma-
separated text. You can also save the report settings to generate the
same report for other projects.

In this section, you will use the Report Settings Editor to create a
new report setting specifically designed for the Getting Started
project.

1. Launch the software and log in as the Practice User, if not
already logged in (see “Starting the Software and Logging In”
on page 22).

2. Open the Getting Started project, if not already open (see step 1
on page 75).

3. In the Project window, click (GeneMapper ID-X Manager).

4. Inthe GeneMapper ID-X Manager, select the Report Settings
tab, then click New. The Report Settings Editor window opens.

GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 7 Reporting, Exporting and Printing Results n
Step 1: Create a Custom Report Setting

5. Complete the top portion of the Report Settings Editor:

a. Enter Getting Started Report <your initials> as the
report Name.

b. Enter a description for the new report setting.
c. Verify that the Practice Security Group is selected from the

drop-down list.

#* Report Settings Editor

Mame: | Getting Started Report_your initials | Description: | For use with Getting Starked Guide only

Security Group: |Practice Security Group e |

6. Select the Samples table columns to display.
a. In the Sample tab, Ctrl-click to select the following

columns from the Available Columns table.

Available Columns

Sarmple | Genatype | Custom|

Colurnnis)
Status | A
Sample File ¥ |

Sample 1D

Comments

Sample Type

Specimen Category
tsis Method

Iatrix

Run Mame
Instrument Type
Instrument ID

Flate ID w

b. Click [gd to add these columns to the Selected Columns
table.

Note: Columns you add to the Selected Columns table are
shown in the Preview Table (at the bottom of the Report
Settings Editor).
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Step 1: Create a Custom Report Setting

7. Select the Genotypes table columns to display.

a. In the Genotype tab, Ctrl-click to select the following
columns from the Available Columns table.
Awailable Columns

Sample| Genotyne | custom

Columnis)
Sample File
Sample Mame
Sample 1D
Run Mame
Panel

|

Size 1
Size &
Height: 1

Height: 2

Peak Area 1
Peak Area 2
Data Point 1
[rata Poink 2 ¥

b. Click |ggd to add these columns to the Selected Columns
table.

8. Add a custom column to the report. The custom column will
appear as a column of blank, editable cells in the report table.

a. Select the Custom tab, then click Create.

b. Enter the following information, then click OK.

»* Custom Column @

Iame: | Custom_your intitials |

Description: Getting Started

[ OF h][ Cancel H Help ]

c. Inthe Custom tab, select the Custom <your initials>
column from the Available Columns table, then click jgd to
add this new column to the Selected Columns table.
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Step 1: Create a Custom Report Setting

9. Adjust the order that the columns appear in the report.

a. In the Selected Columns table, select the Run Date &
Time column.

b. Click (Move Up) repeatedly until this column is
positioned underneath the Sample Name column.

Selected Columns

Colurnn Display Mame Shiow Type COrder

=

(<]

Analysis Method Analysis Method

[#] Sample

Panel Panel [#] Sample

Size Standard Size Standard [#] Sample

Marker Marker [#] Genokype

Allele 1 Allele 1 [#] Genokype

Allele 2 Allele 2 [#] Genokype

Custom_your intitials |Custom_your intitials Z Cuskom

"I\k Sart Options
|

10. Adjust the column header names to be displayed in the report.

a. In the Display Name column, click the Allele 1 field, then
delete this text and enter Peak 1.

Columnn
Sample Mame

Display Mame
Sample Mame

Fun Date & Time

Fun Date & Time

Analysis Method

Analysis Method

Panel Panel
Size Standard Size Standard
Marker Marker
Peak 1
Allele 2 Allele 2

|Cust0m_y0ur intitials |Cust0m_y0ur intitials

b. Replace Allele 2 with Peak 2.

11. In the Number of Alleles field, verify the number of alleles to
report is set to 2.

12. In the Preview Table, review the column display changes you
just made to the Getting Started Report setting.

Preview Table

Sample M...  RunDate...  Analysis ... Panel Size Stan... = Marker Peak 1 Peak 2 Custom_,..
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13. Click OK to save your settings and close the Report Settings
Editor.

14. Click Done to close the GeneMapper ID-X Manager.

Step 2: Generate the Report

1. In the Project window, make sure the Samples tab is selected,
then select View Unedited Samples from the Table Setting
drop-down list.

1. Shift-click to select the rows Sample 01 through Sample 04 in
the Samples table to report.

2. Click El (Report Manager). A report is displayed in the Report
Manager using the first report setting in the drop-down list.

»* Report Manager - *Untitled

File Edit W“iew Tools Help
Report Setting: |.¢\||e|e Table “ | E (7]
Sample File Sample Mame | Marker Allele 1 allele 2 Custom_»AE

1 |ID_SampIe_Ell [Fsa |Sample 01 Dasiize |14 16 ~
z |ID_Sample_01.Fsa |Sample 01 Dz1511 |29 a1 I
3 |ID_SampIe_Dl Fsa [Sample 01 D738z0 |9
4 |ID_Samp|e_EIl [Fsa |Sample 01 CSFIPO |12
5 |ID_SampIe_Dl [Fsa |Sample 01 0351358 |14 17
[} |ID_SampIe_Dl Fsa [Sample 01 THOL ] 9 —
7 |ID_SampIe_Dl [Fsa |Sample 01 0135317 |3 11
] |ID_SampIe_Ell [Fsa |Sample 01 D165539 |9 1z
9 |ID_SampIe_Dl [Fsa [Sample 01 Dz251338 |20 25

10 |ID_SampIe_Dl Fsa [Sample 01 0193433 |14

11 |ID_SampIe_Dl [Fsa |Sample 01 A 14 15

iz |ID_SampIe_Ell [Fsa |Sample 01 TROW i 10

13 |ID_SampIe_Dl Fsa [Sample 01 018351 17

14 |ID_SampIe_Dl Fsa [Sample 01 AMEL b il

15 |ID_Samp|e_EIl [Fsa |Sample 01 055818 |11

16 |ID_SampIe_Dl [Fsa |Sample 01 FGh 23 24

17 |ID_SampIe_02.Fsa Sample 02 0351179 |14 16

18 1ID_Sample_02.fsa |Sample 02 Dz1511 |29 31 w

3. Seclect the Getting Started Report <your initials> setting you
created from the Report Setting drop-down list.

160 GeneMapper® ID-X Software Version 1.0 Getting Started Guide



Chapter 7 Reporting, Exporting and Printing Results
Step 2: Generate the Report

4. Review the report. Note the following:

The report contains the columns specified in the report
setting, including the Custom column

The Allele 1 and Allele 2 columns are reported as Peak 1
and Peak 2

»* Report Manager - *Untitled

File Edit Wiew Tools Help
Reeport Setting (7]
Sample Name Fun Date & Time Analysis Method Panel Size Standard Marker Peak 1 Pesk 2 Custom_your intitials
1 Sample 01 Z006-05-08 14:54:11.0  |Getting Started_your intials  |[Identifiler w13 [CE_GS_HID_GSS00 |D&5S1179 |14 16 Y
z Sample 01 Z006-08-08 14:54:11.0  |Getting Started_your intials  |[Identifiler _w1% |CE_G5_HID_GS500 021511 29 a1 b
3 Sample 01 2006-08-08 14:54:11.0  (Getking Started_your initials  |Identifiler_v1¥ |CE_GS_HID_GS500 |D75820 =]
4 Sample 01 2006-03-08 14:54:11.0  Getking Started_your initials  |Identifiler_w1x |CE_GS5_HID_GSS00  |CSFIPO 12
E] Sample 01 2006-05-08 14:54:111,0  |Getting Started_your intials  |Identifiler 1% |CE_GS_HID_GSS00 |D351358 (14 17
& Sample 01 Z006-05-08 14:54:11.0  |Getting Started_your intials  |[Identifiler _w1% |CE_GS_HID_GS500 | THO1 & a
7 Sample 01 2006-08-08 14:54:11.0  Getking Started_your initials  (Identifiler_w1¥ |CE_G5_HID_G5500 D135317 8 11
8 Sample 01 2006-03-08 14:54:11.0  Getting Started_your initials  [Identifiler_w1x |CE_GS_HID_GSS00  D163539 (9 12 _
] Sample 01 2006-03-08 14:54:11.0  (Getting Started_your initials  [Identifiler_w1¥ |CE_GS_HID_GS500 0251338 |20 25
i0 Sample 01 Z006-05-08 14:54:11.0  |Getting Started_your intials  |[Identifiler _w1% |CE_GS_HID_GSS00 DI195433 (14
i1 Sample 01 2006-08-08 14:54:11.0  |Getting Started_your initials  |Tdentifiler_w1¥% |[CE_G5_HID_GSSO0  |[wikddy 14 15
12 Sample 01 2006-03-08 14:54:11.0  \Getking Started_your initials  (Identifiler_w1¥ |CE_GS_HID_GS500  |[TPOX 8 10
13 Sample 01 2006-03-08 14:54:11.0  Getting Started_your initials  (Identifiler_w1¥% |CE_GS_HID_GSS00 018551 17
14 Sample 01 Z006-05-08 14:54:11.0  |Getting Started_your intials  |[Identifiler w13 CE_GS_HID_GSS00  |AMEL [ i
15 Sample 01 #006-08-08 14:54:11.0  |Getting Started_your intials  |Identifiler _w1¥ CE_GS_HID_GSS00 |[DS5818 11
16 Sample 01 2006-08-08 14:54:11.0  Getking Started_your initials  {Identifiler_w1¥% |CE_G5_HID_G5500 FGA 23 24
17 Sample 02 2006-03-08 14:54:11.0  Getting Started_your initials  [Identifiler_v1¥ |CE_GS_HID_GSS00  D8S1179 |14 16
15 Sample 02 2006-03-08 14:54:11.0  (Getting Started_your initials  (Identifiler_v1¥% |CE_GS_HID_GSS00 |D21511 =L 31
19 Sample 02 Z006-05-08 14:54:11.0  |Getting Started_your inttials  |Identifiler w1 (CE_GS_HID_GS500 |[D75820 9
20 Sample 02 2006-08-08 14:54:11.0  Getting Started_your initials  {Identifiler_w1¥% |CE_G5_HID_G5500 |CSFIPO 12
21 Sample 02 2006-03-08 14:54:11.0  /Getting Started_your initials  [Identifiler_v1¥ |CE_GS_HID_GSS00  |D351358 |14 17 v
5. To edit a cell in the Custom column, double-click the cell, type
the desired text, then press Enter.
Sample Name | Run Date & Time Analysis Method Panel Size Standard Marker Peakl  Peak2 | Cusktom_your initials
1 Sample 01 2006-08-08 14:54:11.0 |Getting Started_your initials |Identifiler_v1x [CE_G5_HID_G5500 [D8S1179 |14 16
z Sample 01 2006-08-08 14:54:11.0 |Getting Started_your initials |Identifiler_v1x [CE_G5_HID_G5500 [D21511 |29 31
3 Sample 01 2006-08-08 14:54:11.0 |Getting Started_your initials [Identifiler_v1x |CE_GS_HID_GSS00 D7S820 |9
4 Sample 01 2006-08-08 14:54:11.0 |Getting Started_your initials |Identifiler_v1x [CE_G5_HID_G5500 [CSFIPC |12

6. Leave the Report Manager window open for the next steps (see
“Step 3: Export the Report” on page 162).
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Step 3: Export the Report

Overview You can export the report generated in the Report Manager as a
formatted table. The exported table format depends on the report
setting selected when generating the report. By default, the export
table format reflects the display in the Report Manager window.
However, you can also export in allele table format to list markers in
columns or rows, and to group the called alleles for a marker into one
or more cells, depending on the number of alleles selected to be
displayed.

Exporting the 1. Inthe Report Manager, select Allele Table from the Report
Report Setting drop-down list.

Note: You can use this report setting to export genotype data in
a traditional allele table format (see step 6 on page 163).

2. Select File » Export to open the Export Report dialog box:

»* Export Report @

Laok in: |@ GeneMapperID-% hd | 53 ,?|E| =
5 ) app Expart File As
;«.ﬁ I3 Applied Binsystems Service |Tab-de|imited ket (Lbxt) hd |
My Recent I3 config
Documents |- Database (&) Apply Selected Report Setting Format
— |5 Database Defaults
Vl_ = Dacs () Convert ta Allels Table By Sample Format
Desktop |- Example Data
) e
= IC5) Panels
"_/ 15 service

My Documents E] GeneMapper _Contexk, bk
E] GeneMapper_Log.kxt
E] PanellmportLog. bxt

My Computer

Iy Metwork -
Flaces Files of type: | Tab- and Comma-delimited Text (*.bxt,* csv) | Cancel

File: name:

| [ Expork ]

3. Navigate to the location in which to save the file.
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4. Enter Export <your initials> as a suffix to the default Getting
Started <your initials>_Allele Table export File name.

File name: Getting Started AB_allele Table Export A8
Files of type: | Tab- and Comma-delimited Tesxt (* b, * csv) v

Note: The Files of type selection filters the list of file names
displayed in the navigation pane, it does not determine the
format of the exported file.

5. Verify that Tab-delimited text (*.txt) is selected as the export
file format.

Note: This selection separates the alleles with tab-stops, and
allows you to open the exported file using a spreadsheet
application (see step 11 on page 164).

6. Select a format option:

Export File As
Tab-delimited bext {.kxk) “
(%) Apply Selected Report Setting Format

() Convert bo Allele Table By Sample Farmat

* Apply Selected Report Setting Format (default) —
Exports the report as it is displayed in the Report Manager
(one marker per row)

1 | 2 [ 3 [ 4 | s
|1 [Sample File Sample Mame Marker  Allele 1 Allele 2
| 2 |ID_Sample_01.fza Sample 01 DBS1179 14 16
| 3 [ID_Sample 01.fsa Sample 01 02151 29 )
| 4 [ID_Sample_01.fsa Sample 01 075820 9
| 5 |ID_Sample_01.fsa |Sample 01 CSF1RD 12

* Convert to Allele Table by Sample Format — Generates a
list of samples (one sample per row) with column(s) for
each marker that lists the called alleles for the marker

Note: Markers without called alleles are also listed.
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10.

11.

164

For heterozygote alleles, you can also choose to:

* Group alleles in one cell — Generates a single column
for each marker and places all alleles for the marker
into one cell (that is, a traditional allele table)

1 [ 2 | 3 | 4 [ 5 |
| 1 |Sample File Sample Name DE31179 D21511 D7 S620
| 2 |ID_Sample_01.fsa | Sample 01 14,16 29,318,
| 3 |ID_Sarmple_02.fsa Sample 02 14,16 2915,
| 4 |ID_Sample 03.fsa  Sample 03 15,16 3.2 11,12
| 8 |ID_Sarple_04.fsa Sample 04 13,14 30, 5,10

* Separate alleles into individual cells — Generates
multiple columns per marker and places only one
allele per cell

1 [ 2 [ 3 | a4 [ s | &
| 1 |Sample File Sarnple Marne DE51179 1 DES1179 2 0215111 D21511 2
| 2 |ID_Zample_01.fza  Sample 01 14 16 29 3
| 3 |ID_Zample_02.fza Sample 02 14 16 29 3
| 4 |ID_Zample_03.fza Sample 03 15 16 3.2
| 5 |ID_Zample_04.fza  Sample 04 13 14 30

Click Export.

Note: If you are exporting an allele table, a dialog box displays
the names of the files created. Click OK.

Select File » Exit to close the Report Manager.

Click Yes in the Save Report dialog, then enter Getting
Started_Allele Table Report <your initials> in the Save
dialog.

Click OK to save the Allele Table Report to the Getting Started
project.

Navigate to and open the exported Getting Started_Allele
Table Export file in a spreadsheet software (such as Microsoft®
Excel®) or Microsoft® Notepad.
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Step 4: Export Table Data

IMPORTANT! When exporting or copying and pasting PQV flags,
include the ME column (from the Genotypes table) and the SE
column (from the Samples table) to indicate whether allele labels
were edited, which may affect individual PQV values.

Exporting When you export data from the Samples or Genotypes table
Individual Tables individually, the following are exported in a single table:

» All samples in the project (not selected samples)

* Only the displayed columns from the individual table that you

are viewing

To export individual tables:

1.

In the Project window, select View » Samples, then select the
Samples tab to export the Samples table or the Genotypes tab to
export the Genotypes table.

Select View Unedited Samples from the Table Setting drop-
down list.

Shift-click a column header in the Samples tab (or Genotypes
tab) to sort the table and determine the sample order.

Click CF (Export Table).

In the dialog box, navigate to the location to save the exported
table file.

Select the export file format:
e Tab-delimited text (*.txt)
e Comma-delimited values (*.csv)
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166

Step 4: Export Table Data

7.

8.

Enter a name for the exported file.
Note: The Files of type selection filters the list of file names

displayed in the navigation pane, it does not determine the
format of the exported file.

Click Export Table.

Exporting When you export data from the Samples table and Genotypes table

together, the following are exported in a combined table:

» All samples in the project (not selected samples)

* Only the displayed columns from the Samples table and

Genotypes table

To export combined tables:

1.

In the Project window, select View Unedited Samples from the
Table Setting drop-down list.

Select File » Export Combined Table.

In the dialog box, navigate to the location to save the exported
table file.

Select the export file format (*.txt or *.csv).

Select a Merge option:
* Allele table by sample

IMPORTANT! This option does not allow you to control
the order of columns in the exported file. Columns are
exported in the order in which they appear in the Samples
and Genotypes tables. To control the order of columns in
the exported file, export from the Report Manager. See
“Step 3: Export the Report” on page 162.

* One line per sample
* One line per marker (default)
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6. Enter a name for the exported file.

7. Click Export.

Note: If you are exporting an allele table, a dialog box displays
the names of the files created. Click OK.

Copying and  You can copy and paste the content of most tables into a spreadsheet
Pasting Table or text file.

Data
1. In the desired table of the GeneMapper® ID-X Software, select

the cells to copy.

2. To copy the data:
a. Without column headers — Press Ctrl+C.

b. With column headers — Press Ctrl+Shift+C.

3. In the desired location (spreadsheet or text file), select
Edit » Paste.

Step 5: Print Results

Use the print preview function in the GeneMapper® ID-X Software
to examine data items (reports, tables, plots, sample information, raw
data, and EPT data) on screen before they print.

When you are satisfied with the results, select File » Print:

Window/Tab Access Fé;ngelfl’;gjt(ie:; Window
Project window — Samples tab View » Samples
Project window — Genotypes tab View » Genotypes
Project window — Info tab View » Sample Info
Project window — Raw Data tab | View » Raw Data
Project window — EPT Data tab View » EPT Data
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. Access From Project Window
Window/Tab By Selecting
Samples plot The Samples tab, then
View » Display Plots
Genotypes plot The Genotypes tab, then
View » Display Plots
Report Manager Tools » Report Manager
Size Match Editor Tools » Size Match Editor

Other Export Options

Exporting from  You can export results from the following tables by selecting
the Samples Plot File » Export Table in the Samples plot:

Table Access From Samples Plot By Selecting
Genotypes table Plots » Tables » Genotypes Table
Label Edit Viewer Plots » Tables » Label Edit Viewer
Sizing table Plots » Tables » Sizing Table

Exporting from  You can export the following data objects stored in the GeneMapper
the GeneMapper ID-X Software database by clicking Export... in the GeneMapper
ID-X Manager ID-X Manager dialog:

* Projects

* Analysis Methods
» Table Settings

* Plot Settings

* Matrices

Note: You can export a matrix file for use in the Data
Collection Software on the ABI PRisM® 310 Genetic Analyzer.

» Size Standards
* Report Settings
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Manager

Exporting from
the Profile
Manager
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Other Export Options

You can export the following data objects stored in the GeneMapper
ID-X Software database by selecting File » Export... in the Panel
Manager window:

e Panels

* Bin Set

* All Kits

* Marker Stutter

You can export the following data objects stored in the GeneMapper
ID-X Software database by clicking Export in the Profile Manager
dialog:

» Lab Reference profiles

* Custom Control profiles

Note: All of the profiles stored in the Profile Manager will be
exported together in a single file.
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